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追加および変更された情報

この章では、『Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0』で追加お       
よび変更された各情報について、リリース固有の内容を説明します。このマニュアルの最新版につ

いては、シスコの次の Web サイトにアクセスしてください。 
http://www.cisco.com/en/US/docs/switches/datacenter/sw/4_0/nx-os/security/configuration/guide/sec_nx-os_
config.html

Cisco NX-OS Release 4.0 の追加情報については、シスコの次の Web サイトにアクセスして『Cisco     
DCNM Release Notes』を参照してください。 
http://www.cisco.com/en/US/docs/switches/datacenter/sw/4_0/nx-os/release/notes/401_nx-os_release_note.h
tml

表 1 に、『Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0』で追加および         
変更された機能についての概要と、その参照先を示します。

表 1 リリースで追加および変更された情報 4.0 

機能 説明
変更された
リリース 参照先

SVI が VLAN ネットワー   
ク インターフェイスに 
変更されました。

SVI が、すべての画面で VLAN ネットワーク   
インターフェイスという用語に変更されまし

た。機能に変更はありません。

4.0(3) マニュアルでのすべての表現

http://www.cisco.com/en/US/docs/switches/datacenter/sw/4_0/nx-os/security/configuration/guide/sec_nx-os_config.html
http://www.cisco.com/en/US/docs/switches/datacenter/sw/4_0/nx-os/release/notes/401_nx-os_release_note.html
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はじめに

この章では、『Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド』の対象読者、構成、      
表記法について説明します。また、関連資料の入手方法についても説明します。

この章で説明する内容は、次のとおりです。

 • 対象読者（p.xiii）

 • マニュアルの構成（p.xiv）

 • 表記法（p.xiv）

 • 関連資料（p.xv）

 • マニュアルの入手方法、テクニカル サポート、およびセキュリティ ガイドライン（p.xvi）

対象読者
このマニュアルは、NX-OS デバイスの設定およびメンテナンスを担当する、経験豊富なネットワー 
ク管理者を対象としています。
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マニュアルの構成
このマニュアルの構成は、次のとおりです。

表記法
マニュアルの注記には、次の表記法を使用しています。

（注） 「注釈」です。役立つ情報や、このマニュアル以外の参照資料などを紹介しています。

注意 「要注意」の意味です。機器の損傷またはデータ損失を予防するための注意事項が記述されていま

す。

章 説明

第 1 章「概要」 各機能を要約して説明します。

第 2 章「VLAN の設定」 VLAN 設定の詳細について説明します。

第 3 章「プライベート VLAN の設定」 プライベート VLAN の設定情報について説明します。

第 4 章「Rapid PVST+ の設定」 IEEE 802.1D Spanning Tree Protocol（STP; スパニングツ
リー プロトコル）に関する情報、および Per VLAN Rapid 
Spanning Tree（Rapid PVST+）設定の詳細について説明し
ます。

第 5 章「MST の設定」 Multiple Spanning Tree（MST）設定の詳細情報について説  
明します。

第 6 章「STP 拡張機能の設定」 シスコ独自の STP 拡張機能であるブリッジ保証、Bridge  
Protocol Data Unit（BPDU; ブリッジ プロトコル データ ユ      
ニット）ガード、BPDU フィルタリング、ループ ガード、  
ルート ガード、および PVST シミュレーションの設定の   
詳細について説明します。

付録 A「Cisco NX-OS Release 4.0 レイ     
ヤ 2 スイッチング機能の設定の上限」

レイヤ 2 スイッチング機能の制限について説明します。
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関連資料
Cisco DCNM のマニュアルの詳細は、次の URL を参照してください。

http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html

Cisco DCNM の一連の資料には、次のマニュアルが含まれています。

リリース ノート

『Cisco DCNM Release Notes, Release 4.0』

DCNM コンフィギュレーション ガイド

『Cisco DCNM Getting Started with Virtual Device Contexts, Release 4.0』

『Cisco DCNM Fundamentals Configuration Guide, Release 4.0』

『Cisco DCNM Interfaces Configuration Guide, Release 4.0』

『Cisco DCNM Layer 2 Switching Configuration Guide, Release 4.0』

『Cisco DCNM Web Services API Guide, Release 4.0』

『Cisco DCNM Security Configuration Guide, Release 4.0』

『Cisco DCNM Unicast Routing Configuration Guide, Release 4.0』

『Cisco DCNM Virtual Device Context Configuration Guide, Release 4.0』

http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html
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マニュアルの入手方法、テクニカル サポート、およびセキュリティ 
ガイドライン

マニュアルの入手方法、テクニカル サポート、マニュアルに関するフィードバックの提供、セキュ 
リティ ガイドライン、および推奨エイリアスや一般的なシスコのマニュアルについては、次の URL  
で、毎月更新される『What’s New in Cisco Product Documentation』を参照してください。シスコの新     
規および改訂版の技術マニュアルの一覧も示されています。

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

シスコのテクニカル サポート
次の URL にアクセスして、シスコのテクニカル サポートを最大限に活用してください。

http://www.cisco.com/en/US/support/index.html

以下を含むさまざまな作業にこの Web サイトが役立ちます。

 • テクニカル サポートを受ける

 • ソフトウェアをダウンロードする

 • セキュリティの脆弱性を報告する、またはシスコ製品のセキュリティ問題に対する支援を受け

る

 • ツールおよびリソースへアクセスする

－ Product Alert の受信登録

－ Field Notice の受信登録

－ Bug Toolkit を使用した既知の問題の検索

 • Networking Professionals（NetPro）コミュニティで、技術関連のディスカッションに参加する

 • トレーニング リソースへアクセスする

 • TAC Case Collection ツールを使用して、ハードウェアや設定、パフォーマンスに関する一般的   
な問題をインタラクティブに特定および解決する

Japan テクニカル サポート Web サイトでは、Technical Support Web サイト
（http://www.cisco.com/techsupport）の、利用頻度の高いドキュメントを日本語で提供しています。

Japan テクニカル サポート Web サイトには、次の URL からアクセスしてください。

http://www.cisco.com/jp/go/tac

Service Request ツールの使用
Service Request ツールには、次の URL からアクセスできます。

http://www.cisco.com/techsupport/servicerequest

日本語版の Service Request ツールは次の URL からアクセスできます。

http://www.cisco.com/jp/go/tac/sr/

シスコの世界各国の連絡先一覧は、次の URL で参照できます。

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
http://www.cisco.com/en/US/support/index.html
http://www.cisco.com/techsupport
http://www.cisco.com/jp/go/tac
http://www.cisco.com/techsupport/servicerequest
http://www.cisco.com/jp/go/tac/sr/
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml
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その他の情報の入手方法

シスコの製品、サービス、テクノロジー、ネットワーキング ソリューションに関する情報につい 
て、さまざまな資料をオンラインで入手できます。

 • シスコの E メール ニュースレターなどの配信申し込みについては、Cisco Subscription Center に      
アクセスしてください。

http://www.cisco.com/offer/subscribe

 • 日本語の月刊 Email ニュースレター「Cisco Customer Bridge」については、下記にアクセスくだ    
さい。

http://www.cisco.com/web/JP/news/cisco_news_letter/ccb/

 • シスコ製品に関する変更やアップデートの情報を受信するには、Product Alert Tool にアクセス   
し、プロファイルを作成して情報の配信を希望する製品を選択してください。Product Alert Tool  
には、次の URL からアクセスできます。
http://tools.cisco.com/Support/PAT/do/ViewMyProfiles.do?local=en

 • 『Cisco Product Quick Reference Guide』はリファレンス ツールで、パートナーを通じて販売され     
ている多くのシスコ製品に関する製品概要、主な機能、製品番号、および簡単な技術仕様が記

載されています。『Cisco Product Quick Reference Guide』を発注するには、次の URL にアクセス      
してください。

http://www.cisco.com/go/guide

 • ネットワークの運用面の信頼性を向上させることのできる最新の専門的サービス、高度なサー

ビス、リモート サービスに関する情報については、Cisco Services Web サイトを参照してくだ    
さい。Cisco Services Web サイトには、次の URL からアクセスできます。
http://www.cisco.com/go/services

 • Cisco Marketplace では、さまざまなシスコの書籍、参考資料、マニュアル、ロゴ入り商品を提
供しています。Cisco Marketplace には、次の URL からアクセスできます。
http://www.cisco.com/go/marketplace/

 • DVD に収録されたシスコの技術マニュアル（Cisco Product Documentation DVD）は、Product 
Documentation Store で発注できます。Product Documentation Store には、次の URL からアクセス
できます。

http://www.cisco.com/go/marketplace/docstore

 • 日本語マニュアルの DVD は、マニュアルセンターから発注できます。マニュアルセンターに  
は下記よりアクセスください。

http://www.cisco.com/japanese/warp/public/3/jp/service/manual_j/manual_center/index.shtml

 • Cisco Press では、ネットワーク、トレーニング、認定関連の出版物を発行しています。Cisco 
Press には、次の URL からアクセスできます。
http://www.ciscopress.com

 • 日本語のシスコプレスの情報は以下にアクセスください。

http://www.seshop.com/se/ciscopress/default.asp

 • 『Internet Protocol Journal』は、インターネットおよびイントラネットの設計、開発、運用を担  
当するエンジニア向けに、シスコが発行する季刊誌です。『Internet Protocol Journal』には、次  
の URL からアクセスできます。
http://www.cisco.com/ipj

 • 『What's New in Cisco Product Documentation』は、シスコ製品の最新マニュアル リリースに関す      
る情報を提供するオンライン資料です。毎月更新されるこの資料は、製品カテゴリ別にまとめ

られているため、目的の製品マニュアルを見つけることができます。

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

 • シスコの Web サイトの各国語版へは、次の URL からアクセスしてください。
http://www.cisco.com/public/countries_languages.shtml

http://www.cisco.com/offer/subscribe
http://www.cisco.com/web/JP/news/cisco_news_letter/ccb/
http://tools.cisco.com/Support/PAT/do/ViewMyProfiles.do?local=en
http://www.cisco.com/go/guide
http://www.cisco.com/go/services
http://www.cisco.com/go/marketplace/
http://www.cisco.com/go/marketplace/docstore
http://www.cisco.com/japanese/warp/public/3/jp/service/manual_j/manual_center/index.shtml
http://www.ciscopress.com
http://www.seshop.com/se/ciscopress/default.asp
http://www.cisco.com/ipj
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
http://www.cisco.com/public/countries_languages.shtml
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1
概要

Cisco NX-OS デバイスは、本マニュアル『Cisco DCNM Layer 2 Switching コンフィギュレーション ガ        
イド』で説明するレイヤ 2 機能をサポートしています。

（注） レイヤ 2 セキュリティ機能の情報は、『Cisco DCNM Security Configuration Guide』を参照してくださ      
い。

この章で説明する内容は、次のとおりです。

 • VLAN（p.1-2）

 • プライベート VLAN（p.1-2）

 • スパニング ツリー（p.1-3）

 • バーチャライゼーションとレイヤ 2 スイッチング（p.1-5）

 • 関連資料（p.1-6）
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1-2
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0

OL-15867-01-J

VLAN
VLAN は、ユーザの物理的な場所に関係なく、機能、プロジェクト チーム、またはアプリケーショ  
ンによって論理的にセグメント化されるスイッチド ネットワークです。VLAN には、物理 LAN と    
同じアトリビュートが設定されますが、物理的に同じ LAN セグメント上に存在しない端末でもグ  
ループ化できます。

VLANには、任意のスイッチ ポートを加入させることができ、ユニキャスト、ブロードキャスト、 
およびマルチキャストのパケットは、その VLAN 内の端末だけに転送され、フラッディングされま  
す。各 VLAN は 1 つの論理ネットワークであるとみなされます。VLAN に属していないステーショ     
ン宛てのパケットは、ブリッジまたはルータを経由して転送する必要があります。

デバイスの初回の起動時は、管理ポートを含むすべてのポートがデフォルト VLAN（VLAN1）に割 
り当てられます。VLAN インターフェイスまたは Switched Virtual Interface（SVI; スイッチ仮想イン     
ターフェイス）は、VLAN 間の通信用として作成されるレイヤ 3 インターフェイスです。

このデバイスは、IEEE 802.1Q 規格に基づき、4094 の VLAN をサポートします。これらの VLAN は       
いくつかの範囲に分かれています。各範囲の使用法は少しずつ異なります。一部の VLAN はデバイ  
スの内部使用のために予約されるので、設定には使用できません。

（注） ソフトウェア上では、Inter-Switch Link（ISL; スイッチ間リンク）はサポートされません。

VLAN 設定の詳細については、第 2 章「VLAN の設定」を参照してください。

プライベート VLAN
プライベート VLAN は、レイヤ 2 レベルでのトラフィック分離とセキュリティを提供します。

プライベート VLAN は、同じプライマリ VLAN を使用する、プライマリ VLAN とセカンダリ VLAN       
の 1 つまたは複数のペアで構成されます。セカンダリ VLAN には、独立 VLAN とコミュニティ      
VLAN の 2 種類があります。独立 VLAN 内のホストは、プライマリ VLAN 内のホストだけと通信       
します。コミュニティ VLAN 内のホストは、そのコミュニティ VLAN 内のホスト間およびプライ    
マリ VLAN 内のホストとのみ通信でき、独立 VLAN または他のコミュニティ VLAN 内のホストと      
は通信できません。

セカンダリ VLAN が独立 VLAN であるかコミュニティ VLAN であるかに関係なく、プライマリ 
VLAN 内のインターフェイスはすべて、1 つのレイヤ 2 ドメインを構成します。つまり、必要な IP 
サブネットは 1 つだけです。

プライベート VLAN および関連するプライマリ VLAN とセカンダリ VLAN の設定と使用方法につ      
いては、第 3 章「プライベート VLAN の設定」を参照してください。
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スパニング ツリー
ここでは、ソフトウェア上での STP の実装について説明します。スパニング ツリーは、IEEE 802.1w    
および IEEE 802.1s を表す場合に使用されます。このマニュアルで IEEE 802.1D 規格の STP につい        
て記す場合は、802.1D であることを明記します。

ここでは、次の内容について説明します。

 • STP の概要（p.1-3）

 • Rapid PVST+（p.1-3）

 • MST（p.1-4）

 • STP 拡張機能（p.1-4）

STP の概要
STP は、レイヤ 2 レベルで、ループフリー（ループを発生させない）ネットワークを提供します。   
レイヤ 2 LAN ポートは、Bridge Protocol Data Unit（BPDU; ブリッジ プロトコル データ ユニット）          
と呼ばれる STP フレームを定期的に送受信します。ネットワーク デバイスは、これらのフレーム   
を転送せずに、フレームを使用してループフリー パスを構築します。

802.1D は、オリジナルの STP 規格です。基本的なループフリー STP から、多数の改善を経て拡張     
されました。Per VLAN Spanning Tree（PVST+）では、各 VLAN に個別にループフリー パスを作成      
できます。また、機器の高速化に対応して、ループフリー コンバージェンス処理も高速化するため 
に、規格全体が再構築されました。802.1w 規格は、高速コンバージェンスが統合された STP で、   
Rapid Spanning Tree（RSTP）と呼ばれています。現在では、各 VLAN 用の STP に高速コンバージェ      
ンス タイムを実装できます。これが、Per VLAN Rapid Spanning Tree（Rapid PVST+）です。

さらに、802.1s 規格の Multiple Spanning Tree（MST）では、複数の VLAN を単一のスパニング ツ       
リー インスタンスにマッピングできます。各インスタンスは、独立したスパニング ツリー トポロ   
ジで実行されます。

ソフトウェアは、従来の 802.1D システムで相互運用できますが、システムでは Rapid PVST+ およ     
び MST が実行されます。特定の Virtual Device Context（VDC） に、Rapid PVST+ または MST のど          
ちらか を使用できます。1 つの VDC で両方を使用することはできません。ソフトウェアのデフォ    
ルトの STP プロトコルは、Rapid PVST+ です。

（注） ソフトウェアは、拡張システム ID および MAC アドレス リダクションを使用します。これらの機     
能をディセーブルにすることはできません。

また、シスコでは独自仕様の機能により、STP の動作を拡張しています（拡張機能の概要について 
は、「STP 拡張機能」[p.1-4] を参照してください）。

Rapid PVST+

Rapid PVST+ は、ソフトウェアのデフォルトのスパニング ツリー モードで、デフォルト VLAN お      
よび新規作成のすべての VLAN 上で、デフォルトでイネーブルになります。

設定された各 VLAN 上で RSTP の単一インスタンスまたはトポロジが実行され、VLAN 上の各     
Rapid PVST+ インスタンスに 1 つのルート デバイスが設定されます。Rapid PVST+ が稼働している       
場合、STP は、VLAN 単位でイネーブルまたはディセーブルにできます。

Rapid PVST+ の設定および実行の詳細については、第 4 章「Rapid PVST+ の設定」を参照してくだ      
さい。
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MST

ソフトウェアは、MST もサポートしています。MST を使用した複数の独立したスパニング ツリー   
トポロジにより、データ トラフィック用に複数の転送パスを提供し、ロード バランスを有効にし  
て、多数の VLAN をサポートするために必要なスパニング ツリー インスタンス数を削減できます。

MST には RSTP が統合されているので、高速コンバージェンスもサポートされます。MST では、1    
つのインスタンス（転送パス）で障害が発生しても他のインスタンス（転送パス）に影響しないの

で、ネットワークの耐障害性が向上します。

（注） スパニング ツリー モードを変更すると、すべてのスパニング ツリー インスタンスが前のモードで    
停止して新規モードで開始されるため、トラフィックが中断されます。

Cisco NX-OS Release 4.0(2) 以降のリリースでは、コマンドライン インターフェイス（CLI）を使用     
して、標準ではなく先行標準の MST メッセージを送信するように特定のインターフェイスを設定  
できます。

MST の設定および実行の詳細については、第 5 章「MST の設定」を参照してください。

STP 拡張機能
ソフトウェアは、以下に示すシスコ独自の機能をサポートしています。

 • スパニング ツリー ポート タイプ ― デフォルトのスパニング ツリー ポート タイプは、標準
（normal）です。レイヤ 2 ホストに接続するインターフェイスをエッジ ポートとして、また、
レイヤ 2 スイッチまたはブリッジに接続するインターフェイスをネットワーク ポートとして
設定できます。

 • ブリッジ保証 ― ポートをネットワーク ポートとして設定すると、ブリッジ保証によりすべて   
のポート上に BPDU が送信され、BPDU を受信しないポートはブロッキング ステートに移行し    
ます。この拡張機能を使用できるのは、Rapid PVST+ または MST を実行する場合だけです。

 • BPDU ガード ― BPDU ガードは、BPDU を受信したポートをシャットダウンします。

 • BPDU フィルタ ― BPDU フィルタは、ポート上での BPDU の送受信を抑制します。

 • ループ ガード ― ループ ガードは、非指定ポートが STP フォワーディング ステートに移行す       
るのを阻止し、ネットワーク上でのループの発生を防止します。

 • ルート ガード ― ルート ガードは、ポートが STP トポロジのルートにならないように防御しま      
す。

これらの STP 拡張機能の設定および実行の詳細については、第 6 章「STP 拡張機能の設定」を参照     
してください。
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バーチャライゼーションとレイヤ 2 スイッチング
NX-OS ソフトウェアにより、単一スイッチング デバイス上で複数の Virtual Device Context（VDC）     
がサポートされるようになりました。各 VDC はスタンドアロン デバイスとして処理され、物理イ   
ンターフェイスなどの特定のリソースがネットワーク管理ロールによって各 VDC に割り当てられ  
ます。各 VDC には管理者が割り当てられます。この管理者は、特定の VDC 内で、限定されたシス    
テム情報を表示できます。障害もまた、特定の VDC 内で分離されます。

この VDC コンセプトは、すべてのレイヤ 2 スイッチング機能を含む、Cisco NX-OS 上のすべての
機能に適用されます。

各 VDC では、すべてのプロセスが個別に実行されます（図 1-1 を参照）。同じプロセス ID 番号を、     
別の VDC で再使用できます。たとえば、図 1-1 に示すように、個別の各 VDC で VLAN 100 の ID         
を再使用できます。

図 1-1 VDC でのレイヤ 2 サービスの使用

各 VDC は、レイヤ 2 サービスを使用できるスタンドアロン デバイスとして動作します。VDC によ      
り、複数の論理機能で物理デバイスを共有できます。完全に分離された レイヤ 2 リソースをプロビ   
ジョニングして、個々の VDC に割り当てることができます。

複数の VDC を設定すると、各 VDC が物理デバイス リソースのグループになります。各 VDC に、       
リソースおよびユーザ ロールを割り当てます。VDC を使用すると、システムのリソースを著しく  
拡張して柔軟に使用できるだけでなく、障害分離も容易になります。

VDC では、プロセスおよび管理環境を分離することにより、論理デバイス間に障害および管理上 
の境界を確実に定義できます。各 VDC を、独自の設定、リソース、ユーザ、および管理インター  
フェイスを備えた個別のデバイスとして捉えることができます。

Vlan 100

Vlan 101

STP 100

VDC 1

Vlan 100

Vlan 101

STP 100

VDC 2

Vlan 100

Vlan 101

STP 100

VDC 10

Vlan 100

Vlan 101

STP 100

VDC 20
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VDC ごとに異なる管理者レベルまたはロールで、各 VDC にアクセスして管理できます。特定の   
ユーザ ロールの範囲外であるコマンドは、そのユーザに対して非表示になるか、コマンドを入力す 
るとエラーが返されます。この機能により、物理デバイス全体にアクセスできるユーザ数を制限し、

トラフィック中断の原因となる設定ミスを軽減できます。

（注） VDC およびリソース割り当ての詳細については、『Cisco DCNM Virtual Device Context Configuration      
Guide』を参照してください。

（注） 再起動性およびシームレスな移行については、『Cisco NX-OS High Availability and Redundancy Guide』      
を参照してください。

関連資料
レイヤ 2 スイッチング機能に関連するマニュアルは、次のとおりです。

 • 『Cisco NX-OS Layer 2 Switching Configuration Guide』

 • 『Cisco DCNM Interfaces Configuration Guide』

 • 『Cisco DCNM Security Configuration Guide』

 • 『Cisco DCNM Virtual Device Context Configuration Guide』

 • 『Cisco DCNM Licensing Guide』

 • 『Cisco NX-OS High Availability and Redundancy Guide』

 • 『Cisco NX-OS System Management Configuration Guide』
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2
VLAN の設定

この章では、NX-OS デバイス上での VLAN（仮想 LAN）の設定方法について説明します。

Data Center Network Manager（DCNM）機能の詳細については、『Cisco DCNM Fundamentals 
Configuration Guide』を参照してください。

この章の内容は、次のとおりです。

 • VLAN について（p.2-2）

 • VLAN のライセンス要件（p.2-7）

 • VLAN 設定の前提条件（p.2-7）

 • 注意事項および制約事項（p.2-7）

 • VLAN の設定（p.2-8）

 • 統計情報の表示（p.2-11）

 • VLAN 設定のフィールドの説明（p.2-11）

 • 追加情報（p.2-21）

（注） プライベート VLAN の情報については、第 3 章「プライベート VLAN の設定」を参照してください。
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VLAN について
VLAN を使用すると、ネットワークを、レイヤ 2 レベルの個別の論理領域として分割できます。ま   
た、VLAN をブロードキャスト ドメインとして扱うこともできます。

VLAN には、任意のスイッチ ポートを加入させることができ、ユニキャスト、ブロードキャスト、  
およびマルチキャストのパケットは、その VLAN 内の端末だけに転送され、フラッディングされま  
す。各 VLAN は 1 つの論理ネットワークであるとみなされます。VLAN に属していないステーショ     
ン宛てのパケットは、ブリッジまたはルータを経由して転送する必要があります。

ここでは、次の内容について説明します。

 • VLAN の概要（p.2-2）

 • VLAN の範囲（p.2-4）

 • VLAN の作成、削除、および変更（p.2-5）

 • ハイ アベイラビリティ（p.2-6）

 • バーチャライゼーションのサポート（p.2-6）

VLAN の概要

（注） VLAN Trunking Protocol（VTP; VLAN トランキング プロトコル）モードは、オフです。他のデバイ     
ス上で VTP がオンの場合に VTP ドメインを分割する VTP Protocol Data Unit（PDU; プロトコル デー          
タ ユニット）は、すべてのデバイスのインターフェイスで廃棄されます。

VLAN は、ユーザの物理的な場所に関係なく、機能またはアプリケーションによって論理的にセグ 
メント化されるスイッチド ネットワーク内の端末のグループです。VLAN には、物理 LAN と同じ    
アトリビュートが設定されますが、物理的に同じ LAN セグメント上に存在しない端末でもグルー  
プ化できます。

VLANには、任意のスイッチ ポートを加入させることができ、ユニキャスト、ブロードキャスト、 
およびマルチキャストのパケットは、その VLAN 内の端末だけに転送され、フラッディングされま  
す。各 VLAN は 1 つの論理ネットワークであるとみなされ、VLAN に属していないステーション宛     
てのパケットは、ルータ経由で転送する必要があります。
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図 2-1 に、論理ネットワークとしての VLAN を示します。この図では、エンジニアリング部門の端   
末が 1 つの VLAN に割り当てられ、マーケティング部門の端末およびアカウンティング部門の端末    
も、それぞれ別の VLAN に割り当てられています。

図 2-1 論理的に定義されたネットワークとしての VLAN

VLAN は通常、IP サブネットワークと関連付けられます。たとえば、特定の IP サブネットに含ま    
れるすべての端末を同じ VLAN に割り当てます。別の VLAN と通信するには、トラフィックをルー    
ティングする必要があります。

デフォルトでは、新規に作成された VLAN は動作可能です。つまり、新規に作成された VLAN は、    
非シャットダウンの状態になります。また、VLAN は、トラフィックを転送するアクティブ ステー  
ト、またはパケットを転送しない一時停止（suspended）ステートとして設定できます。デフォルト
では、VLAN はアクティブ ステートで、トラフィックを転送します。

VLAN インターフェイスまたは Switched Virtual Interface（SVI; スイッチ仮想インターフェイス）は、     
VLAN 間の通信用として作成されるレイヤ 3 インターフェイスです。VLAN 間でトラフィックを    
ルーティングするには、各 VLAN に VLAN インターフェイスを作成して、設定する必要がありま    
す。各 VLAN に必要な VLAN インターフェイスは、1 つだけです。

（注） VLAN ネットワーク インターフェイス、サブインターフェイスの設定、および IP アドレスの割り    
当ての詳細については、『Cisco DCNM Interfaces Configuration Guide』を参照してください。この機    
能は、VLAN ネットワーク インターフェイスを設定する前にイネーブルにする必要があります。

1 

2 

 VLAN

3 

 VLAN  VLAN
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39
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VLAN の範囲

（注） NX-OS デバイスでは、拡張システム ID が常に自動的にイネーブルになります。

このデバイスは、IEEE 802.1Q 規格に従って、各 Virtual Device Context（VDC）で 4094 の VLAN を         
サポートします。これらの VLAN は、ソフトウェアによっていくつかの範囲に分割され、範囲に  
よって用途が少しずつ異なります。

表 2-1 に VLAN の範囲を示します。

（注） VLAN 3968 ～ 4047 および 4094 は、各 VDC の内部使用のために予約されています。これらの VLAN         
を使用または変更することはできません。

ソフトウェアは、内部 VLAN の使用を必要とするマルチキャストや診断などの機能のために、80  
の VLAN 番号のグループを割り当てます。デフォルトでは、VLAN 3968 ～ 4047 が内部用として割      
り当てられます。また、VLAN 4094 もデバイスによる内部使用のために予約されます。

（注） マルチキャストの情報については『Cisco NX-OS Multicast Routing Configuration Guide』を、診断の     
情報については『Cisco NX-OS System Management Configuration Guide』を参照してください。

予約されたグループ内の VLAN を使用、変更、または削除することはできません。内部的に割り当  
てられた VLAN および関連用途を表示することはできます。

表 2-1 VLAN の範囲 

VLAN 番号 範囲 用途

1 標準 シスコ システムズのデフォルトです。この VLAN は使用できます   
が、変更または削除することはできません。

2 ～ 1005 標準 これらの VLAN は、作成、使用、変更、および削除ができます。

1006 ～ 4094 拡張 これらの VLAN は、作成、名前指定、および使用ができます。次  
のパラメータは変更できません。

 • ステートは必ず、アクティブです。

 • VLAN は常にイネーブルです。これらの VLAN はシャットダ   
ウンできません。

3068 ～ 4047 
および 4094

内部割り当て

済み

これらの 80 の VLAN と VLAN 4094 は、内部デバイス用に割り当       
てられています。内部用に予約されている範囲内の VLAN の作成、  
削除、または変更はできません。



第 2章      VLAN の設定
VLAN について 

2-5
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0        

OL-15867-01-J

VLAN の作成、削除、および変更

（注） デフォルトでは、すべての NX-OS ポートがレイヤ 3 ポートです。

VLAN は、各 VDC で 1 ～ 4094 の番号が割り当てられます。スイッチ ポートとして設定したポー        
トはすべて、レイヤ 2 デバイスとしてのスイッチの初回起動時に、デフォルト VLAN に割り当てら    
れます。デフォルト VLAN（VLAN 1）はデフォルト値のみを使用します。デフォルト VLAN のア    
クティビティを作成、削除、または一時停止することはできません。

VLAN は、番号を割り当てることによって作成します。作成した VLAN は削除したり、アクティブ   
ステートから一時停止ステートに移行したりできます。既存の VLAN ID を使用して VLAN を作成     
しようとすると、デバイスで VLAN サブモードが開始されますが、同じ VLAN は再作成されません。

新規に作成した VLAN は、その VLAN にレイヤ 2 ポートが割り当てられるまでは未使用の状態に      
なります。デフォルトでは、すべてのポートが VLAN1 に割り当てられます。

VLAN の範囲に応じて、VLAN（デフォルト VLAN を除く）に次のパラメータを設定できます。

 • VLAN 名

 • VLAN ステート

 • シャットダウンまたは非シャットダウン

（注） VLAN アクセス ポートまたはトランク ポートとしてのポート設定および VLAN へのポート割り当     
ての詳細については、『Cisco DCNM Interfaces Configuration Guide』を参照してください。

特定の VLAN を削除すると、その VLAN に関連付けられていたポートがシャットダウンし、トラ    
フィックの転送が停止します。トランク ポートから特定の VLAN を削除すると、その VLAN だけ     
がシャットダウンし、トラフィックは引き続き、トランク ポート経由で他のすべての VLAN 上で   
転送されます。

ただし、削除した VLAN の VLAN とポートのマッピングはシステム上にすべて存続しているので、    
その VLAN を再イネーブル化または再作成すると、元のポート設定が自動的にその VLAN に戻さ    
れます。VLAN のスタティック MAC アドレスとエージング タイムは、VLAN を再イネーブル化し     
ても復元されません。

（注） VLAN 3968 ～ 4047 および 4094 は、各 VDC の内部使用のために予約されています。これらの VLAN         
を使用または変更することはできません。
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ハイ アベイラビリティ
このソフトウェアでは、コールド リブート時に、VLAN のステートフルおよびステートレスの両方  
の再起動で、ハイ アベイラビリティがサポートされます。ステートフルな再起動では、最大 3 回の   
再試行がサポートされます。再起動から 10 秒以内に 4 回以上の再試行を行うと、スーパーバイザ    
モジュールがリロードされます。

ソフトウェアのアップグレードまたはダウングレードは、VLAN に関してはシームレスに実行でき 
ます。

（注） ハイ アベイラビリティ機能の詳細については、『Cisco NX-OS High Availability and Redundancy 
Configuration Guide』を参照してください。

バーチャライゼーションのサポート

このソフトウェアは、VDC をサポートしているので、VLAN の設定および運用は各 VDC にローカ    
ルになります。

（注） VDC およびリソース割り当ての詳細については、『Cisco DCNM Virtual Device Context Configuration      
Guide』を参照してください。

各 VLAN では、すべてのポートが同じ VDC に存在している必要があります。VDC に十分なリソー     
スが割り当てられていない場合、ソフトウェアによりエラー メッセージが戻されます。

新規の VDC を作成すると、新しいデフォルト VLAN として VLAN1 が自動的に作成され、VLAN      
3968 ～ 4047 および 4094 がデバイス用として内部予約されます。

1 つ以上の VLAN を、ユーザによる設定を許可または拒否するロールに関連付けることができます。   
VLAN をロールに関連付けると、対応するインターフェイスも同じチェックの対象になります。た 
とえば、ロールに VLAN1へのアクセスが許可されている場合、VLAN1を使用するインタ－フェイ
スへのアクセスも許可されます。インターフェイスに、ロールに関連付けられた VLAN が設定され  
ていない場合、そのインターフェイスはそのロールにアクセスできません。
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VLAN のライセンス要件
次の表に、この機能に関するライセンス要件を示します。

ただし、VDC を使用するには、Advanced Services ライセンスが必要です。

VLAN 設定の前提条件
VLAN 設定時の前提条件は、次のとおりです。

 • デバイスにログオンしている必要があります。

 • VLAN を変更するには、その VLAN が作成されている必要があります。

注意事項および制約事項
VLAN の作成時は、次の注意事項および制約事項に従ってください。

 • 各 VDC の VLAN の最大数は、4094 です。

 • 内部使用のために予約された VLAN グループ内の VLAN は、作成、変更、または削除するこ    
とはできません。

 • VLAN1 は、デフォルトの VLAN です。この VLAN を作成、変更、または削除することはでき     
ません。

 • VLAN 1006 ～ 4094 は常にアクティブ ステートなので、常にイネーブルです。これらの VLAN 
のステートを一時停止またはシャットダウンすることはできません。

製品 ライセンス要件

DCNM VLAN のライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco DCNM にバンドル     
され、無料で提供されます。DCNM ライセンス機構の詳細については、『Cisco DCNM Licensing Guide』を    
参照してください。

NX-OS VLAN のライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco NX-OS システム イ      
メージにバンドルされ、無料で提供されます。NX-OS ライセンス機構の詳細については、『Cisco NX-OS  
Licensing Guide』を参照してください。
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VLAN の設定
ここでは、次の内容について説明します。

 • VLAN の作成および削除（p.2-8）

 • VLAN の基本設定の変更（p.2-10）

（注） VLAN（アクセス ポートまたはトランク ポート）へのレイヤ 2 インターフェイスの割り当ての詳    
細については、『Cisco DCNM Interfaces Configuration Guide』を参照してください。デフォルトでは、    
すべてのインターフェイスが VLAN1 に割り当てられます。

VLAN の作成および削除
デフォルトの VLAN およびデバイス用に内部的に割り当てられた VLAN 以外は、すべての VLAN     
を作成または削除できます。

作成した VLAN は、自動的にアクティブ ステートになります。

（注） VLAN を削除すると、その VLAN に関連付けられているポートがシャットダウンします。したがっ   
て、廃棄されるトラフィック フローやパケットはありません。トランク ポートの場合、ポートは  
オープンしたたままで、削除した VLAN を除く他のすべての VLAN からのトラフィックが引き続    
き転送されます。

作成する VLAN の範囲内に作成できない VLAN が含まれていると、作成できない VLAN がリスト      
されたメッセージが戻されますが、指定範囲内の他の VLAN はすべて作成されます。

VLAN を作成するには、VLAN ペインを使用します（図 2-2 を参照）。
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図 2-2 VLAN 設定の詳細

手順の詳細

VLAN を作成または削除するには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching > VLAN  を選択して VLAN ペインを開きます。

ステップ 2 Summary ペインで Device View タブをクリックします。

ステップ 3 Summary ペインで、VLAN を作成するデバイスをクリックします。

ステップ 4 ツールバーで New をクリックします。

ステップ 5 ドロップダウン リストから、Normal VLAN を選択します。

ステップ 6 VLAN ID カラムで、作成する VLAN の ID を入力します。

VLAN は、デフォルト設定の状態ですぐに作成されます。

ステップ 7 （任意）VLAN の名前を変更するには、Name カラムをクリックし、設定する名前を入力します。
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ステップ 8 （任意）Summary ペインで削除する VLAN をクリックしてから、メニュー バーから VLAN > Delete       
を選択します。

これらの VLAN を削除してよいかどうかの確認メッセージが表示されます。Yes をクリックする   
と、これらの VLAN はデバイスからすぐに削除されます。

ステップ 9 （任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。

VLAN の基本設定の変更
VLAN ペインを使用して、VLAN の基本設定を変更できます（図 2-2 を参照）。

手順の詳細

VLAN の基本設定を変更するには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching > VLAN  を選択して VLAN ペインを開きます。

ステップ 2 Summary ペインで Device View タブをクリックします。

ステップ 3 設定を変更するデバイスをクリックします。

Summary ペインで選択したデバイスが強調表示され、Details ペインにタブが表示されます。

ステップ 4 そのデバイスを展開表示します。

デバイスに設定された VLAN が一覧表示されます。

ステップ 5 設定を変更するデバイスを選択します。

ステップ 6 Details ペインで VLAN Details タブをクリックします。

ステップ 7 VLAN Settings タブをクリックします。

（注） Media 行のグレー表示された値を Ethernet から変更しないでください。サポートされるメ
ディアは Ethernet のみです。

ステップ 8 VLAN Name フィールドに名前を入力します。

ステップ 9 ドロップダウン リストから、設定する VLAN のタイプ、管理ステート、および管理ステータスを   
選択します。

ステップ 10 デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。
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統計情報の表示
次のウィンドウが Statistics タブに表示されます。

 • VLAN Traffic Statistics ― レイヤ 2 のユニキャスト、マルチキャスト、およびブロードキャスト      
トラフィック、レイヤ 3 のユニキャストおよびマルチキャスト トラフィックなどの VLAN ト     
ラフィックについての情報が表示されます。

VLAN 設定のフィールドの説明
ここでは、VLAN ペインで表示されるフィールドについて説明します。内容は次のとおりです。

 • Device ビュー：デバイス：グローバル設定：Global Settings セクション（p.2-11）

 • Device ビュー：VLAN：VLAN の詳細：VLAN Settings セクション（p.2-12）

 • Device ビュー：VLAN：VLAN の詳細：Advanced Settings セクション（p.2-16）

 • Device ビュー：VLAN：標準 VLAN の VLAN ポート：Access Ports セクション（p.2-16）

 • Device ビュー：VLAN：標準 VLAN の VLAN ポート：Trunk Ports セクション（p.2-16）

 • Device ビュー：VLAN：プライマリ VLAN のプライマリ VLAN ポート：Promiscuous Ports セク       
ション（p.2-17）

 • Device ビュー：VLAN：セカンダリ VLAN の Secondary VLAN Ports タブ：PVLAN Host Ports セ          
クション（p.2-17）

 • Network ビュー：デバイス：VLAN の詳細：VLAN Settings セクション（p.2-18）

 • Network ビュー：デバイス：VLAN の詳細：Advanced Settings セクション（p.2-19）

 • Network ビュー：デバイス：VLAN ポート：Access Ports セクション（p.2-19）

 • Network ビュー：デバイス：VLAN ポート：Trunk Ports セクション（p.2-19）

Device ビュー：デバイス：グローバル設定：Global Settings セクション

表 2-2 Device ビュー：デバイス：グローバル設定：Global Settings セクション

フィールド 説明

Dot1Q Native Tag デバイスのすべてのトランク ポートで維持されるネイティブ VLAN のパケットのタギングデ   
フォルトはディセーブルです。
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Device ビュー：VLAN：VLAN の詳細：VLAN Settings セクション

表 2-3 Device ビュー：VLAN：VLAN の詳細：VLAN Settings セクション：標準 VLAN  

フィールド 説明

VLAN ID 表示のみ。VLAN ID です。デフォルトでは、VLAN の後ろに VLAN の番号が付きます
（VLANXXXX）。

Device 表示のみ。この VLAN のデバイスのホスト名または IP アドレスです。
VLAN Name VLAN の名前。デフォルト名は、VLAN の後ろに VLAN の番号が付きます（VLANXXXX）。
VLAN Type 標準 VLAN として設定されるタイプ。有効な値は、次のとおりです。

 • Normal

 • Primary 

 • Community

 • Isolated

Media このフィールドはサポートされていません。

Admin State 管理ステート。有効な値は、次のとおりです。

 • Active

 • Suspended

デフォルトは Active です。
Admin Status 管理ステータス。有効な値は、次のとおりです。

 • Enabled

 • Disabled

デフォルトは Enabled です。

VLAN ネットワーク インターフェイス設定
Description VLAN ネットワーク インターフェイスの説明。任意の印刷可能な文字列です。
IP Address VLAN ネットワーク インターフェイスの IP アドレス。ドット付き 10 進表記の有効な IP アド        

レスです（A:B:C:D）。
Netmask VLAN ネットワーク インターフェイスのネットワーク マスク（ドット付き 10 進表記）。
Admin State VLAN ネットワーク インターフェイスの管理ステート。有効な値は、次のとおりです。

 • Down

 • Up

デフォルトは Up です。
Oper Status 表示のみ。VLAN ネットワーク インターフェイスの動作ステータス。
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表 2-4 Device ビュー：VLAN：VLAN の詳細：VLAN 設定：プライマリ VLAN 

フィールド 説明

VLAN ID 表示のみ。VLAN ID です。デフォルトでは、VLAN の後ろに VLAN の番号が付きます
（VLANXXXX）。

Device 表示のみ。この VLAN のデバイスのホスト名または IP アドレスです。
VLAN Name VLAN の名前。デフォルト名は、VLAN の後ろに VLAN の番号が付きます（VLANXXXX）。
VLAN Type プライマリ VLAN として設定される VLAN のタイプ。プライベート VLAN は、ルータからプ      

ライベート VLAN ホスト ポートへのダウンストリーム トラフィックを伝送します。有効な値    
は、次のとおりです。

 • Normal

 • Primary 

 • Community

 • Isolated

Media このフィールドはサポートされていません。

Admin State 管理ステート。有効な値は、次のとおりです。

 • Active

 • Suspended

デフォルトは Active です。
Admin Status 管理ステータス。有効な値は、次のとおりです。

 • Enabled

 • Disabled

デフォルトは Enabled です。
Oper Status 表示のみ。VLAN の動作ステータス。

セカンダリ VLAN

（注） 各プライマリ VLAN に複数のセカンダリ VLAN を関連付けることができます。

VLAN Id 表示のみ。デバイスに設定された独立およびコミュニティ VLAN。
Type 表示のみ。セカンダリ VLAN のタイプ。有効な値は、次のとおりです。

 • Community

 • Isolated

VLAN ネットワーク インターフェイス設定
Description VLAN ネットワーク インターフェイスの説明。任意の印刷可能な文字列です。
IP Address VLAN ネットワーク インターフェイスの IP アドレス。ドット付き 10 進表記の有効な IP アド        

レスです（A:B:C:D）。
Netmask VLAN ネットワーク インターフェイスのネットワーク マスク（ドット付き 10 進表記）。
Admin State VLAN ネットワーク インターフェイスの管理ステート。有効な値は、次のとおりです。

 • Down

 • Up

デフォルトは Up です。
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表 2-5 Device ビュー：VLAN：VLAN の詳細：VLAN 設定：コミュニティ VLAN 

フィールド 説明

VLAN ID 表示のみ。VLAN ID です。デフォルトでは、VLAN の後ろに VLAN の番号が付きます
（VLANXXXX）。

Device 表示のみ。この VLAN のデバイスの ホスト名または IP アドレスです。
VLAN Name VLAN の名前。デフォルト名は、VLAN の後ろに VLAN の番号が付きます（VLANXXXX）。
VLAN Type コミュニティ VLAN として設定される VLAN 。有効な値は、次のとおりです。

 • Normal

 • Primary 

 • Community

 • Isolated

Primary VLAN ID 表示のみ。このコミュニティ VLAN が関連付けられているプライマリ VLAN が表示されます。

（注） プライマリ VLAN を関連付けていない場合、Not Configured と表示されます。

Media このフィールドはサポートされていません。

Admin State 有効な値は、次のとおりです。

 • Active

 • Suspended

デフォルトは Active です。
Admin Status 有効な値は、次のとおりです。

 • Enabled

 • Disabled

デフォルトは Enabled です。

VLAN ネットワーク インターフェイス設定

（注） コミュニティ VLAN をプライマリ VLAN に関連付けている場合、この VLAN ネットワーク インターフェイス       
はサポートされません。プラベート VLAN については、プライマリ VLAN 上の VLAN ネットワーク インター       
フェイスのみ動作します。

Description VLAN ネットワーク インターフェイスの説明。任意の印刷可能な文字列です。
IP Address VLAN ネットワーク インターフェイスの IP アドレス。ドット付き 10 進表記の有効な IP アド        

レスです（A:B:C:D）。
Netmask VLAN ネットワーク インターフェイスのネットワーク マスク（ドット付き 10 進表記）。
Admin State VLAN ネットワーク インターフェイスの管理ステート。有効な値は、次のとおりです。

 • Down

 • Up

デフォルトは Up です。
Oper Status 表示のみ。VLAN ネットワーク インターフェイスの動作ステータス。
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表 2-6 Device ビュー：VLAN：VLAN の詳細：VLAN 設定：独立 VLAN 

フィールド 説明

VLAN ID 表示のみ。VLAN ID です。デフォルトでは、VLAN の後ろに VLAN の番号が付きます
（VLANXXXX）。

Device 表示のみ。この VLAN のデバイスのホスト名または IP アドレスです。
VLAN Name VLAN の名前。最大文字列数は XXX です。デフォルト名は、VLAN の後ろに VLAN の数値が      

付きます（VLANXXXX）。
VLAN Type 独立 VLAN として設定される VLAN のタイプ。有効な値は、次のとおりです。

 • Normal

 • Primary 

 • Community

 • Isolated

Primary VLAN ID 表示のみ。このコミュニティ VLAN が関連付けられているプライマリ VLAN が表示されます。

（注） プライマリ VLAN を関連付けていない場合、Not Configured と表示されます。

Media このフィールドはサポートされていません。

Admin State 管理ステート。有効な値は、次のとおりです。

 • Active

 • Suspended

デフォルトは Active です。
Admin Status 管理ステータス。有効な値は、次のとおりです。

 • Enabled

 • Disabled

デフォルトは Enabled です。
Oper Status VLAN の動作ステータス。

VLAN ネットワーク インターフェイス設定

（注） 独立 VLAN がプライマリ VLAN に関連付けられている場合、この VLAN ネットワーク インターフェイスはサ       
ポートされません。プラベート VLAN については、プライマリ VLAN 上の VLAN ネットワーク インターフェ       
イスのみ動作します。

Description VLAN ネットワーク インターフェイスの説明。任意の印刷可能な文字列です。
IP Address VLAN ネットワーク インターフェイスの IP アドレス。ドット付き 10 進表記の有効な IP アド        

レスです（A:B:C:D）。
Netmask VLAN ネットワーク インターフェイスのネットワーク マスク（ドット付き 10 進表記）。
Admin State VLAN ネットワーク インターフェイスの管理ステート。有効な値は、次のとおりです。

 • Down

 • Up

デフォルトは Up です。
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Device ビュー：VLAN：VLAN の詳細：Advanced Settings セクション

Device ビュー：VLAN：標準 VLAN の VLAN ポート：Access Ports セクション

Device ビュー：VLAN：標準 VLAN の VLAN ポート：Trunk Ports セクション

表 2-7 Device ビュー：VLAN：VLAN の詳細：Advanced Settings セクション 

フィールド 説明

SPAN 設定
RSPAN VLAN リモート SPAN（RSPAN）VLAN の有無についてのステータス

SPAN の始点の設定
Session ID 表示のみ。インターフェイス結合時の SPAN セッション ID
Type 表示のみ。セッションのタイプ

Direction:Ingress 入力パケットのモニタ

Direction:Egress 出力パケットのモニタ

セキュリティ設定

DAI 表示のみ。Dynamic ARP Inspection（DAI; ダイナミック ARP インスペクション）がイネーブル     
かディセーブルかについてのステータス

DHCP Snooping 表示のみ。DHCP スヌーピングがイネーブルかディセーブルかについてのステータス
VACL VLAN で入力トラフィックをフィルタする VLAN アクセス マップ

表 2-8 Device ビュー：VLAN：標準 VLAN の VLAN ポート：Access Ports セクション 

フィールド 説明

Interface Name 表示のみ。アクセス インターフェイスの名前。このインターフェイスは、物理ポートまたは 
ポート チャネルのいずれでも可能です。

Description 表示のみ。インターフェイスに設定される説明。デフォルトはブランクです。

Port Status 表示のみ。ポートのステータス。有効な値は、次のとおりです。

 • Admin down

 • Up

 • Down

表 2-9 Device ビュー：VLAN：標準 VLAN の VLAN ポート：Trunk Ports セクション 

フィールド 説明

Interface Name 表示のみ。トランク インターフェイスの名前。物理ポートまたはポート チャネルのいずれで  
も可能です。

Description 表示のみ。インターフェイスに設定される説明。デフォルトはブランクです。

Port Status 表示のみ。ポートのステータス。有効な値は、次のとおりです。

 • Admin down

 • Up

 • Down
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Device ビュー：VLAN：プライマリ VLAN のプライマリ VLAN ポート：Promiscuous 
Ports セクション

Device ビュー：VLAN：セカンダリ VLAN の Secondary VLAN Ports タブ：PVLAN 
Host Ports セクション

表 2-10 Device ビュー：VLAN：プライマリ VLAN の VLAN ポート：Promiscuous Ports セクション 

フィールド 説明

Interface Name 表示のみ。インターフェイスの名前。このインターフェイスは、物理ポートまたはポート チャ 
ネルのいずれでも可能です。

Description 表示のみ。インターフェイスに設定される説明。デフォルトはブランクです。

Secondary VLANs プライマリ VLAN の無差別ポートに関連付けられたセカンダリ VLAN
Port Status 表示のみ。ポートのステータス。有効な値は、次のとおりです。

 • Admin down

 • Up

 • Down

表 2-11 Device ビュー：VLAN：セカンダリ VLAN の VLAN ポート：PVLAN Host Ports セクション 

フィールド 説明

Interface Name 表示のみ。インターフェイスの名前。このインターフェイスは、物理ポートまたはポート チャ 
ネルのいずれでも可能です。

Description 表示のみ。インターフェイスに設定される説明。デフォルトはブランクです。

Port Status ポートが関連付けられているセカンダリ VLAN。

表示のみ。ポートのステータス。有効な値は、次のとおりです。

 • Admin down

 • Up

 • Down
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Network ビュー：デバイス：VLAN の詳細：VLAN Settings セクション

表 2-12 Network ビュー：デバイス：VLAN の詳細：VLAN 設定：標準 VLAN 

フィールド 説明

VLAN ID 表示のみ。VLAN ID です。デフォルトでは、VLAN の後ろに VLAN の番号が付きます
（VLANXXXX）。

Device 表示のみ。この VLAN のデバイスの ホスト名または IP アドレスです。
VLAN Name VLAN の名前。最大文字列数は XXX です。デフォルト名は、VLAN の後ろに VLAN の数値が      

付きます（VLANXXXX）。
VLAN Type 標準 VLAN として設定される VLAN のタイプ。有効な値は、次のとおりです。

 • Normal

 • Primary 

 • Community

 • Isolated

Media このフィールドはサポートされていません。

Admin State 管理ステート。有効な値は、次のとおりです。

 • Active

 • Suspended

デフォルトは Active です。
Admin Status 管理ステータス。有効な値は、次のとおりです。

 • Enabled

 • Disabled

デフォルトは Enabled です。

VLAN ネットワーク インターフェイス設定
Description VLAN ネットワーク インターフェイスの説明。任意の印刷可能な文字列です。
IP Address VLAN ネットワーク インターフェイスの IP アドレス。ドット付き 10 進表記の有効な IP アド        

レスです（A:B:C:D）。
Netmask VLAN ネットワーク インターフェイスのネットワーク マスク（ドット付き 10 進表記）。
Admin State VLAN ネットワーク インターフェイスの管理ステート。有効な値は、次のとおりです。

 • Down

 • Up

デフォルトは Up です。
Oper Status 表示のみ。VLAN ネットワーク インターフェイスの動作ステータス。
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Network ビュー：デバイス：VLAN の詳細：Advanced Settings セクション

Network ビュー：デバイス：VLAN ポート：Access Ports セクション

Network ビュー：デバイス：VLAN ポート：Trunk Ports セクション

表 2-13 Network ビュー：デバイス：VLAN の詳細：Advanced Settings セクション 

フィールド 説明

SPAN 設定
RSPAN VLAN リモート SPAN（RSPAN）VLAN の有無についてのステータス

SPAN の始点の設定
Session ID 表示のみ。インターフェイス結合時の SPAN セッション ID
Type 表示のみ。セッションのタイプ

Direction:Ingress 入力パケットのモニタ

Direction:Egress 出力パケットのモニタ

セキュリティ設定

DAI 表示のみ。Dynamic ARP Inspection（DAI; ダイナミック ARP インスペクション）がイネーブル     
かディセーブルかについてのステータス

DHCP Snooping 表示のみ。DHCP スヌーピングがイネーブルかディセーブルかについてのステータス
VACL VLAN で入力トラフィックをフィルタする VLAN アクセス マップ

表 2-14 Network ビュー：デバイス：標準 VLAN の VLAN ポート：Access Ports セクション 

フィールド 説明

Interface Name 表示のみ。アクセス インターフェイスの名前。このインターフェイスは、物理ポートまたは 
ポート チャネルのいずれでも可能です。

Description 表示のみ。インターフェイスに設定される説明。デフォルトはブランクです。

Port Status 表示のみ。ポートのステータス。有効な値は、次のとおりです。

 • Admin down

 • Up

 • Down

表 2-15 Network ビュー：VLAN：標準 VLAN の VLAN ポート：Trunk Ports セクション 

フィールド 説明

Interface Name 表示のみ。トランク インターフェイスの名前。このインターフェイスは、物理ポートまたは 
ポート チャネルのいずれでも可能です。

Description 表示のみ。インターフェイスに設定される説明。デフォルトはブランクです。

Port Status 表示のみ。ポートのステータス。有効な値は、次のとおりです。

 • Admin down

 • Up

 • Down
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Network ビュー：デバイス：プライマリ VLAN ポート：Promiscuous Ports セクション

Network ビュー：デバイス：セカンダリ VLAN ポート：PVLAN Host Ports セクション

表 2-16 Network ビュー：デバイス：プライマリ VLAN ポート：Promiscuous Ports セクション 

フィールド 説明

Interface Name 表示のみ。インターフェイスの名前。このインターフェイスは、物理ポートまたはポート チャ 
ネルのいずれでも可能です。

Description 表示のみ。インターフェイスに設定される説明。デフォルトはブランクです。

Secondary VLANs プライマリ VLAN の無差別ポートに関連付けられたセカンダリ VLAN
Port Status 表示のみ。ポートのステータス。有効な値は、次のとおりです。

 • Admin down

 • Up

 • Down

表 2-17 Network ビュー：デバイス：セカンダリ VLAN ポート：PVLAN Host Ports セクション 

フィールド 説明

Interface Name 表示のみ。インターフェイスの名前。このインターフェイスは、物理ポートまたはポート チャ 
ネルのいずれでも可能です。

Description 表示のみ。インターフェイスに設定される説明。デフォルトはブランクです。

Port Status ポートが関連付けられているセカンダリ VLAN。

表示のみ。ポートのステータス。有効な値は、次のとおりです。

 • Admin down

 • Up

 • Down
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追加情報
VLAN の実装に関する追加情報は、次のセクションを参照してください。

 • 関連資料（p.2-21）

 • 標準規格（p.2-21）

 • MIB（p.2-21）

関連資料

標準規格

MIB

関連トピック マニュアル名

プライベート VLAN 第 3 章「プライベート VLAN の設定」
Rapid PVST+ 第 4 章「Rapid PVST+ の設定」
MST 第 5 章「MST の設定」

STP 拡張機能 第 6 章「STP 拡張機能の設定」

NX-OS レイヤ 2 スイッチングの設定 『Cisco NX-OS Layer 2 Switching Configuration Guide』

インターフェイス、VLAN ネットワーク インター
フェイス、IP アドレス指定、ポート チャネル

『Cisco DCNM Interfaces Configuration Guide』

DCNM fundamentals 『Cisco DCNM Security Configuration Guide』

マルチキャスト ルーティング 『Cisco NX-OS Multicast Routing Configuration Guide』

ハイ アベイラビリティ 『Cisco NX-OS High Availability and Redundancy Guide』

システム管理 『Cisco NX-OS System Management Configuration Guide』
VDC 『Cisco DCNM Virtual Device Context Configuration Guide』

ライセンス 『Cisco DCNM Licensing Guide』

リリース ノート 『Cisco DCNM Release Notes, Release 4.0』

標準規格 タイトル

この機能でサポートされる新規または改訂された標準規格はありません。

また、この機能による既存の標準規格サポートの変更はありません。

—

MIB MIB リンク

 • CISCO-VLAN-MEMBERSHIP-MIB： 
vmMembershipTable-MIB 
vmMembershipSummaryTable-MIB

次の URL から、MIB の検索およびダウンロードができます。

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml
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3
プライベート VLAN の設定

Data Center Network Manager（DCNM）機能の詳細については、『Cisco DCNM Fundamentals 
Configuration Guide』を参照してください。

この章では、プライベート VLAN を設定する手順について説明します。プライベート VLAN は、レ    
イヤ 2 レベルでさらなる保護機能を提供します。

この章の内容は、次のとおりです。

 • プライベート VLAN について（p.3-2）

 • プライベート VLAN のライセンス要件（p.3-8）

 • プライベート VLAN の前提条件（p.3-8）

 • 注意事項および制約事項（p.3-9）

 • プライベート VLAN の設定（p.3-12）

 • プライベート VLAN の統計情報の表示（p.3-19）

 • フィールドの説明（p.3-19）

 • 追加情報（p.3-20）

（注） VLAN ネットワーク インターフェイスの IP アドレス指定の詳細については、『Cisco DCNM 
Interfaces Configuration Guide』を参照してください。
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プライベート VLAN について

（注） レイヤ 2 ポートは、トランク ポート、アクセス ポート、またはプライベート VLAN ポートとして
機能します。

（注） この機能を設定する前に、プライベート VLAN 機能をイネーブルにする必要があります。

同様のシステム間で直接通信する必要がない特定の状況では、プライベート VLAN により、レイヤ  
2 レベルの保護を強化できます。プライベート VLAN は、プライマリ VLAN とセカンダリ VLAN      
のアソシエーションです。

プライマリ VLAN は、セカンダリ VLAN を関連付けるブロードキャスト ドメインを定義します。     
セカンダリ VLAN は、独立 VLAN またはコミュニティ VLAN のどちらかです（独立 VLAN および        
コミュニティ VLAN の詳細は、「セカンダリ VLAN およびプライマリ VLAN の設定」[p.3-9] を参照       
してください）。独立 VLAN 上のホストは、プライマリ VLAN 内で関連付けられた無差別ポートと    
のみ通信します。コミュニティ VLAN 上のホストは、同じコミュニティ VLAN 上のホスト間およ    
び関連付けられた無差別ポートとのみ通信し、独立ポートまたは他のコミュニティ VLAN 内のポー  
トとは通信しません（プライベート VLAN のポート タイプの詳細は、「プライベート VLAN ポート     
の設定」[p.3-10] を参照してください）。

統合スイッチングおよびルーティング機能を使用するコンフィギュレーションでは、各プライベー

ト VLAN に単一のレイヤ 3 VLAN ネットワーク インターフェイスを割り当てることにより、ルー      
ティングを提供できます。VLAN ネットワーク インターフェイスは、プライマリ VLAN 用に作成    
します。このようなコンフィギュレーションでは、セカンダリ VLAN はすべて、プライマリ VLAN   
上の VLAN ネットワーク インターフェイスとのマッピングにより、レイヤ 3 でのみ通信します。セ     
カンダリ VLAN 上の VLAN ネットワーク インターフェイスは、すべてサービス停止状態になりま     
す。

ここでは、次の内容について説明します。

 • プライベート VLAN の概要（p.3-3）

 • ハイ アベイラビリティ（p.3-8）

 • バーチャライゼーションのサポート（p.3-8）
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プライベート VLAN の概要
デバイスでプライベート VLAN 機能を適用するには、プライベート VLAN をイネーブルにする必    
要があります。

ここでは、次の内容について説明します。

 • プライベート VLAN のプライマリ VLAN とセカンダリ VLAN（p.3-3）

 • プライベート VLAN ポート（p.3-4）

 • プライマリ、独立、およびコミュニティ プライベート VLAN（p.3-4）

 • プライマリ VLAN とセカンダリ VLAN の関連付け（p.3-6）

 • プライベート VLAN 内のブロードキャスト トラフィック（p.3-6）

 • プライベート VLAN ポートの分離（p.3-7）

 • プライベート VLAN および VLAN インターフェイス（p.3-7）

 • 複数のデバイスにまたがるプライベート VLAN（p.3-7）

プライベート VLAN のプライマリ VLAN とセカンダリ VLAN

プライベート VLAN 機能では、VLAN の使用時にユーザが直面する 2 つの問題に対処できます。

 • 各 Virtual Device Context（VDC）は、最大 4096 の VLAN をサポートします。各カスタマーに 1        
つの VLAN を割り当てると、サービス プロバイダーがサポートできるカスタマー数は制限さ   
れます。

 • IP ルーティングをイネーブルにするには、各 VLAN にサブネット アドレス空間またはアドレ    
ス ブロックを割り当てます。これにより未使用の IP アドレスが無駄になり、IP アドレスの管    
理に問題が生じます。

プライベート VLAN を使用することにより、スケーラビリティの問題が解決され、IP アドレスの   
管理が容易になり、カスタマーにレイヤ 2 セキュリティが提供されます。

プライベート VLAN の機能は、VLAN のレイヤ 2 ブロードキャスト ドメインをサブドメインに分      
割できます。サブドメインは、1 つの プライベート VLAN ペアで、プライマリ VLAN とセカンダ      
リ VLAN で構成されます。プライベート VLAN ドメインには、各サブドメインに 1 ペアずつ、複      
数のプライベート VLAN ペアを設定できます。プライベート VLAN ドメイン内のすべての VLAN     
ペアは、同じプライマリ VLAN を共有します。各サブドメインは、セカンダリ VLAN ID で識別し     
ます。

（注） プライベート VLAN ドメインに設定できるプライマリ VLAN は 1 つだけです。

セカンダリ VLAN は、同じ VLAN 内のポートをレイヤ 2 で分離します。プライマリ VLAN 内のセ        
カンダリ VLAN には、次の 2 つのタイプがあります。

 • 独立 VLAN ― 独立 VLAN 内のポートは、レイヤ 2 レベルでは相互に通信できません。

 • コミュニティ VLAN ― コミュニティ VLAN 内のポートは相互に通信できますが、レイヤ 2 レ       
ベルの他のコミュニティ VLAN 内または独立 VLAN 内のポートとは通信できません。
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プライベート VLAN ポート

（注） コミュニティ プライベート VLAN および独立プライベート VLAN のポートは、いずれも PVLAN 
ホスト ポートというラベルが付けられます。PVLAN ホスト ポートは、関連付けられているセカ
ンダリ VLAN のタイプによって、コミュニティ PVLAN ポートまたは独立 PVLAN ポートのどちら
かになります。

プライベート VLAN ポートには、次のタイプがあります。

 • 無差別 ― 無差別ポートは、プライマリ VLAN に属します。無差別ポートは、コミュニティ ホ     
スト ポートおよび独立ホスト ポートを含め、セカンダリ VLAN に属していて、無差別ポート    
とプライマリ VLAN に関連付けられているすべてのインターフェイスと通信できます。プライ  
マリ VLAN には、複数の無差別ポートを設定できます。各無差別ポートには、複数のセカンダ  
リ VLAN を関連付けることができますが、セカンダリ VLAN を関連付けなくてもかまいませ    
ん。無差別ポートとセカンダリ VLAN が同じプライマリ VLAN 内にあれば、1 つのセカンダリ     
VLAN を複数の無差別ポートに関連付けることができます。このアソシエーション（関連付け） 
は、ロード バランシングまたは冗長性のために使用することもできます。セカンダリ VLAN に   
無差別ポートを関連付けないこともできますが、その場合、セカンダリ VLAN はレイヤ 3 イン    
ターフェイスと通信できません。

 • 独立 ― 独立ポートは、独立セカンダリ VLAN に属するホスト ポートです。このポートは、同     
じプライベート VLAN ドメイン内の他のポートからレイヤ 2 で完全に分離されていますが、関    
連付けられた無差別ポートとは通信できます。プライベート VLAN は、無差別ポートからのト  
ラフィックを除き、独立ポート宛のトラフィックをすべてブロックします。独立ポートから受

信したトラフィックは、無差別ポートにのみ転送されます。特定の独立 VLAN に複数の独立  
ポートを設定し、その独立 VLAN 内で各ポートを他のすべてのポートから完全に分離できま  
す。

 • コミュニティ ― コミュニティ ポートは、コミュニティ セカンダリ VLAN に属するホスト ポー       
トです。コミュニティ ポートは、同じコミュニティ VLAN 内の他のポートおよび関連付けら   
れた無差別ポートと通信します。これらのインターフェイスは、他のコミュニティにある他の

すべてのインターフェイスおよびプライベート VLAN ドメイン内のすべての独立ポートから、  
レイヤ 2 で分離されています。

（注） トランクは、無差別、独立、およびコミュニティの各ポート間のトラフィックを伝送する VLAN を  
サポートできるので、独立ポートとコミュニティ ポートのトラフィックはトランク インターフェ  
イスを経由してデバイスと送受信されることがあります。

プライマリ、独立、およびコミュニティ プライベート VLAN

プライマリ VLAN にはレイヤ 3 ゲートウェイがあるので、プライベート VLAN の外部と通信する      
には、セカンダリ VLAN をプライマリ VLAN に関連付けます。プライマリ VLAN および 2 種類の        
セカンダリ VLAN（独立 VLAN およびコミュニティ VLAN）には、次の特性があります。

 • プライマリ VLAN ― プライマリ VLAN は、無差別ポートから（独立およびコミュニティ）ホ
スト ポートおよび他の無差別ポートへのトラフィックを伝送します。

 • 独立 VLAN ― 独立 VLAN は、ホストから無差別ポートおよびレイヤ 3 ゲートウェイへの単方       
向アップストリーム トラフィックを伝送するセカンダリ VLAN です。プライベート VLAN ド     
メインに複数の独立 VLAN を設定し、各 VLAN 内のトラフィックを分離できます。また、各    
独立 VLAN に複数の独立ポートを設定し、各独立ポートからのトラフィックを完全に分離する  
こともできます。
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 • コミュニティ VLAN ― コミュニティ VLAN は、アップストリーム トラフィックをコミュニ      
ティ ポートから無差別ポート ゲートウェイおよび同じコミュニティ内の他のホスト ポートに   
伝送するセカンダリ VLAN です。1 つのプライベート VLAN ドメイン内に複数のコミュニティ     
VLAN を設定できます。これらのポートは、同じコミュニティ内のポートとは相互に通信でき 
ますが、プライベート VLAN 内の他のコミュニティ VLAN 内または独立 VLAN 内のポートと      
は通信できません。

図 3-1 に、プライマリまたはプライベート VLAN 内のレイヤ 2 トラフィック フロー、および VLAN       
のタイプとポートのタイプを示します。

図 3-1 プライベート VLAN のレイヤ 2 トラフィック フロー

（注） プライベート VLAN のトラフィック フローは、ホスト ポートから無差別ポートへの単方向です。
無差別ポートから出力されるトラフィックは、標準 VLAN 内のトラフィックと同様に処理され、
関連付けられたセカンダリ VLAN でトラフィックが分離されることはありません。

無差別ポートは 1 つのプライマリ VLAN の専用ポートになりますが、複数の独立 VLAN および複      
数のコミュニティ VLAN で使用できます（レイヤ 3 ゲートウェイは通常、無差別ポート経由でデバ    
イスに接続されます）。無差別ポートを使用すると、さまざまなデバイスをアクセス ポイントとし 
てプライベート VLAN に接続できます。たとえば、無差別ポートを使用して、管理ワークステー  
ションからすべてのプライベート VLAN サーバをモニタ、またはバックアップできます。

プライマリ VLAN には複数の無差別ポートを設定できますが、各プライマリ VLAN に設定できる    
レイヤ 3 ゲートウェイは 1 つだけです。

スイッチング環境では、個々の端末または共通グループの端末に、個別のプライベート VLAN およ  
び関連する IP サブネットを割り当てることができます。端末は、プライベート VLAN の外側と通    
信する場合、デフォルト ゲートウェイのみと通信する必要があります。

 VLAN
 A VLAN
 B VLAN

 VLAN

 A
 

 B
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27

73



第 3章      プライベート VLAN の設定        
プライベート VLAN について

3-6
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0

OL-15867-01-J

（注） レイヤ 3 ゲートウェイを設定するには、VLAN ネットワーク インターフェイス機能をイネーブル    
にしておく必要があります。VLAN ネットワーク インターフェイスと IP アドレス指定の詳細につ    
いては、『Cisco DCNM Interfaces Configuration Guide』を参照してください。

プライマリ VLAN とセカンダリ VLAN の関連付け

セカンダリ VLAN 内のホスト ポートでプライベート VLAN 外と通信するには、セカンダリ VLAN      
をプライマリ VLAN に関連付ける必要があります。アソシエーションが正常に動作していない場  
合、セカンダリ VLAN のホスト ポート（独立ポートおよびコミュニティ ポート）はダウン ステー     
トになります。

（注） セカンダリ VLAN は、1 つのプライマリ VLAN にのみ関連付けることができます。

アソシエーションを正常に動作させるには、次の条件が満たされている必要があります。

 • プライマリ VLAN が存在する。

 • セカンダリ VLAN が存在する。

 • プライマリ VLAN がプライマリ VLAN として設定されている。

 • セカンダリ VLAN が、独立 VLAN またはコミュニティ VLAN として設定されている。

プライマリ VLAN またはセカンダリ VLAN のどちらかを削除すると、その VLAN に関連付けられ      
ているポートは非アクティブになります。特定の VLAN をプライベート VLAN モードに再変換す    
ると、元のアソシエーションが復元されます。

セカンダリ VLAN とプライマリ VLAN 間のアソシエーションを変更するには、最初に現在のアソ    
シエーションを削除してから、新しいアソシエーションを追加します。

プライベート VLAN 内のブロードキャスト トラフィック

プライベート VLAN 内のポートからのブロードキャスト トラフィックは、次のように伝送されま   
す。

 • 無差別ポートからのブロードキャスト トラフィックは、プライマリ VLAN 内のすべてのポー   
トに伝送されます。このブロードキャスト トラフィックは、プライベート VLAN パラメータ   
が設定されていないポートも含め、プライマリ VLAN 内のすべてのポートに配信されます。

 • 独立ポートからのブロードキャスト トラフィックは、その独立ポートが関連付けられているプ 
ライマリ VLAN 内の無差別ポートだけに配信されます。

 • コミュニティ ポートからのブロードキャスト トラフィックは、そのポートのコミュニティ内の  
すべてのポート、およびそのコミュニティ ポートに関連付けられているすべての無差別ポート 
に配信されます。このブロードキャスト パケットは、プライマリ VLAN 内の他のコミュニティ   
または独立ポートには配信されません。
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プライベート VLAN ポートの分離

プライベート VLAN を使用して、端末へのアクセスを次のように制御できます。

 • 端末に接続している特定のインターフェイスを独立ポートとして設定すると、レイヤ 2 での通  
信が阻止されます。たとえば、端末がサーバである場合、この設定により、サーバ間のレイヤ

2 通信が阻止されます。

 • デフォルト ゲートウェイおよび特定の端末（バックアップ サーバなど）に接続しているイン
ターフェイスを無差別ポートとして設定すると、すべての端末からデフォルト ゲートウェイ
へのアクセスが許可されます。

プライベート VLAN および VLAN インターフェイス

レイヤ 2 VLAN への VLAN インターフェイスは、Switched Virtual Interface（SVI; スイッチ仮想イン        
ターフェイス）とも呼ばれます。レイヤ 3 デバイスは、セカンダリ VLAN ではなく、プライマリ    
VLAN を介してのみプライベート VLAN と通信します。

VLAN ネットワーク インターフェイスは、プライマリ VLAN に対してのみ設定します。セカンダ    
リ VLAN には VLAN インターフェイスを設定しないでください。VLAN がセカンダリ VLAN とし       
て設定されている場合、セカンダリ VLAN の VLAN ネットワーク インターフェイスは非アクティ     
ブになります。VLAN インターフェイスの設定が正しくない場合、次のような状況になります。

 • アクティブな VLAN ネットワーク インターフェイスが設定された VLAN をセカンダリ VLAN      
として設定しようとすると、VLAN インターフェイスをディセーブルにするまでは、設定が許 
可されません。

 • セカンダリ VLAN として設定されている VLAN 上で VLAN ネットワーク インターフェイスを       
作成してイネーブルにしようとすると、その VLAN インターフェイスはディセーブルのまま  
で、システムからエラーが返されます。

プライマリ VLAN がセカンダリ VLAN に関連付けられ、マッピングされている場合、プライマリ    
VLAN 上のすべての設定がセカンダリ VLAN に伝播されます。たとえば、プライマリ VLAN 上の     
VLAN ネットワーク インターフェイスに IP サブネットを割り当てると、このサブネットはプライ    
ベート VLAN 全体の IP サブネット アドレスになります。

（注） VLAN インターフェイスを設定するには、VLAN インターフェイス機能をイネーブルにしておく必  
要があります。VLAN インターフェイスおよび IP アドレス指定の詳細については、『Cisco DCNM    
Interfaces Configuration Guide』を参照してください。

複数のデバイスにまたがるプライベート VLAN

プライベート VLAN を複数の装置にわたるように拡張するには、プライマリ VLAN、独立 VLAN、    
およびコミュニティ VLAN を、プライベート VLAN をサポートする他の装置にトランキングしま    
す。プライベート VLAN 設定のセキュリティを保持して、プライベート VLAN として設定された    
VLAN が他の目的に使用されないようにするには、プライベート VLAN ポートが設定されていない   
デバイスを含め、すべての中間デバイスにプライベート VLAN を設定します。
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ハイ アベイラビリティ
このソフトウェアは、コールド リブート時に、プライベート VLAN のステートフルおよびステー   
トレスの両方の再起動において、ハイ アベイラビリティをサポートしています。ステートフルな再 
起動では、再試行は最大 3 回までサポートされます。再起動から 10 秒以内に 4 回以上の再試行を      
行うと、スーパーバイザ モジュールがリロードされます。

プライベート VLAN ごとに、ソフトウェアのアップグレードまたはダウングレードをシームレスに  
実行できます。

（注） ハイ アベイラビリティ機能の詳細については、『Cisco NX-OS High Availability and Redundancy 
Configuration Guide』を参照してください。

バーチャライゼーションのサポート

ソフトウェアは、Virtual Device Context（VDC）をサポートしています。

（注） VDC およびリソース割り当ての詳細については、『Cisco DCNM Virtual Device Context Configuration      
Guide』を参照してください。

各 VLAN は、プライマリ VLAN およびすべてのセカンダリ VLAN のプライベート VLAN ポート
が、すべて同じ VDC に属している必要があります。プライベート VLAN は、複数の VDC に対し
ては設定できません。

プライベート VLAN のライセンス要件
次の表に、この機能に関するライセンス要件を示します。

ただし、VDC を使用するには、Advanced Services ライセンスが必要です。

プライベート VLAN の前提条件
プライベート VLAN 設定時の前提条件は、次のとおりです。

 • デバイスにログオンしている必要があります。

 • 必要に応じて、Advanced Services ライセンスをインストールし、特定の VDC を開始します。

 • プライベート VLAN 機能をイネーブルにする必要があります。

製品 ライセンス要件

DCNM プライベート VLAN のライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco    
DCNM にバンドルされ、無料で提供されます。DCNM ライセンス機構の詳細については、『Cisco DCNM   
Licensing Guide』を参照してください。

NX-OS プライベート VLAN のライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco    
NX-OS システム イメージにバンドルされ、無料で提供されます。NX-OS ライセンス機構の詳細について   
は、『Cisco NX-OS Licensing Guide』を参照してください。
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注意事項および制約事項
プライベート VLAN 設定時の注意事項の内容は、次のとおりです。

 • セカンダリ VLAN およびプライマリ VLAN の設定（p.3-9）

 • プライベート VLAN ポートの設定（p.3-10）

 • 他の機能に関連する制限（p.3-10）

セカンダリ VLAN およびプライマリ VLAN の設定
プライベート VLAN の設定時は、次の注意事項に従ってください。

 • デフォルト VLAN（VLAN1）または内部的に割り当てられた VLAN を、プライマリ VLAN ま     
たはセカンダリ VLAN として設定することはできません。

 • 1 つのプライマリ VLAN に、複数の独立 VLAN およびコミュニティ VLAN を関連付けること       
ができます。独立 VLAN またはコミュニティ VLAN は、1 つのプライマリ VLAN だけに関連       
付けることができます。

 • プライベート VLAN により、ホストはレイヤ 2 で分離されますが、レイヤ 3 で相互に通信でき      
ます。

 • セカンダリ VLAN がプライマリ VLAN に関連付けられている場合、プライマリ VLAN の Spanning- 
Tree Protocol（STP; スパニングツリー プロトコル）パラメータ（ブリッジ プライオリティな    
ど）はセカンダリ VLAN に伝播されます。ただし、他のデバイスに STP パラメータを伝播す   
る必要はありません。プライマリ VLAN、独立 VLAN、およびコミュニティ VLAN のスパニン    
グ ツリー トポロジが正確に一致し、これらの VLAN が同じ転送データベースを適切に共有で    
きるかどうかを確認するには、STP 設定を手動でチェックする必要があります。

 • 標準トランク ポートの場合、次の事項に注意してください。

－ プライベート VLAN 内の各 VLAN に、個別の STP インスタンスが存在します。

－ プライマリ VLAN およびすべてのセカンダリ VLAN の STP パラメータが一致している必      
要があります。

－ プライマリ VLAN および関連付けられたすべてのセカンダリ VLAN が、同じ Multiple 
Spanning Tree（MST）インスタンス内に存在している必要があります。

 • 非トランク ポートの場合、次の事項に注意してください。

－ STP が認識するのは、プライベート VLAN ホスト ポートのプライマリ VLAN だけです。
STP は、ホスト ポート上のセカンダリ VLAN では実行されません。

（注） ホスト ポートとして設定するすべてのポート上で BPDU ガードをイネーブルにすることを推奨し
ます。この機能は、無差別ポート上ではイネーブルにしないでください。BPDU ガードの設定情
報については、第 6 章「STP 拡張機能の設定」を参照してください。

 • プライマリ VLAN、独立 VLAN、およびコミュニティ VLAN には、別々の QoS（Quality Of 
Service）を適用できます 

 • すべてのプライベート VLAN トラフィックに VACL を適用するには、プライマリ VLAN の 
VLAN ネットワーク インターフェイスにセカンダリ VLAN をマッピングしてから、プライマ
リ VLAN の VLAN ネットワーク インターフェイス上に VACL を設定します。

 • プライマリ VLAN の VLAN ネットワーク インターフェイスに適用した VACL は、マッピング       
が設定されている場合にのみ、関連付けられた独立 VLAN およびコミュニティ VLAN に自動    
的に適用されます。
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 • プライマリ VLAN の VLAN ネットワーク インターフェイスにセカンダリ VLAN をマッピング       
せずに、プライマリ VLAN とセカンダリ VLAN に異なる VACL を設定すると、問題が生じる      
ことがあります。

 • プライベート VLAN のトラフィックは、異なる VLAN では異なる方向に伝送されるので、マッ    
ピングを設定する前に、入力トラフィック用と出力トラフィック用にそれぞれ異なる VACL を  
設定できます。

（注） プライベート VLAN 内のプライマリ VLAN とすべてのセカンダリ VLAN では、同じ VACL を保持        
する必要があります。

 • DHCP スヌーピングはプライベート VLAN 上でイネーブルにできます。プライマリ VLAN 上     
で DHCP スヌーピングをイネーブルにすると、DHCP 設定がセカンダリ VLAN に伝播されま     
す。セカンダリ VLAN 上に DHCP を設定しても、プライマリ VLAN 上で DHCP がすでに設定        
されている場合、セカンダリ VLAN 上での設定は有効になりません。

 • VLAN をセカンダリ VLAN として設定する前に、セカンダリ VLAN 用の VLAN ネットワーク       
インターフェイスをシャットダウンする必要があります。

 • 無差別ポートが設定された独立プライベート VLAN 内でのホスト間通信を防ぐには、そのサブ  
ネット内のホストの相互通信を拒否する Role-Based ACL（RBACL; ロールベース ACL）を設定    
します。

プライベート VLAN ポートの設定
プライベート VLAN ポートの設定時は、次の注意事項に従ってください。

 • プライマリ VLAN、独立 VLAN、またはコミュニティ VLAN として設定する VLAN に割り当
てられているレイヤ 2 アクセス ポートは、この VLAN がプライベート VLAN の設定に含まれ
ている場合、非アクティブになります。プライベート VLAN を伝送するレイヤ 2 トランク イ
ンターフェイスはアクティブで、STP データベースの一部として保持されます。

 • ポートチャネル グループに属すポートを、プライベート VLAN ポート として設定しないでく    
ださい。ポートがプライベート VLAN の設定に含まれている場合、そのポートのポート チャ   
ネル設定は非アクティブになります。

 • プライベート VLAN 設定に使用される VLAN を削除すると、その VLAN に関連付けられたプ
ライベート VLAN ポートは非アクティブになります。

他の機能に関連する制限

プライベート VLAN の設定時は、他の機能に関連する設定上の制限を考慮してください。

（注） 状況によっては、エラー メッセージが表示されずに設定が受け入れられますが、コマンドは無効
になります。

 • IGMP は、プライマリ VLAN 上でのみ実行され、すべてのセカンダリ VLAN にプライマリ VLAN      
の設定が使用されます。

 • セカンダリ VLAN 内の IGMP 加入要求は、プライマリ VLAN で受信されたものとして処理さ      
れます。

 • プライベート VLAN は、次の Switched Port Analyzer（SPAN; スイッチド ポート アナライザ）機        
能をサポートします。
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－ プライベート VLAN ポートを SPAN 送信元ポートとして設定できます。

－ プライマリ VLAN、独立 VLAN、およびコミュニティ VLAN 上で VLAN-based SPAN
（VSPAN）を使用したり、単一の VLAN 上で SPAN を使用したりして、出力トラフィック
または入力トラフィックを個別にモニタすることができます。

 • プライベート VLAN ホストまたは無差別ポートは、SPAN 宛先ポートにはできません。

 • 宛先 SPAN ポートを、独立ポートにすることはできません（ただし、送信元 SPAN ポートは独    
立ポートにできます）。

 • SPAN は、プライマリ VLAN およびセカンダリ VLAN の両方に対して設定できます。また、出     
力トラフィックまたは入力トラフィックのうち、どちらか一方だけに対して設定することもで

きます。

 • プライマリ VLAN とセカンダリ VLAN 間のアソシエーションを設定すると、セカンダリ VLAN     
を学習したダイナミック MAC アドレスがすぐに消去されます。

 • プライマリ VLAN とセカンダリ VLAN 間のアソシエーションを設定すると、セカンダリ VLAN     
上で作成されたすべてのスタティック MAC アドレスが、プライマリ VLAN に挿入されます。    
アソシエーションを削除すると、スタティック MAC アドレスはセカンダリ VLAN だけの設定    
に戻ります。

 • プライマリ VLAN とセカンダリ VLAN 間のアソシエーションの設定後に、セカンダリ VLAN     
用のスタティック MAC アドレスを作成することはできません。

 • プライマリ VLAN とセカンダリ VLAN 間のアソシエーションの設定後、このアソシエーショ    
ンを削除すると、プライマリ VLAN 上に作成されたすべてのスタティック MAC アドレスは、    
プライマリ VLAN 上でのみ存続します。

 • プライベート VLAN では、ポート セキュリティ機能はサポートされません。

（注） スタティック MAC アドレスの設定の詳細については、『Cisco DCNM Security Configuration Guide』
を参照してください。
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プライベート VLAN の設定
ここでは、次の内容について説明します。

 • プライベート VLAN の設定時の注意事項（p.3-12）

 • プライベート VLAN のイネーブル化（p.3-13）

 • プライベート VLAN としての VLAN の設定（p.3-14）

 • プライマリ プライベート VLAN へのセカンダリ VLAN の関連付け（p.3-15）

 • プライマリ VLAN の VLAN インターフェイスへのセカンダリ VLAN のマッピング（p.3-16）

 • プライベート VLAN ホスト ポートとプライベート VLAN 無差別ポートの設定（p.3-18）

（注） VLAN ネットワーク インターフェイスへの IP アドレス指定の詳細については、『Cisco DCNM 
Interfaces Configuration Guide』を参照してください。

プライベート VLAN の設定時の注意事項
 • デバイスにプライベート VLAN 機能を適用するには、プライベート VLAN をイネーブルにし    
ておく必要があります。VLAN インターフェイス機能をイネーブルにしてから、この機能をデ 
バイスに適用してください。

 • セカンダリ VLAN を設定する前に、セカンダリ VLAN として設定するすべての VLAN の VLAN       
ネットワーク インターフェイスをシャットダウンします。

 • プライベート VLAN 機能の設定を開始する前に、「注意事項および制約事項」（p.3-9）を参照し  
てください。



第 3章      プライベート VLAN の設定
プライベート VLAN の設定  

3-13
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0        

OL-15867-01-J

プライベート VLAN のイネーブル化
プライベート VLAN 機能を使用するには、デバイス上でプライベート VLAN をイネーブルにする    
必要があります。

VLAN ペインを使用してデバイス上でプライベート VLAN をイネーブルにします（図 3-2 を参照）。

図 3-2 プライベート VLAN の設定

手順の詳細

デバイス上でプライベート VLAN 機能をイネーブルにするには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching  > VLAN  を選択して VLAN ペインを開きます。

ステップ 2 Summary ペインで Device View タブをクリックします。

ステップ 3 Summary ペインで、VLAN を作成するデバイスをクリックします。

ステップ 4 デバイス上で右クリックし、ドロップダウン リストから Enable Private VLAN Conditional Services      
を選択します。

ステップ 5 （任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。
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プライベート VLAN としての VLAN の設定

（注） VLAN をセカンダリ VLAN（コミュニティ VLAN または独立 VLAN のどちらか）として設定する      
前に、その VLAN のネットワーク インターフェイスをシャットダウンする必要があります。

VLAN は、プライベート VLAN として設定できます。

プライベート VLAN 内で、プライマリ VLAN、コミュニティ VLAN、または独立 VLAN として使      
用するすべての VLAN を作成します。そのあとで、複数の独立 VLAN および複数のコミュニティ    
VLAN を 1 つのプライマリ VLAN に関連付けます。複数のプライマリ VLAN とアソシエーション       
を設定できます。つまり、複数のプライベート VLAN を設定できます。

プライマリ VLAN またはセカンダリ VLAN のどちらかを削除すると、その VLAN に関連付けられ      
ているポートは非アクティブになります。

（注） プライベート VLAN がイネーブルであることを確認してください。

VLAN ペインを使用してプライベート VLAN を作成し、関連付けます（図 3-2 を参照）。

手順の詳細

プライベート VLAN を作成するには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching  > VLAN  を選択して VLAN ペインを開きます。

ステップ 2 Summary ペインで Device View タブをクリックします。

ステップ 3 Summary ペインで、VLAN を作成するデバイスをクリックします。

ステップ 4 メニューで New をクリックします。

ステップ 5 ドロップダウン リストから、Primary VLAN、 Community VLAN、 または  Isolated VLAN  を選択し          
ます。

ステップ 6 VLAN ID カラムで、追加する VLAN の ID を入力します。

VLAN は、デフォルト設定の状態ですぐに作成されます。

ステップ 7 （任意）VLAN の名前を変更するには、Name カラムをクリックし、設定する名前を入力します。

ステップ 8 （任意）特定の VLAN を削除するには、メニュー バーから VLAN > Delete を選択します。

これらの VLAN を削除してよいかどうかの確認メッセージが表示されます。Yes をクリックする   
と、これらの VLAN はデバイスからすぐに削除されます。

ステップ 9 （任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。
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プライマリ プライベート VLAN へのセカンダリ VLAN の関連付け
プライマリ VLAN またはセカンダリ VLAN のどちらかを削除すると、その VLAN に関連付けられ      
ているポートは非アクティブになります。

特定の VLAN をプライベート VLAN モードに再変換すると、元のアソシエーションが復元されま
す。

セカンダリ VLAN をプライマリ VLAN に関連付けます。コミュニティ VLAN および独立 VLAN は、        
セカンダリ VLAN です。各セカンダリ VLAN は、プライマリ VLAN に関連付ける必要があります。      
複数のプライマリ VLAN とアソシエーションを設定できます。つまり、複数のプライベート VLAN   
を設定できます。

プライマリ VLAN またはセカンダリ VLAN のどちらかを削除すると、その VLAN に関連付けられ      
ているポートは非アクティブになります。既存のアソシエーションを変更するには、まず現在のア

ソシエーションを削除してから新しいアソシエーションを設定します。

VLAN ペインを使用してプライベート VLAN を関連付けます（図 3-3 を参照）。

図 3-3 セカンダリ VLAN とプライベート VLAN の関連付け
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手順の詳細

（注） セカンダリ VLAN を作成してから、セカンダリ VLAN とプライマリ VLAN を関連付けます。

セカンダリ VLAN とプライマリ VLAN を関連付けるには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching  > VLAN  を選択して VLAN ペインを開きます。

ステップ 2 Summary ペインで Device View タブをクリックします。

ステップ 3 Summary ペインで、VLAN を関連付けるデバイスをクリックします。

ステップ 4 Summary ペインで、プライマリ VLAN をクリックします。

Details ペインにタブが表示されます。

ステップ 5 VLAN Details  タブをクリックします。

ステップ 6 VLAN Settings セクションをクリックします。

ステップ 7 Secondary VLANs  エリアで右クリックし、このプライマリ VLAN と関連付けるセカンダリ VLAN 
を入力します。

Secondary VLANs エリアに、関連付けられた各セカンダリ VLAN の VLAN タイプおよび VLAN ID        
が表示されます。

ステップ 8 （任意）プライマリ VLAN にセカンダリ VLAN を追加で関連付けるには、ステップ 4 ～ 7 を繰り返        
します。

ステップ 9 （任意）プライマリ VLAN からセカンダリ VLAN を削除するには、Secondary VLANs  エリアをク       
リックし、プライマリ VLAN との関連付けを削除したい VLAN を選択します。マウスを右クリッ    
クリし、Delete Secondary VLAN. をクリックします。

ステップ 10（任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。

プライマリ VLAN の VLAN インターフェイスへのセカンダリ VLAN のマッピング
セカンダリ VLAN を、プライマリ VLAN の VLAN インターフェイスにマッピングします。独立      
VLAN およびコミュニティ VLAN は、ともにセカンダリ VLAN と呼ばれます。プライマリ VLAN      
の入力トラフィックをレイヤ 3 で処理するには、セカンダリ VLAN をプライマリ VLAN の VLAN       
ネットワーク インターフェイスにマッピングします。
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（注） VLAN ネットワーク インターフェイスを設定する前に、VLAN インターフェイスをイネーブルに   
する必要があります。プライマリ VLAN に関連付けられたコミュニティ VLAN または独立 VLAN     
上の VLAN ネットワーク インターフェイスは、アウト オブ サービスになります。稼働するのは、     
プライマリ VLAN 上の VLAN ネットワーク インターフェイスだけです。

VLAN ペインで、プライマリ VLAN の VLAN ネットワーク インターフェイスを追加し、VLAN ネッ       
トワーク インターフェイスをセカンダリ VLAN に関連付けます（図 3-3 を参照）。

手順の詳細

（注） VLAN をセカンダリ VLAN（コミュニティ VLAN または独立 VLAN のどちらか）として設定する      
前に、その VLAN のネットワーク インターフェイスをシャットダウンする必要があります。

プライマリ VLAN の VLAN ネットワーク インターフェイスを設定し、セカンダリ VLAN に関連付       
けるには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching  >VLAN  を選択して VLAN ペインを開きます。

ステップ 2 Summary ペインで Device View タブをクリックします。

ステップ 3 Summary ペインで、プライマリ VLAN をクリックします。

ステップ 4 メニュー バーから VLAN > Add VLAN Network Interface を選択します。

VLAN Details タブの VLAN Settings セクションにウィンドウが表示されます。ここで、VLAN ネッ      
トワーク インターフェイスを設定できます。

ステップ 5 Description フィールドに、VLAN ネットワーク インターフェイスの説明を入力します。

ステップ 6 IP Address フィールドに、VLAN ネットワーク インターフェイスの IP アドレスを入力します。

ステップ 7 Netmask フィールドに、VLAN ネットワーク インターフェイスのネットマスクを入力します。

ステップ 8 Admin State フィールドで、ドロップダウン リストから Up または Down を選択します。

ステップ 9 （任意）VLAN Network Interface エリアで、Secondary VLANs フィールドのドロップダウン リストを      
クリックし、プライマリ VLAN の VLAN ネットワーク インターフェイスに追加で関連付けるセカ     
ンダリ VLAN を選択します。

ステップ 10（任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。
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プライベート VLAN ホスト ポートとプライベート VLAN 無差別ポートの設定
プライベート VLAN ホスト ポートとプライベート VLAN 無差別ポートを設定できます。プライ     
ベート VLAN では、ホスト ポートはセカンダリ VLAN（コミュニティ VLAN または独立 VLANの       
どちらか）に含まれます。レイヤ 2 インターフェイスをプライベート VLAN の無差別ポートとして    
設定し、その無差別ポートをプライマリ VLAN およびセカンダリ VLAN に関連付けることができ    
ます。

（注） ホスト ポートとして設定したすべてのインターフェイス上で BPDU ガードをイネーブルにするこ
とを推奨します。

Ethernet ペインを使用してプライベート VLAN ポートを設定します（図 3-4 を参照）。

図 3-4 プライベート VLAN ホストの設定

手順の詳細

ホストおよび無差別のプライベート VLAN ポートを作成するには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Interfaces > Physical > Ethernet  を選択して Ethernet ペインを開きます。

ステップ 2 Contents ペインの Summary ペインから、デバイスをダブルクリックし、インターフェイスを表示し   
ます。

ステップ 3 スロットをダブルクリックし、インターフェイスを一覧表示します。
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ステップ 4 インターフェイスをクリックします。

Summary ペインで選択したインターフェイスが強調表示され、Details ペインにタブが表示されま  
す。

ステップ 5 Details ペインで Port Details  タブをクリックします。

ステップ 6 Port Mode Settings セクションをクリックします。

ステップ 7 ドロップダウン リストから、PVLAN Host  または  PVLAN Promiscuous  を選択し、アクセス ポー          
トとしてポートを設定します。

ステップ 8 セカンダリ VLAN ドロップダウン リストをクリックし、このインターフェイス用に設定したいセ   
カンダリ VLAN を選択します。

Secondary VLAN ウィンドウに、設定されたセカンダリ VLAN と、各セカンダリ VLAN が関連付け      
られているプライマリ VLAN が表示されます。セカンダリ VLAN を選択すると、Primary VLAN     
フィールドが自動的に生成されます。

ステップ 9 （任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。

プライベート VLAN の統計情報の表示
次のウィンドウが Statistics タブに表示されます。

 • VLAN Traffic Statistics ― レイヤ 2 のユニキャスト、マルチキャスト、ブロードキャストトラ      
フィック、およびレイヤ 3 のユニキャスト、マルチキャスト トラフィックなどの プライベー    
ト VLAN トラフィックについての情報が表示されます。

フィールドの説明
プライベート VLAN ポートの設定に使用するフィールドの詳細については、『Cisco DCNM Interfaces    
Configuration Guide』を参照してください。

プライベート VLAN の設定に使用するフィールドの詳細については、第 2 章「VLAN の設定」を参     
照してください。
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追加情報
プライベート VLAN の実装に関する追加情報は、次のセクションを参照してください。

 • 関連資料（p.3-20）

 • 標準規格（p.3-20）

 • MIB（p.3-20）

関連資料

標準規格

MIB

関連トピック マニュアル名

すべての VLAN 第 2 章「VLAN の設定」

STP 拡張機能 第 6 章「STP 拡張機能の設定」

NX-OS レイヤ 2 スイッチングの設定 『Cisco NX-OS Layer 2 Switching Configuration Guide』

VLAN インターフェイス、IP アドレス指定 『Cisco DCNM Interfaces Configuration Guide』

スタティック MAC アドレス、セキュリティ 『Cisco DCNM Security Configuration Guide』
DCNM fundamentals 『Cisco DCNM Security Configuration Guide』

ハイ アベイラビリティ 『Cisco NX-OS High Availability and Redundancy Guide』

システム管理 『Cisco NX-OS System Management Configuration Guide』
VDC 『Cisco DCNM Virtual Device Context Configuration Guide』

ライセンス 『Cisco DCNM Licensing Guide』

リリース ノート 『Cisco DCNM Release Notes, Release 4.0』

標準規格 タイトル

この機能でサポートされる新規または改訂された標準規格はありません。

また、この機能による既存の標準規格サポートの変更はありません。

—

MIB MIB リンク

 • CISCO-PRIVATE-VLAN-MIB 次の URL から、MIB の検索およびダウンロードができます。

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml


C H A P T E R

4-1
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0        

OL-15867-01-J

4
Rapid PVST+ の設定

この章では、NX-OS デバイスに Rapid per VLAN Spanning Tree（Rapid PVST+）プロトコルを設定す       
る方法について説明します。

Data Center Network Manager の機能の詳細については、『Cisco DCNM Fundamentals Configuration       
Guide』を参照してください。

この章で説明する内容は、次のとおりです。

 • Rapid PVST+ について（p.4-2）

 • Rapid PVST+ のライセンス要件（p.4-20）

 • Rapid PVST+ を設定するための前提条件（p.4-20）

 • 注意事項および制約事項（p.4-21）

 • Rapid PVST+ の設定（p.4-22）

 • 統計情報の表示（p.4-35）

 • Rapid PVST+ のフィールドの説明（p.4-35）

 • 追加情報（p.4-38）

（注） Multiple Spanning Tree（MST）の詳細については、第 5 章「MST の設定」、STP 拡張の詳細につい      
ては、第 6 章「STP 拡張機能の設定」を参照してください。
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Rapid PVST+ について

（注） Spanning Tree Protocol（STP; スパニング ツリー プロトコル）パラメータの設定に DCNM を使用す       
る前に、使用しているデバイスのコマンドラインに NX-OS グローバル コマンドを入力してログレ   
ベルを設定する必要があります。 
--logging-level spanning-tree 6 
--logging logfile messages 6 
--logging event link-status default 
ログレベルについては、『Cisco NX-OS System Management Configuration Guide』を参照してください。

（注） レイヤ 2 インターフェイスの作成方法については、『Cisco DCNM Interfaces Configuration Guide』を      
参照してください。

Spanning Tree Protocol（STP; スパニング ツリー プロトコル）は、ネットワークのレイヤ 2 でループ       
のないネットワークを実現するために実装されました。Rapid PVST+ は、VLAN（仮想 LAN）ごと   
にスパニング ツリー トポロジを 1 つ作成することができる、STP の更新版です。デバイスのデフォ     
ルト STP モードは Rapid PVST+ です。

（注） スパニング ツリーは、IEEE 802.1w および IEEE 802.1s を表す場合に使用されます。このマニュア      
ルで IEEE 802.1D STP に関して説明する場合は、具体的に 802.1D と表記されます。

ここでは、VLAN 単位で実装される IEEE 802.1w 標準（Rapid Spanning Tree Protocol [RSTP; 高速ス         
パニング ツリー プロトコル ]）である Rapid PVST+ プロトコルについて説明します。Rapid PVST+      
は、個別の VLAN でなく、すべての VLAN に対応する単一の STP インスタンスが規定された IEEE       
802.1Q VLAN 標準と相互運用されます（「Rapid PVST+ および IEEE 802.1Q トランク」[p.4-18] を参        
照）。

デバイスのデフォルト VLAN（VLAN1）および新規作成されたすべての VLAN では、Rapid PVST+    
がデフォルトでイネーブルです。Rapid PVST+ はレガシー IEEE 802.1D STP が稼働するデバイスと      
相互運用されます（「Rapid PVST+ とレガシー 802.1D STP の相互運用性」[p.4-18] を参照）。

RSTP は元の STP 標準である 802.1D の改良版であり、高速コンバージェンスを実現します。

ここでは、Rapid PVST+ の概要を示します。内容は次のとおりです。

 • STP（p.4-3）

 • Rapid PVST+（p.4-8）

 • Rapid PVST+ および IEEE 802.1Q トランク（p.4-18）

 • Rapid PVST+ とレガシー 802.1D STP の相互運用性（p.4-18）

 • Rapid PVST+ と 802.1s MST の相互運用性（p.4-18）

 • ハイ アベイラビリティ（p.4-19）

 • バーチャライゼーションのサポート（p.4-19）
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（注） デバイスは、Rapid PVST+ に対して中断のない完全アップグレードをサポートしています。中断の  
ないアップグレードの詳細については、『Cisco NX-OS High Availability and Redundancy Guide』を参      
照してください。

STP

STP は、ネットワークのループを排除しながらパスの冗長性を提供する、レイヤ 2 リンク管理プロ   
トコルです。

ここでは、STP の基本情報を示します。内容は次のとおりです。

 • 概要（p.4-3）

 • トポロジの作成方法（p.4-4）

 • ブリッジ ID（p.4-4）

 • BPDU（p.4-6）

 • ルート ブリッジの選定（p.4-7）

 • スパニング ツリー トポロジの作成（p.4-7）

概要

レイヤ 2 イーサネット ネットワークが正常に動作するには、2 つの端末間で存在できるアクティブ    
パスは 1 つだけです。STP の動作は透過的なので、端末が単一の LAN セグメントに接続されてい     
るのか、それとも複数セグメントからなるスイッチド LAN に接続されているのかを、端末が検知  
することはできません。

フォールトトレラントなインターネットワークを作成する場合、ネットワーク上のすべてのノード

間にループフリー パスを形成する必要があります。STP アルゴリズムは、スイッチド レイヤ 2 ネッ     
トワーク上で最良のループフリー パスを算出します。レイヤ 2 LAN ポートは、Bridge Protocol Data      
Unit（BPDU; ブリッジ プロトコル データ ユニット）と呼ばれる STP フレームを定期的に送受信し      
ます。ネットワーク装置はこれらのフレームを転送しないで、フレームを使用してループフリー パ 
スを構築します。

端末間に複数のアクティブ パスがあると、ネットワーク内でループが発生する原因になります。 
ネットワークにループが存在する場合、端末が重複したメッセージを受信したり、ネットワーク装

置が複数のレイヤ 2 LAN ポート上の端末 MAC（メディア アクセス制御）アドレスを学習したりす     
る可能性があります。

STP は、ルート ブリッジおよびそのルートからレイヤ 2 ネットワーク上のすべてのネットワーク装    
置へのループフリー パスを備えたツリーを定義します。STP は冗長データ パスを強制的にブロッ   
ク ステートにします。スパニング ツリーの 1 つのネットワーク セグメントで障害が発生し、冗長     
パスが存在する場合、STP アルゴリズムはスパニング ツリー トポロジを再計算し、ブロック パス    
をアクティブにします。

ネットワーク装置上の 2 つのレイヤ 2 LAN ポートがループの一部になっている場合、デバイス上の     
どちらのポートがフォワーディング ステートになり、どちらのポートがブロッキング ステートに  
なるかは、STP ポート プライオリティおよびポート パス コストの設定によって決まります。STP    
のポート プライオリティ値は、その場所でポートがトラフィックを送受信する場合の効率を示しま 
す。STP ポート パス コスト値は、メディア速度から算出されます。
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トポロジの作成方法

スパニング ツリーに参加している LAN 内のすべてのデバイスは、BPDU を交換して、ネットワー    
ク内の他のスイッチに関する情報を収集します。この BPDU 交換により、次の作業が行われます。

 • スパニング ツリー ネットワーク トポロジに対して一意のルート スイッチが選定されます。

 • LAN セグメントごとに代表スイッチが 1 つ選定されます。

 • 冗長スイッチ ポートをバックアップ ステートにすることにより、スイッチド ネットワーク上   
のループが排除されます。スイッチド ネットワーク内のどの場所からも、ルート デバイスに  
到達するために必要でないパスは、すべて STP ブロック ステートになります。

アクティブなスイッチド ネットワークのトポロジは、次の要素によって決まります。

 • 各デバイスに対応付けられた一意のデバイス ID（デバイスの MAC アドレス）

 • 各スイッチ ポートに対応付けられたルートへのパス コスト

 • 各スイッチ ポートに対応付けられたポート ID

スイッチド ネットワークでは、論理上、ルート スイッチがスパニング ツリー トポロジの中心です。    
STP は BPDU を使用して、スイッチド ネットワークのルート スイッチおよびルート ポートを選定      
します。

ブリッジ ID

各ネットワーク装置上の各 VLAN には、一意の 64 ビットブリッジ ID が設定されています。ブリッ      
ジ ID はブリッジ プライオリティ値、拡張システム ID（IEEE 802.1t）、および STP MAC アドレス割        
り当てで構成されています。

ここでは、次の内容について説明します。

 • ブリッジ プライオリティ値（p.4-4）

 • 拡張システム ID（p.4-5）

 • STP MAC アドレスの割り当て（p.4-5）

ブリッジ プライオリティ値

拡張システム ID がイネーブルの場合、ブリッジ プライオリティは 4 ビット値です。

「VLAN の Rapid PVST+ hello タイムの設定」（p.4-32）を参照してください。デバイス ブリッジ ID       
（ルート ブリッジの ID を判別するためにスパニング ツリー アルゴリズムで使用され、最小値が優     
先される）に指定できるのは、4096 の倍数のみです。

（注） このデバイスでは、拡張システム ID は常にイネーブルです。拡張システム ID をディセーブルにす    
ることはできません。



第 4章      Rapid PVST+ の設定
Rapid PVST+ について  

4-5
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0        

OL-15867-01-J

拡張システム ID

12 ビットの拡張システム ID フィールドは、ブリッジ ID の一部です（図 4-1 を参照）。

図 4-1 拡張システム ID を含むブリッジ ID

デバイスでは常に 12 ビット拡張システム ID が使用されます。

ブリッジ ID と統合することで、拡張システム ID は VLAN の一意の ID として機能します（表 4-1        
を参照）。

STP MAC アドレスの割り当て

（注） デバイスでは常に MAC アドレス リダクションがイネーブルです。

デバイスでは常に MAC アドレス リダクションがイネーブルであるため、不要なルート ブリッジの    
選定を防止して、スパニング ツリー トポロジの問題を防ぐには、その他のすべてのレイヤ 2 接続    
ネットワーク装置でも MAC アドレス リダクションをイネーブルにする必要があります。

MAC アドレス リダクションをイネーブルにすると、ルート ブリッジ プライオリティは、4096 の     
倍数に VLAN ID を加えた値となります。デバイス ブリッジ ID（ルート ブリッジの ID を判別する        
ためにスパニング ツリー アルゴリズムで使用され、最小値が優先される）に指定できるのは、4096  
の倍数のみです。指定できる値は、次のとおりです。

 • 0

 • 4096

 • 8192

 • 12288

 • 16384

 • 20480

 • 24576

 • 28672

 • 32768

 • 36864

 

4 

 ID 
12 

 ID 

MAC 
6 

18
44

44

表 4-1 拡張システム ID がイネーブルの場合のブリッジ プライオリティ値および拡張システム ID

ブリッジ プライオリティ値 拡張システム ID（VLAN ID と同設定）

ビット
16

ビット
15

ビット
14

ビット
13

ビット
12

ビット
11

ビット
10

ビット
9

ビット
8

ビット
7

ビット
6

ビット
5

ビット
4

ビット
3

ビット
2

ビット
1

32768 16384 8192 4096 2048 1024 512 256 128 64 32 16 8 4 2 1
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 • 40960

 • 45056

 • 49152

 • 53248

 • 57344

 • 61440

STP は拡張システム ID と MAC アドレスを使用して、VLAN ごとに一意のブリッジ ID を作成しま        
す。

（注） 同じスパニング ツリー ドメイン内の別のブリッジで MAC アドレス リダクション機能が稼働して     
いない場合、ブリッジ ID により細かい値を選択できるため、そのブリッジがルート ブリッジの所   
有権を取得する可能性があります。

BPDU

ネットワーク装置は STP インスタンス全体に BPDU を送信します。各ネットワーク装置はコンフィ    
ギュレーション BPDU を送信して、スパニング ツリー トポロジを伝達および計算します。各コン    
フィギュレーション BPDU に含まれる最小限の情報は、次のとおりです。

 • 送信側ネットワーク装置がルート ブリッジとみなしているネットワーク装置の固有のブリッ 
ジ ID

 • ルートまでの STP パス コスト

 • 送信側ブリッジのブリッジ ID

 • メッセージ エージ

 • 送信側ポートの識別子

 • hello タイマー、転送遅延タイマー、および max-age プロトコル タイマーの値

 • STP 拡張プロトコルの追加情報

ネットワーク装置が Rapid PVST+ BPDU フレームを伝送すると、そのフレームが伝送される VLAN     
に接続されたすべてのネットワーク装置が BPDU を受信します。ネットワーク装置が BPDU を受信    
しても、フレームは転送されません。代わりに、フレームに含まれる情報を使用して BPDU が計算  
されます。トポロジが変更されると、ネットワーク装置は BPDU 交換を開始します。

BPDU 交換によって次の処理が行われます。

 • 1 台のネットワーク装置がルート ブリッジとして選定されます。

 • パス コストに基づいて、各ネットワーク装置のルート ブリッジまでの最短距離が計算されます。

 • LAN セグメントごとに代表ブリッジが選択されます。このネットワーク装置はルート ブリッジ  
に最も近いネットワーク装置であり、このネットワーク装置を経由してルートにフレームが転

送されます。

 • ルート ポートが選定されます。このポートにより、ブリッジからルート ブリッジまでの最適
パスが提供されます。

 • スパニング ツリーに含まれるポートが選択されます。

Rapid PVST+ によって BPDU に追加されるフィールドの詳細については、「Rapid PVST+ BPDU」      
（p.4-9）を参照してください。
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ルート ブリッジの選定

VLAN ごとに、最高のブリッジ ID（数値的に最小の ID 値）を持つネットワーク装置がルート ブ     
リッジとして選定されます。すべてのネットワーク装置がデフォルト プライオリティ（32768）に 
設定されている場合は、VLAN 内で最小の MAC アドレスを持つネットワーク装置がルート ブリッ    
ジになります。ブリッジ プライオリティ値はブリッジ ID の最上位ビットを占めます。

ブリッジ プライオリティ値を変更すると、デバイスがルート ブリッジとして選定される確率が変  
わります。小さな値を設定するとその確率が高くなり、大きな値を設定すると低くなります。

STP ルート ブリッジは、レイヤ 2 ネットワークにおける各スパニング ツリー トポロジの論理上の      
中心です。レイヤ 2 ネットワーク内のどの場所からも、ルート ブリッジに到達するために必要とさ   
れないパスは、すべて STP ブロッキング モードになります。

BPDU には、送信側ブリッジおよびそのポートについて、ブリッジおよび MAC アドレス、ブリッ   
ジ プライオリティ、ポート プライオリティ、パス コストなどの情報が含まれます。STP はこの情    
報を使用して STP インスタンスのルート ブリッジを選定し、ルート ブリッジへのルート ポートを     
選定し、各レイヤ 2 セグメントの Designated Port（DP; 指定ポート）を判別します。

スパニング ツリー トポロジの作成

図 4-2 では、スイッチ A がルート ブリッジに選定されます。これは、すべてのネットワーク装置で    
ブリッジ プライオリティがデフォルト（32768）に設定されており、スイッチ A の MAC アドレス     
が最小であるためです。ただし、トラフィック パターン、転送ポートの数、またはリンク タイプ  
によっては、スイッチ A が最適なルート ブリッジであるとはかぎりません。最適なネットワーク   
装置がルート ブリッジになるように、装置のプライオリティを上げる（数値を下げる）ことで、 
ルートとして最適なネットワーク装置を使用する、新しい STP トポロジを強制的に再計算させるこ  
とができます。

図 4-2 スパニング ツリー トポロジ

スパニング ツリー トポロジをデフォルトのパラメータに基づいて計算すると、スイッチド ネット   
ワーク上の送信元から宛先端末までのパスが最適にならない可能性があります。たとえば、現在の

ルート ポートよりも数値の大きいポートに高速リンクを接続すると、ルート ポートが変更される  
場合があります。最高速のリンクをルート ポートにすることが重要です。

たとえば、スイッチ B の 1 つのポートが光ファイバ リンクであり、同じスイッチの別のポート     
（Unshielded Twisted-Pair [UTP; シールドなしツイストペア ] リンク）がルート ポートになっている     
と仮定します。ネットワーク トラフィックを高速の光ファイバ リンクに流した方が効率的です。光  
ファイバ ポートの STP ポート プライオリティをルート ポートよりも上げると（数値を下げる）、光     
ファイバ ポートが新しいルート ポートになります。

18
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Rapid PVST+

ここでは、次の内容について説明します。

 • 概要（p.4-8）

 • Rapid PVST+ BPDU（p.4-9）

 • 提案合意ハンドシェイク（p.4-10）

 • プロトコル タイマー（p.4-11）

 • ポート ロール（p.4-12）

 • ポート ステート（p.4-13）

 • ポート ロールの同期化（p.4-15）

 • 単一方向リンク障害の検出（p.4-16）

 • ポート コスト（p.4-17）

 • ポート プライオリティ（p.4-17）

概要

Rapid PVST+ は VLAN 単位で実装される IEEE 802.1w（RSTP）標準です。（STP を手動でディセー       
ブルにしないかぎり）設定されている VLAN ごとに 1 つの STP インスタンスが動作します。VLAN      
上の各 Rapid PVST+ インスタンスには、それぞれ 1 つのルート スイッチがあります。Rapid PVST+       
が稼働している場合、STP は、VLAN 単位でイネーブルまたはディセーブルにできます。

（注） デバイスのデフォルト STP モードは Rapid PVST+ です。

Rapid PVST+ は、ポイントツーポイント配線を利用してスパニング ツリーの高速コンバージェンス   
を実現します。Rapid PVST+ を使用した場合、スパニング ツリーの再設定は 1 秒以内に実行できま     
す（802.1D STP のデフォルト設定の場合は 50 秒かかります）。PVID は自動的にチェックされます。

（注） Rapid PVST+ は VLAN ごとに STP インスタンスを 1 つサポートします。

Rapid PVST+ を使用すると、STP コンバージェンス時間が短縮されます。デフォルトでは、STP 内    
の各指定ポートは 2 秒おきに BPDU を送信します。トポロジ内の指定ポートで、hello メッセージ     
が 3 回連続して受信されない場合、または最大エージング タイムが満了した場合、ポートはテーブ   
ル内のすべてのプロトコル情報をただちにフラッシュします。ポートで BPDU が受信されなかった  
回数が 3 に達するか、または最大エージング タイムが満了した場合、ポートは直接接続されたネイ   
バーの指定ポートとの接続が切断されているとみなします。このように、プロトコル情報を短時間

で期限切れにすることによって、障害を短時間で検出できます。

Rapid PVST+ には、デバイス、デバイス ポート、または LAN に障害が発生したあとに、短時間で     
接続を回復する機能があります。エッジ ポート、新規ルート ポート、およびポイントツーポイン  
ト リンクで接続されたポートに対して、次のような高速コンバージェンス機能を提供します。

 • エッジ ポート ― RSTP デバイス上のポートをエッジ ポートに設定すると、そのエッジ ポート      
は即座にフォワーディング ステートになります（この短時間での移行は、従来は、PortFast と  
いうシスコ独自の機能で実現されていました）。単一の端末に接続されるポートのみをエッジ

ポートとして設定してください。リンクが変更されても、エッジ ポートによるトポロジ変更は 
発生しません。
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（注） レイヤ 2 ホストに接続されたすべてのポートをエッジ ポートとして設定することを推奨します。
STP ポート タイプの詳細については、第 6 章「STP 拡張機能の設定」を参照してください。

 • ルート ポート ― Rapid PVST+ が新規ルート ポートを選択した場合、古いルート ポートをブ
ロックして、即座に新規ルート ポートをフォワーディング ステートに移行します。

 • ポイントツーポイント リンク ― ポイントツーポイント リンクを介してポートを別のポートに    
接続してローカル ポートが指定ポートになる場合、ループのないトポロジを実現するために、 
提案合意ハンドシェイクを使用して相手側ポートと高速移行をネゴシエーションします。

Rapid PVST+ がフォワーディング ステートへの高速移行を実現できるのは、エッジ ポートおよび    
ポイントツーポイント リンク上のみです。リンク タイプを設定できますが、リンク タイプ情報は   
ポートのデュプレックス設定から自動的に取得されます。全二重ポートはポイントツーポイント

ポートであるとみなされ、半二重ポートは共有ポートであるとみなされます。

エッジ ポートでトポロジ変更は発生しませんが、その他のすべての指定ポートおよびルート ポー  
トでは、直接接続されたネイバーからの BPDU 受信に 3 回連続で失敗するか、または最大エージン    
グ タイムが満了した場合、TC（トポロジ変更）BPDU が生成されます。この時点で、指定ポート  
またはルート ポートは TC フラグが設定された BPDU を送信します。該当するポートで TC 時間タ       
イマーが稼働しているかぎり、BPDU に TC フラグは設定されたままです。TC 時間タイマーの値    
は、hello タイムの設定値に 1 秒を加えた値です。トポロジ変更が最初に検出された場所から、即座   
にこの情報がトポロジ全体にフラッディングされます。

Rapid PVST+ がトポロジ変更を検出すると、以下の処理が実行されます。

 • 必要に応じて、すべての非エッジ ルート ポートおよび指定ポートに対して、hello タイムの 2    
倍の値に設定された TC 時間タイマーを開始します。

 • これらのすべてのポートに関連付けられた MAC アドレスをフラッシュします。

トポロジ変更通知はトポロジ全体に短時間でフラッディングされます。トポロジ変更が受信される

と、ダイナミック エントリはポート単位ですぐに消去されます。

（注） TCA フラグが使用されるのは、そのデバイスが、レガシー 802.1D STP が稼働しているデバイスと    
相互作用している場合のみです。Rapid PVST+ と 802.1D STP の相互作用の詳細については、「Rapid     
PVST+ とレガシー 802.1D STP の相互運用性」（p.4-18）を参照してください。

トポロジ変更後、提案合意シーケンスがネットワーク エッジ方向に迅速に伝播され、接続が迅速に 
復元されます（「ポート ロールの同期化」[p.4-15] を参照）。

Rapid PVST+ BPDU

Rapid PVST+ および 802.1w では、次の情報を追加するために、フラグ バイトの 6 ビットをすべて       
使用しています。

 • BPDU の送信元ポートのロールおよびステート

 • 提案合意ハンドシェイク

図 4-3 に、Rapid PVST+ での BPDU フラグの使用方法を示します。
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図 4-3 BPDU 内の Rapid PVST+ フラグ バイト

もう 1 つの重要な変更点は、Rapid PVST+ BPDU がタイプ 2、バージョン 2 であるため、デバイス        
が接続先のレガシー（802.1D）ブリッジを検出できることです。802.1D の BPDU はタイプ 0、バー    
ジョン 0 です。

提案合意ハンドシェイク

スイッチ A はポイントツーポイント リンクを介してスイッチ B に接続されており、すべてのポー     
トがブロッキング ステートになります（図 4-4 を参照）。スイッチ A のプライオリティがスイッチ    
B のプライオリティよりも数値的に小さいと仮定します。

図 4-4 高速コンバージェンスの提案合意ハンドシェイク
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デバイス A は提案メッセージ（提案フラグが設定されたコンフィギュレーション BPDU）をデバイ   
ス B に送信して、自身を代表デバイスにするように提案します（図 4-4 を参照）。

デバイス B が提案メッセージを受信すると、提案メッセージを受信したポートを新しいルート ポー   
トとして選択し、すべての非エッジ ポートを強制的にブロッキング ステートにします。さらに、そ  
の新しいルート ポート経由で合意メッセージ（合意フラグが設定された BPDU）を送信します。

デバイス A は、スイッチ B から合意メッセージを受信すると、ただちに自身の指定ポートをフォ    
ワーディング ステートにします。デバイス B はすべての非エッジ ポートをブロックしており、さ    
らにスイッチ A と B はポイントツーポイント リンクで接続されているため、ネットワークにルー     
プは形成されません（ポート ステートの詳細については、「ポート ステート」[p.4-13] を参照）。

デバイス C がデバイス B に接続された場合も、同様の一連のハンドシェイク メッセージが交換さ     
れます。デバイス C はデバイス B に接続されたポートをルート ポートとして選択し、リンクの両     
端はすぐにフォワーディング ステートに移行します。このハンドシェイク プロセスを繰り返すた  
びに、もう 1 つのデバイスがアクティブ トポロジに追加されます。ネットワークが収束すると、こ   
の提案合意ハンドシェイクはルートからスパニング ツリーのリーフに進みます。

スイッチはポートのデュプレックス モードからリンク タイプを学習します。全二重ポートはポイ  
ントツーポイント接続とみなされ、半二重ポートは共有接続とみなされます。spanning-tree
link-type インターフェイス コンフィギュレーション コマンドを入力すると、デュプレックス設定   
で制御されたデフォルト設定を上書きすることができます。

この提案合意ハンドシェイクが開始されるのは、非エッジ ポートがブロッキング ステートから  
フォワーディング ステートに移行した場合のみです。ハンドシェイク プロセスは、トポロジ全体  
に段階的に拡散します。

プロトコル タイマー

表 4-2 に、Rapid PVST+ のパフォーマンスに影響するプロトコル タイマーを示します。

表 4-2 Rapid PVST+ プロトコル タイマー

変数 説明

hello タイマー ネットワーク装置間で BPDU をブロードキャストする頻度を決定します。デ  
フォルトは 2 秒で、指定できる範囲は 1 ～ 10 です。

転送遅延タイマー ポートが転送を開始するまでの、リスニング ステートおよびラーニング ス  
テートが継続する時間を決定します。このタイマーは通常、プロトコルで使

用されません。ただし、802.1D スパニング ツリーと相互運用する場合は、使  
用されます。デフォルトは 15 秒で、指定できる範囲は 4 ～ 30 秒です。

最大エージング 
タイマー

ポートで受信したプロトコル情報がネットワーク装置によって保管される時

間を決定します。このタイマーは通常、プロトコルで使用されません。ただ

し、802.1D スパニング ツリーと相互運用する場合は、使用されます。デフォ  
ルトは 20 秒で、指定できる範囲は 6 ～ 40 秒です。
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ポート ロール

Rapid PVST+ では、ポート ロールを割り当ててアクティブ トポロジを学習することで、スパニン    
グ ツリーの高速コンバージェンスを実現します。「ルート ブリッジの選定」（p.4-7）で説明してい  
るように、Rapid PVST+ は、802.1D STP を利用して、最も高いスイッチ プライオリティ（最小プラ     
イオリティ値）を持つデバイスをルート ブリッジとして選択します。Rapid PVST+ は、次に示す   
ポート ロールの 1 つを各ポートに割り当てます。

 • ルート ポート ― デバイスがルート ブリッジにパケットを転送する際に最適なパス（最小コス    
ト）を提供します。

 • 指定ポート ― LAN からルート ブリッジにパケットを転送する際に最小パス コストになる指     
定デバイスに接続します。指定デバイスが LAN に接続されるポートを指定ポートと呼びます。

 • 代替ポート ― 現在のルート ポートが提供するルート ブリッジへの代替パスを提供します。ま    
た、トポロジ内の別のデバイスへのパスを提供します。

 • バックアップ ポート ― 指定ポートが提供する、スパニング ツリーのリーフへのパスのバック    
アップとして機能します。バックアップ ポートは、2 つのポートがループバック内でポイント  
ツーポイント リンクで接続されている場合、または 1 つのデバイスに共有 LAN セグメントへ     
の接続が複数ある場合のみ、使用できます。バックアップ ポートは、トポロジ内のデバイスに 
対する別のパスを提供します。

 • ディセーブル ポート ― スパニング ツリーの処理における役割が指定されていないポートです。

ネットワーク全体で一貫したポート ロールがある安定したトポロジでは、Rapid PVST+ により各   
ルート ポートおよび指定ポートは即座にフォワーディング ステートに移行し、すべての代替ポー  
トおよびバックアップ ポートは常にブロッキング ステートになります。指定ポートは、ブロッキ  
ング ステートから開始します。ポート ステートにより、フォワーディング プロセスおよびラーニ   
ング プロセスの動作が制御されます。

ルート ポートまたは指定ポートのロールが割り当てられたポートは、アクティブ トポロジに含ま  
れます。代替ポートまたはバックアップ ポートのロールが割り当てられたポートは、アクティブ 
トポロジから除外されます（図 4-5 を参照）。

図 4-5 ポート ロールを示すトポロジ例
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ポート ステート

ここでは、Rapid PVST+ および MST のポート ステートについて説明します。内容は次のとおりで     
す。

 • Rapid PVST+ のポート ステートの概要（p.4-13）

 • ブロッキング ステート（p.4-14）

 • ラーニング ステート（p.4-14）

 • フォワーディング ステート（p.4-14）

 • ディセーブル ステート（p.4-14）

 • ポート ステートの概要（p.4-15）

Rapid PVST+ のポート ステートの概要

プロトコル情報がスイッチド LAN を通過するとき、伝播遅延が生じることがあります。その結果、  
スイッチド ネットワークのさまざまな時点および場所でトポロジの変化が発生します。レイヤ 2  
LAN ポートがスパニング ツリー トポロジに含まれていない状態からフォワーディング ステートに    
直接移行すると、一時的にデータ ループが形成される可能性があります。ポートは新しいトポロジ 
情報がスイッチド LAN 経由で伝播されるまで待機し、それからフレーム転送を開始する必要があ  
ります。

Rapid PVST+ または MST を使用する NX-OS  の各レイヤ 2 LAN ポートは、次の 4 つのステートの            
いずれかになります。

 • ブロッキング ― レイヤ 2 LAN ポートがフレーム転送に参加していない状態です。

 • ラーニング ― レイヤ 2 LAN ポートがフレーム転送に参加する準備をしている状態です。

 • フォワーディング ― レイヤ 2 LAN ポートはフレームを転送します。

 • ディセーブル ― レイヤ 2 LAN ポートが STP に参加せず、フレームを転送していない状態です。

Rapid PVST+ をイネーブルにすると、デバイス上のすべてのポート、VLAN、およびネットワーク  
は、電源投入時に必ずブロッキング ステートを経て、それからラーニングという移行ステートに進 
みます。設定が適切であれば、各レイヤ 2 LAN ポートはフォワーディング ステートまたはブロッ    
キング ステートで安定します。

STP アルゴリズムによってレイヤ 2 LAN ポートがフォワーディング ステートになると、次の処理     
が行われます。

1. レイヤ 2 LAN ポートがブロッキング ステートになり、ラーニング ステートに移行するように     
指示するプロトコル情報を待ちます。

2. レイヤ 2 LAN ポートが転送遅延タイマーの満了を待ち、満了した時点でラーニング ステート    
になり、転送遅延タイマーをリセットします。

3. ラーニング ステートで、レイヤ 2 LAN ポートはフレーム転送を引き続きブロックしながら、転    
送データベースの端末のロケーション情報を学習します。

4. レイヤ 2 LAN ポートは、転送遅延タイマーの終了とともにフォワーディング ステートになり、    
学習およびフレーム転送が両方ともイネーブルになります。
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ブロッキング ステート

ブロッキング ステートのレイヤ 2 LAN ポートは、フレーム転送に参加しません。

ブロッキング ステートのレイヤ 2 LAN ポートの動作は、次のとおりです。

 • 接続セグメントから受信したフレームを廃棄します。

 • 転送用に他のポートからスイッチングされたフレームを廃棄します。

 • アドレス データベースに、端末のロケーション情報は組み込みません（ブロッキング状態のレ 
イヤ 2 LAN ポートに関する学習は行われないため、アドレス データベースは更新されません）。

 • BPDU を受信し、それをシステム モジュールに転送します。

 • システム モジュールから送られた BPDU を受信し、処理して送信します。

 • コントロール プレーン メッセージを受信して応答します。

ラーニング ステート

ラーニング ステートのレイヤ 2 LAN ポートは、フレームの MAC アドレスを学習して、フレーム転      
送に参加するための準備を行います。レイヤ 2 LAN ポートは、ブロッキング ステートからラーニ    
ング ステートを開始します。

ラーニング ステートのレイヤ 2 LAN ポートの動作は、次のとおりです。

 • 接続セグメントから受信したフレームを廃棄します。

 • 転送用に他のポートからスイッチングされたフレームを廃棄します。

 • 端末のロケーション情報をアドレス データベースに組み込みます。

 • BPDU を受信し、それをシステム モジュールに転送します。

 • システム モジュールから送られた BPDU を受信し、処理して送信します。

 • コントロール プレーン メッセージを受信して応答します。

フォワーディング ステート

フォワーディング ステートのレイヤ 2 LAN ポートはフレームを転送します。レイヤ 2 LAN ポート       
は、ラーニング ステートからフォワーディング ステートを開始します。

フォワーディング ステートのレイヤ 2 LAN ポートの動作は、次のとおりです。

 • 接続セグメントから受信したフレームを転送します。

 • 転送用に他のポートからスイッチングされたフレームを転送します。

 • 端末のロケーション情報をアドレス データベースに組み込みます。

 • BPDU を受信し、それをシステム モジュールに転送します。

 • システム モジュールから受信した BPDU を処理します。

 • コントロール プレーン メッセージを受信して応答します。

ディセーブル ステート

ディセーブル ステートのレイヤ 2 LAN ポートは、フレーム転送または STP に参加しません。ディ      
セーブル ステートのレイヤ 2 LAN ポートは事実上、動作することはありません。

ディセーブル ステートのレイヤ 2 LAN ポートの動作は、次のとおりです。

 • 接続セグメントから受信したフレームを廃棄します。

 • 転送用に他のポートからスイッチングされたフレームを廃棄します。

 • アドレス データベースに、端末のロケーション情報は組み込みません（学習は行われないた 
め、アドレス データベースは更新されません）。

 • ネイバーから BPDU を受信しません。

 • システム モジュールから送信用の BPDU を受信しません。
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ポート ステートの概要

表 4-3 に、ポートの有効な動作ステートと Rapid PVST+ ステート、およびポートがアクティブ トポ     
ロジに含まれるかどうかを示します。

ポート ロールの同期化

デバイスのポートの 1 つが提案メッセージを受信し、そのポートが新しいルート ポートとして選択   
されると、Rapid PVST+ は他のすべてのポートを新しいルート情報に強制的に同期化させます。

他のポートがすべて同期化されると、デバイスはルート ポートで受信した上位のルート情報と同期 
化されます。次のいずれかの場合は、デバイスの個別のポートが同期されます。

 • ポートがブロッキング ステートの場合

 • エッジ ポート（ネットワークのエッジ上に設定されているポート）の場合

指定ポートがフォワーディング ステートであり、エッジ ポートとして設定されていない場合、Rapid  
PVST+ によって新しいルート情報に強制的に同期化されると、その指定ポートはブロッキング ス  
テートに移行します。一般に、Rapid PVST+ がポートをルート情報に強制的に同期させ、ポートが  
上記のいずれの条件も満たしていない場合、そのポートのステートはブロッキングに設定されます。

デバイスはすべてのポートが同期されたことを確認すると、そのルート ポートに対応する指定デバ 
イスに合意メッセージを送信します。ポイントツーポイント リンクによって接続されたスイッチが 
それぞれのポート ロールについて合意すると、Rapid PVST+ はポートのステートを即座にフォワー   
ディング ステートに移行させます。図 4-6 に、このイベント シーケンスを示します。

図 4-6 高速コンバージェンス時のイベント シーケンス

表 4-3 ポート ステートとアクティブ トポロジ 

動作ステータス ポート ステート アクティブ トポロジ内のポートの有無

イネーブル ブロッキング なし

イネーブル ラーニング あり

イネーブル フォワーディング あり

ディセーブル ディセーブル なし

2. 
9. 

1. 4. 

6. 

 

8. 10. 

 

7. 

5. 

3. 
11. 

18
44

42



第 4章      Rapid PVST+ の設定        
Rapid PVST+ について

4-16
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0

OL-15867-01-J

ここでは、次の内容について説明します。

 • 上位 BPDU 情報の処理（p.4-16）

 • 不良 BPDU 情報の処理（p.4-16）

上位 BPDU 情報の処理

上位 BPDU は、現在ポートに格納されているものよりも上位のルート情報（小さいスイッチ ID、低   
いパス コストなど）を持つ BPDU です。

ポートが上位 BPDU を受信すると、Rapid PVST+ は再構成を開始します。そのポートが新しいルー    
ト ポートとして提案され選択されると、Rapid PVST+ はすべての非エッジ、指定ポートを強制的に   
同期化します。

受信した BPDU が提案フラグの設定された Rapid PVST+ BPDU である場合、デバイスは他のすべて      
のポートを同期化してから合意メッセージを送信します。以前のポートがブロッキング ステートに 
なるとすぐに、新しいルート ポートがフォワーディング ステートに移行します。

ポートで上位の情報が受信されたために、そのポートがバックアップ ポートまたは代替ポートにな 
る場合、Rapid PVST+ によりポートはブロッキング ステートに設定され、合意メッセージが送信さ   
れます。指定ポートは、転送遅延タイマーが満了するまで、提案フラグが設定された BPDU を送信  
し続けます。転送遅延タイマーが満了すると、指定ポートはフォワーディング ステートに移行します。

不良 BPDU 情報の処理

不良 BPDU は、現在ポートに格納されているものよりも下位のルート情報（大きいスイッチ ID、高   
いパス コストなど）を持つ BPDU です。

指定ポートが不良 BPDU を受信すると、その指定ポートは自身の情報を即座に応答します。

単一方向リンク障害の検出

ソフトウェアは、受信した BPDU のポート ロールとステートの一貫性をチェックし、Unidirectional   
Link Detection（UDLD; 単一方向リンク検出）機能を使用して、ブリッジング ループが発生する可   
能性のある単一方向リンク障害を検出します。この機能は、異議メカニズムに基づいています。

UDLD の詳細については、『Cisco DCNM Interface Configuration Guide』を参照してください。

指定ポートが矛盾を検出するとロールは維持されますが、状態は廃棄ステートに戻ります。これは、

接続に矛盾が生じた場合、ブリッジング ループを開始するよりも接続を中断する方が好ましいため 
です。

図 4-7 に、ブリッジング ループの一般的な原因となる単一方向リンク障害を示します。スイッチ A   
はルート ブリッジで、その BPDU はデバイス B へのリンクで損失されます。802.1w 標準の BPDU       
には、送信ポートのロールとステートが含まれます。スイッチ A はこの情報を使用して、スイッチ  
B がスイッチ A の送信した上位 BPDU に反応せず、スイッチ B がルート ポートではなく、指定ポー        
トであることを検出できます。その結果、スイッチ A はスイッチ B のポートをブロックする（ま    
たはブロックし続ける）ので、ブリッジング ループが回避されます。

図 4-7 単一方向リンク障害の検出
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 +  

 BPDU
 A  B

18
44

40



第 4章      Rapid PVST+ の設定
Rapid PVST+ について  

4-17
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0        

OL-15867-01-J

（注） ブリッジ保証機能の詳細については、第 6 章「STP 拡張機能の設定」も参照してください。

ポート コスト

（注） Rapid PVST+ はデフォルトで、ショート（16 ビット）パスコスト方式を使用してコストを計算しま   
す。ショート パスコスト方式の場合は、1 ～ 65535 の任意の値を割り当てることができます。ただ    
し、ロング（32 ビット）パスコスト方式を使用するようにデバイスを設定すると、1 ～ 200,000,000   
の任意の値を割り当てることができます。パスコスト計算方式はグローバルに設定されます。

STP ポート パスコストのデフォルト値は、LAN インターフェイスのメディア速度およびパスコス   
ト計算方式から決定されます（表 4-4 を参照）。ループが発生すると、STP はポート コストを考慮   
して、フォワーディング ステートにする LAN インターフェイスを選択します。

STP に最初に選択させたい LAN インターフェイスには低いコスト値を、最後に選択させたい LAN    
インターフェイスには高いコスト値を割り当てることができます。すべての LAN インターフェイ  
スが同じコスト値を使用している場合には、STP は LAN インターフェイス番号が最も小さい LAN    
インターフェイスをフォワーディング ステートにして、残りの LAN インターフェイスをブロック   
します。

アクセス ポートでは、ポート単位でポート コストを割り当てます。トランク ポートでは、VLAN   
単位でポート コストを割り当てます。トランク ポートのすべての VLAN に同じポート コストを設     
定できます。

ポート プライオリティ

複数のポートのパス コストが同じである場合に、冗長パスが発生すると、Rapid PVST+ はポート プ    
ライオリティを考慮して、フォワーディング ステートにする LAN ポートを選択します。Rapid   
PVST+ に最初に選択させたい LAN ポートには低いプライオリティ値を、最後に選択させたい LAN    
ポートには最も高いプライオリティ値を割り当てることができます。

すべての LAN ポートが同じプライオリティ値を使用している場合には、Rapid PVST+ は LAN ポー      
ト番号が最も小さい LAN ポートをフォワーディング ステートにして、残りの LAN ポートをブロッ     
クします。プライオリティの有効範囲は 0 ～ 224 （デフォルトは 128）で、32 単位で設定できます。      
NX-OS  デバイスは LAN ポートがアクセス ポートとして設定されている場合にはポート プライオ      
リティ値を使用し、LAN ポートがトランク ポートとして設定されている場合には VLAN ポート プ     
ライオリティ値を使用します。

表 4-4 デフォルトのポート コスト

帯域幅
ポート コストのショート 
パスコスト方式 ポート コストのロング パスコスト方式

10 Mbps 100 2,000,000

100 Mbps 19 200,000

1 ギガビット イーサネット 4 20,000

10 ギガビット イーサネット 2 2,000
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Rapid PVST+ および IEEE 802.1Q トランク
802.1Q トランクによって、ネットワークの STP の構築方法に、いくつかの制約が課されます。802.1Q   
トランクを使用して接続しているシスコのネットワーク装置では、トランク上で許容される VLAN 
ごとに 1 つの STP インスタンスが維持されます。しかし、他社製の 802.1Q ネットワーク装置では、      
トランク上で許容されるすべての VLAN に対して 1 つの STP インスタンス（Common Spanning Tree        
[CST]）しか維持されません。

802.1Q トランクを使用してシスコのネットワーク装置を他社製のネットワーク装置に接続する場 
合、シスコのネットワーク装置は、トランクの 802.1Q VLAN の STP インスタンスを、他社製の     
802.1Q ネットワーク装置の STP インスタンスと統合します。ただし、シスコのネットワーク装置   
によって維持される VLAN 別の STP 情報はすべて、他社製の 802.1Q ネットワーク装置のクラウド      
によって切り離されます。シスコのネットワーク装置を隔てている他社製の 802.1Q 装置のクラウ  
ドは、ネットワーク装置間の単一トランク リンクとして処理されます。

802.1Q トランクの詳細については、『Cisco NX-OS Interface Configuration Guide』を参照してください。

Rapid PVST+ とレガシー 802.1D STP の相互運用性
Rapid PVST+ は、レガシー 802.1D プロトコルが稼働しているデバイスと相互運用できます。BPDU    
バージョン 0 を受信したデバイスは、802.1D が稼働している装置と相互運用していることを認識し   
ます。Rapid PVST+ の BPDU はバージョン 2 です。受信した BPDU が 802.1w BPDU バージョン 2            
であり、提案フラグが設定されている場合、デバイスはその他のすべてのポートが同期化されたあ

とに、合意メッセージを送信します。BPDU が 802.1D BPDU バージョン 0 の場合、デバイスは提案      
フラグを設定せずにポートの転送遅延タイマーを開始します。新しいルート ポートは、フォワー 
ディング ステートに移行するために 2 倍の転送遅延時間を必要とします。

デバイスは、次のように、レガシー 802.1D デバイスと相互運用します。

 • 通知 ― 802.1D BPDU と異なり、802.1w は TCN BPDU を使用しません。ただし、802.1D スイッ         
チと相互運用性を保つために、NX-OS  デバイスは TCN BPDU の処理と生成を行います。

 • 確認 ― 802.1w デバイスは、指定ポートで 802.1D デバイスから TCN メッセージを受信すると、       
TCA ビットが設定された 802.1D コンフィギュレーション BPDUで応答します。ただし、802.1D    
デバイスに接続されたルート ポートで TC 時間タイマー（802.1D のトポロジ変更タイマーと同    
じ）がアクティブであり、TCA が設定されたコンフィギュレーション BPDU を受信した場合、   
TC 時間タイマーがリセットされます。

この処理方法は、802.1D スイッチにのみ必要です。802.1w BPDU には TCA ビットが設定され     
ません。

 • プロトコルの移行 ― 802.1D スイッチとの下位互換性を保つために、802.1w は 802.1D コンフィ      
ギュレーション BPDU と TCN BPDU をポート単位で選択的に送信します。

ポートが初期化されると、移行遅延タイマーが開始され（802.1w BPDU を送信する最短時間を  
指定）、802.1w BPDU が送信されます。このタイマーがアクティブの間、デバイスは目的のポー  
トで受信されたすべての BPDU を処理し、プロトコル タイプは無視します。

ポートの移行遅延タイマーの期限が切れたあとに、デバイスが 802.1D BPDU を受信した場合、   
デバイスは 802.1D デバイスに接続されたと認識し、802.1D BPDU のみの使用を開始します。た    
だし、802.1w デバイスがポートで 802.1D BPDU を使用している場合、タイマー満了後に 802.1w     
BPDU を受信すると、デバイスはタイマーを再起動し、そのポートで 802.1w BPDU の使用を開    
始します。

Rapid PVST+ と 802.1s MST の相互運用性
Rapid PVST+ は IEEE 802.1s MST 標準とシームレスに相互運用されます。ユーザ設定は不要です。      
このシームレスな相互運用性をディセーブルにするための PVST シミュレーションの詳細について  
は、第 6 章「STP 拡張機能の設定」を参照してください。
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ハイ アベイラビリティ
ソフトウェアは Rapid PVST+ に対してハイ アベイラビリティをサポートしています。ただし、Rapid    
PVST+ を再起動した場合、統計情報およびタイマーは復元されません。タイマーは最初から開始さ 
れ、統計情報は 0 にリセットされます。

（注） ハイ アベイラビリティ機能の詳細については、『Cisco NX-OS High Availability and Redundancy 
Configuration Guide』を参照してください。

バーチャライゼーションのサポート

（注） VDC およびリソースの割り当ての詳細については、『Cisco DCNM Virtual Device Context 
Configuration Guide』を参照してください。

システムでは VDC をサポートしています。VDC を使用すると、VDC ごとに独立したレイヤ 2 バー      
チャライゼーションが実現し、VDC ごとに独立した STP 2 が実行されます（図 4-8 を参照）。

図 4-8 VDC ごとに個別の STP

VDC ごとに独自の Rapid PVST+ が使用されます。NX-OS ソフトウェアを使用している場合、複数     
の VDC に渡って Rapid PVST+ を設定することはできません。ただし、1 つの VDC で Rapid PVST+          
を実行し、別の VDC で MST を実行することはできます。正しい VDC を開始していることを確認      
してから、Rapid PVST+ または MST パラメータを設定してください。

たとえば、VDC1 で MST、VDC2 で Rapid PVST+、VDC3 で MST を稼働させることができます。
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Rapid PVST+ のライセンス要件
次の表に、この機能に関するライセンス要件を示します。

ただし、VDC を使用する場合は Advanced Services ライセンスが必要です。

Rapid PVST+ を設定するための前提条件
Rapid PVST+ には次の前提条件があります。

 • デバイスにログオンしている必要があります。

 • STP パラメータの設定に DCNM を使用する前に、使用しているデバイスのコマンドラインに   
logging-level spanning-tree 6 NX-OS グローバル コマンドを入力してログレベルを設定する必要     
があります。ログレベルの情報については、『Cisco NX-OS System Management Configuration    
Guide』を参照してください。

製品 ライセンス要件

DCNM Rapid PVST+ にライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco DCNM に組      
み込まれており、無料で提供されます。DCNM ライセンス スキームの詳細については、『Cisco DCNM   
Licensing Guide』を参照してください。

NX-OS Rapid PVST+ にライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco NX-OS シス      
テム イメージにバンドルされ、無料で提供されます。NX-OS ライセンス機構の詳細については、『Cisco  
NX-OS Licensing Guide』を参照してください。
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注意事項および制約事項
Rapid PVST を設定する場合は、次の制限および制約事項に従ってください。

 • VLAN およびポートの最大数は 75,000 です。

 • 各 VDC で一度にアクティブにできるのは、Rapid PVST+ または MST のいずれか 1 つのみです。

 • ポート チャネリング ― ポート チャネル バンドルは、単一ポートとみなされます。ポート コ      
ストは、このチャネルに割り当てられたすべての設定済みポート コストの合計値です。

 • プライベート VLAN：

－ トランク ポートでは、プライマリおよびセカンダリ プライベート VLAN は 2 つの異なる      
論理ポートです。両方の VLAN に、まったく同じ STP トポロジが必要です。

－ アクセス ポートでは、STP はプライマリ VLAN のみを認識します。

 • レイヤ 2 ホストに接続されたすべてのポートを STP エッジ ポートとして設定することを推奨     
します。STP ポート タイプの詳細については、第 6 章「STP 拡張機能の設定」 を参照してくだ      
さい。

 • STP は常にイネーブルのままにしておきます。

 • タイマーは変更しないでください。安定性が低下することがあります。

 • ユーザ トラフィックが管理 VLAN に流れないようにして、管理 VLAN とユーザ データを常に      
分離するようにしてください。

 • プライマリおよびセカンダリ ルート スイッチの場所として、ディストリビューション レイヤ   
およびコア レイヤを選択します。

 • 802.1Q トランクを介して 2 台のシスコ製デバイスを接続すると、トランク上で許容される VLAN    
ごとにスパニング ツリー BPDU が交換されます。トランクのネイティブ VLAN 上の BPDU は、       
タグなしの状態で、予約済み 802.1D スパニング ツリー マルチキャスト MAC アドレス      
（01-80-C2-00-00-00）に送信されます。トランクのすべての VLAN 上の BPDU は、タグ付きの    
状態で、予約済み Cisco Shared Spanning Tree Protocol（SSTP）マルチキャスト MAC アドレス       
（01-00-0c-cc-cc-cd）に送信されます。



第 4章      Rapid PVST+ の設定        
Rapid PVST+ の設定

4-22
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0

OL-15867-01-J

Rapid PVST+ の設定
PVST+ プロトコルに 802.1 w 標準を適用した Rapid PVST+ が、デバイスのデフォルトの STP 設定で         
す。

Rapid PVST+ は VLAN 単位でイネーブルになります。デバイスは VLAN ごとに個別の STP インス        
タンスを維持します（STP をディセーブルに設定した VLAN を除きます）。デフォルト VLAN、お    
よびユーザが作成した各 VLAN では、Rapid PVST+ がデフォルトでイネーブルです。

（注） デバイスで Rapid PVST+ を実行している場合、MST のプリプロビジョニングを行うことができま    
す。メイン メニューで、Tools > Global Preferences > Pre Provisioning を選択し、この機能の有効        
化と表示を行う画面にアクセスしたり、画面を非表示にしたりできます。プリプロビジョニングに

ついては、『Cisco DCNM Fundamentals Configuration Guide』を参照してください。

ここでは、次の内容について説明します。

 • Rapid PVST+ のイネーブル化（p.4-23）

 • デバイスのすべての STP パラメータをデフォルト値に設定（p.4-24）

 • Rapid PVST+ の VLAN 単位でのディセーブル化またはイネーブル化（p.4-25）

 • プライマリおよびセカンダリ ルートとスイッチ プライオリティの設定（p.4-26）

 • Rapid PVST+ ポート プライオリティの設定（p.4-28）

 • Rapid PVST+ パスコスト方式およびポート コストの設定（p.4-28）

 • インターフェイス別にすべての Rapid PVST+ パラメータをデフォルト値に設定（p.4-30）

 • VLAN の Rapid PVST+ hello タイムの設定（p.4-32）

 • VLAN の Rapid PVST+ 転送遅延時間の設定（p.4-33）

 • VLAN の Rapid PVST+ 最大エージング タイムの設定（p.4-33）

 • リンク タイプの指定（p.4-34）
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Rapid PVST+ のイネーブル化
Rapid PVST+ をディセーブル化した VLAN がある場合は、指定した VLAN で Rapid PVST+ を再度         
イネーブルにする必要があります。デバイスで MST がイネーブルな場合に、Rapid PVST+ を使用    
するには、そのデバイスで Rapid PVST+ をイネーブルにする必要があります。

「Rapid PVST+ の VLAN 単位でのディセーブル化またはイネーブル化」（p.4-25）を参照してくださ    
い。

デフォルトの STP モードは Rapid PVST+ です。同じ VDC 上で MST と Rapid PVST+ を同時に実行            
することはできません。

（注） スパニング ツリー モードを変更すると、すべてのスパニング ツリー インスタンスが前のモードで    
停止して新規モードで再開されるため、トラフィックが中断されます。

Spanning Tree ペインを使用して Rapid PVST+ をイネーブルにします（図 4-9 を参照）。

図 4-9 Rapid PVST+ のイネーブル化
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手順の詳細

（注） デフォルトの STP モードは Rapid PVST+ です。Rapid PVST+ はデフォルトでイネーブルです。以       
前にデバイスのモードを MST に変更し、デバイスの STP モードを Rapid PVST+ に戻す場合にこの       
手順を使用します。

デバイスで Rapid PVST+ をイネーブルにするには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree を選択して、Spanning Tree ペインを表示します。

ステップ 2 Summary ペインで、Rapid PVST+ をイネーブルにするデバイスをクリックします。

Rapid PVST+ はすべての VLAN でデフォルトでイネーブルです。

ステップ 3 Protocol フィールドで、ドロップダウン リストをクリックして Rapid-PVST+ を選択します。

ステップ 4 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

デバイスのすべての STP パラメータをデフォルト値に設定
デバイスのすべての STP パラメータをデフォルト値に設定できます。これによって STP モードは    
Rapid PVST+ になります。

Spanning Tree ペインを使用してデバイスのすべての STP パラメータをデフォルト値に設定します    
（図 4-9 を参照）。

手順の詳細

デバイスのすべての STP パラメータをデフォルト値に設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree を選択して、Spanning Tree ペインを表示します。

ステップ 2 Summary ペインで、STP のデフォルト値に設定するデバイスをクリックします。

デフォルトの STP モードは Rapid PVST+ です。

ステップ 3 メニューバーで Spanning Tree > Set to default を選択します。

ステップ 4 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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Rapid PVST+ の VLAN 単位でのディセーブル化またはイネーブル化
Rapid PVST+ は VLAN 単位でイネーブルまたはディセーブルにできます。

（注） デフォルト VLAN、およびユーザが作成したすべての VLAN では、Rapid PVST+ がデフォルトで
イネーブルです。

Rapid-PVST+ ペインを使用して VLAN 別に Rapid PVST+ をイネーブルまたはディセーブルにしま      
す（図 4-10 を参照）。

図 4-10 Rapid PVST+ の設定
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手順の詳細

VLAN 別に Rapid PVST+ をイネーブルまたはディセーブルにするには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > Rapid-PVST+ を選択して、Rapid-PVST+ ペ         
インを表示します。

ステップ 2 Summary ペインで、Device View タブをクリックします。

ステップ 3 Summary ペインで、イネーブルまたはディセーブルにする VLAN をクリックします。

Rapid PVST+ はすべての VLAN でデフォルトでイネーブルです。

ステップ 4 メニューバーで Rapid-PVST+ > Enable STP を選択します。

（注） Rapid-PVST+ > Manage VLAN を選択すると、VLAN ペインに戻ります。

ステップ 5 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

（注） VLAN 内のすべてのスイッチおよびブリッジでスパニング ツリーがディセーブルになっている場  
合以外は、VLAN 上でスパニング ツリーをディセーブルにしないでください。VLAN 内の一部の   
スイッチおよびブリッジでスパニング ツリーをディセーブルに設定し、同じ VLAN 内の残りのス   
イッチおよびブリッジではイネーブルのままにしておくことはできません。このような設定にする

と、スパニング ツリーがイネーブルのスイッチおよびブリッジが、ネットワークの物理的トポロ 
ジに関して不完全な情報を得るので、予想外の結果が生じる可能性があります。

注意 物理的なループの存在しないトポロジであっても、スパニング ツリーをディセーブルにすること 
は推奨できません。スパニング ツリーは、設定およびケーブル接続の誤りに対するセーフガード 
の役割を果たします。VLAN 内に物理的なループが存在しないことを保証できる場合以外は、 
VLAN でスパニング ツリーをディセーブルにしないでください。

プライマリおよびセカンダリ ルートとスイッチ プライオリティの設定
ソフトウェアは、Rapid PVST+ が有効なアクティブ VLAN ごとに、STP インスタンスを個別に維持     
します。VLAN ごとに、最小のブリッジ ID を持つネットワーク装置が、その VLAN のルート ブ      
リッジになります。

指定されたデバイスがルート ブリッジとして選択される可能性が高くなるように、プライマリおよ 
びセカンダリ ルートまたは指定された VLAN のスイッチ プライオリティを設定できます。

（注） 特定のスイッチ プライオリティ値を設定するよりも、プライマリおよびセカンダリ ルートを指定  
することを推奨します。
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複数のバックアップ ルート ブリッジを設定する場合は、複数のデバイスをセカンダリ ルートとし   
て指定する必要があります。プライマリ ルート ブリッジを設定するときに使用したものと同じ  
ネットワーク直径および hello タイムをセカンダリ ルートに使用してください。

Rapid-PVST+ ペインを使用してデバイスを VLAN のプライマリ ルート ブリッジに設定します（図     
4-10 を参照）。

手順の詳細

Rapid PVST+ が有効な VLANで、デバイスがプライマリまたはセカンダリ ルート ブリッジになる     
よう設定する、あるいはスイッチ プライオリティを設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > Rapid-PVST+ を選択して、Rapid-PVST+ ペ         
インを表示します。

ステップ 2 Summary ペインで、Device View タブをクリックします。

ステップ 3 Summary ペインで、デバイスをプライマリ ルートに設定する VLAN をクリックします。

Details ペインにタブが表示されます。

ステップ 4 Details タブをクリックします。

ステップ 5 VLAN Setting セクションをクリックします。

VLAN Setting セクションの Switch Priority エリアでは、デバイスを特定の VLAN のプライマリまた       
はセカンダリ ルートに設定したり、スイッチ プライオリティを設定したりできます。

ステップ 6 （任意）Root フィールドでドロップダウン リストをクリックし、primary をクリックしてデバイス   
を VLAN のプライマリ ルートに設定します。

ステップ 7 （任意）Root フィールドでドロップダウン リストをクリックし、secondary をクリックしてデバイ   
スを VLAN のセカンダリ ルートに設定します。

ステップ 8 （任意）Switch Priority エリアの Switch Priority フィールドでドロップダウン リストをクリックし、      
デバイスを VLAN のルート スイッチとして設定するための値を選択します。

デフォルト値は 32768 です。

ステップ 9 （任意）Diameter フィールドでドロップダウン リストをクリックし、直径に設定する値を選択します。

直径のデフォルト値は 7 です。

ステップ 10（任意）Hello Time フィールドでドロップダウン リストをクリックし、hello メッセージの間に設定    
する秒数を選択します。

hello タイムのデフォルトは 2 秒です。

ステップ 11（任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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Rapid PVST+ ポート プライオリティの設定
Rapid PVST+ に最初に選択させたい LAN ポートには低いプライオリティ値を、最後に選択させた    
い LAN ポートには最も高いプライオリティ値を割り当てることができます。すべての LAN ポート    
が同じプライオリティ値を使用している場合には、Rapid PVST+ は LAN ポート番号が最も小さい    
LAN ポートをフォワーディング ステートにして、残りの LAN ポートをブロックします。

デバイスは LAN ポートがアクセス ポートとして設定されている場合にはポート プライオリティ値    
を使用し、LAN ポートがトランク ポートとして設定されている場合には VLAN ポート プライオリ     
ティ値を使用します。

Rapid-PVST+ ペインを使用して Rapid PVST+ のポート プライオリティ値を割り当てます（図 4-10 を      
参照）。

手順の詳細

個々のポートに Rapid PVST+ ポート プライオリティを割り当てるには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > Rapid-PVST+ を選択して、Rapid-PVST+ ペ         
インを表示します。

ステップ 2 Summary ペインで、Device View タブをクリックします。

ステップ 3 Summary ペインで、ポート プライオリティを設定する VLAN をクリックします。

Details ペインにタブが表示されます。

ステップ 4 Details タブをクリックします。

ステップ 5 Port Setting セクションをクリックします。

ステップ 6 プライオリティを設定するポートをクリックします。

ステップ 7 Priority フィールドでドロップダウン リストをクリックし、ポートの Rapid PVST+ プライオリティ     
として設定する値を選択します。

デフォルト値は 128 です。

ステップ 8 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

Rapid PVST+ パスコスト方式およびポート コストの設定
アクセス ポートでは、ポートごとにポート コストを割り当てることができます。トランク ポート   
では、VLAN ごとにポート コストを割り当てることができます。トランク上のすべての VLAN に    
同じポート コストを設定できます。
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（注） Rapid PVST+ モードでは、ショートまたはロング パスコスト方式を使用できます。パスコスト方式   
の設定は、インターフェイス サブモードまたはコンフィギュレーション サブモードで行います。  
デフォルト パスコスト方式はショートです。

Spanning Tree ペインを使用して Rapid PVST+ のパスコスト方式号を設定します（図 4-9 を参照）。

Rapid-PVST+ ペインを使用してポートの Rapid PVST+ コストを設定します（図 4-10 を参照）。

手順の詳細

Rapid PVST+ のパスコスト方式およびポート コストを設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree を選択して、Spanning Tree ペインを表示します。

ステップ 2 Summary ペインで、設定するデバイスをクリックします。

Details ペインにタブが表示されます。

ステップ 3 Configuration タブをクリックします。

ステップ 4 Global Setting セクションをクリックします。

ステップ 5 Path Cost フィールドで、パスコスト方式としてロングまたはショートを選択します。

デフォルト パスコスト方式はショートです。

ステップ 6 メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

ステップ 7 Feature Selector ペインで、Switching > Spanning Tree > Rapid-PVST+ を選択して、Rapid-PVST+ ペ         
インを表示します。

ステップ 8 Summary ペインで、Device View タブをクリックします。

ステップ 9 Summary ペインで、ポート プライオリティを設定する VLAN をクリックします。

Details ペインにタブが表示されます。

ステップ 10 Details タブをクリックします。

ステップ 11 Port Setting セクションをクリックします。

ステップ 12 コストを設定するポートをクリックします。

ステップ 13 Cost フィールドで、auto をクリックしてポートのコストをディセーブルにします。

デフォルト値は 128 です。
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ステップ 14 値を入力してポートのコストを設定します。

デフォルト方式であるショート パスコスト方式で有効な値は 1 ～ 65535 です。ロング パスコスト      
方式で有効な値は 1 ～ 200000000 です。デフォルトのポート コストはポートの帯域幅によって決定     
されます。

ステップ 15（任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

インターフェイス別にすべての Rapid PVST+ パラメータをデフォルト値に設定
Rapid-PVST+ ペインを使用して、デバイスで特定の VLAN の特定のインターフェイスに設定された   
すべての STP パラメータをデフォルトの Rapid PVST+ 値にリセットします（図 4-11 を参照）。

図 4-11 Rapid PVST+ 値の設定
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手順の詳細

デバイスで特定の VLAN のインターフェイスに設定されたすべての STP パラメータをデフォルト    
値に設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > Rapid-PVST+ を選択して、Rapid-PVST+ ペ         
インを表示します。

ステップ 2 Summary ペインで、Network View タブをクリックします。

ステップ 3 Summary ペインで、設定するデバイスをクリックします。

VLAN が含まれるデバイスが表示されます。

ステップ 4 デバイスをクリックします。

Summary ペインでデバイスが強調表示され、Details ペインにタブが表示されます。

ステップ 5 Details ペインで、Details タブをクリックします。

ステップ 6 Details タブで、Port Setting セクションをクリックします。

選択したデバイスの VLAN のインターフェイスが表示されます。

ステップ 7 インターフェイスをクリックします。

選択したインターフェイスが強調表示されます。

ステップ 8 メニューバーで Rapid PVST+ > Set to default を選択します。

ステップ 9 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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VLAN の Rapid PVST+ hello タイムの設定
VLAN の Rapid PVST+ hello タイムを設定できます。

（注） この設定を使用する場合は、注意してください。スパニング ツリーが中断されることがあります。 
hello タイムを変更するには、通常、プライマリ ルートおよびセカンダリ ルートを設定することを   
推奨します。

Rapid-PVST+ ペインを使用して VLAN の hello タイムを設定します（図 4-10 を参照）。

手順の詳細

Rapid PVST+ が有効な VLAN の hello タイムを設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > Rapid-PVST+ を選択して、Rapid-PVST+ ペ         
インを表示します。

ステップ 2 Summary ペインで、Device View タブをクリックします。

ステップ 3 Summary ペインで、hello タイムを設定する VLAN をクリックします。

Details ペインにタブが表示されます。

ステップ 4 Details タブをクリックします。

ステップ 5 VLAN Settings セクションをクリックします。

ステップ 6 Hello Time フィールドでドロップダウン リストをクリックし、hello メッセージの間に設定する秒数    
を選択します。

hello タイムのデフォルトは 2 秒です。

ステップ 7 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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VLAN の Rapid PVST+ 転送遅延時間の設定
Rapid PVST+ を使用している場合は、転送遅延時間を VLAN 単位で設定できます。

Rapid-PVST+ ペインを使用して VLAN の転送遅延時間を設定します（図 4-10 を参照）。

手順の詳細

Rapid PVST+ が有効な VLAN の転送遅延時間を設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > Rapid-PVST+ を選択して、Rapid-PVST+ ペ         
インを表示します。

ステップ 2 Summary ペインで、Device View タブをクリックします。

ステップ 3 Summary ペインで、hello タイムを設定する VLAN をクリックします。

Details ペインにタブが表示されます。

ステップ 4 Details タブをクリックします。

ステップ 5 VLAN Setting セクションをクリックします。

ステップ 6 Forward Delay Time フィールドで、転送遅延値に設定する秒数を入力します。

転送遅延時間のデフォルトは 15 秒です。

ステップ 7 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

VLAN の Rapid PVST+ 最大エージング タイムの設定
Rapid PVST+ を使用している場合は、最大エージング タイムを VLAN 単位で設定できます。

Rapid-PVST+ ペインを使用して VLAN の最大エージング タイムを設定します（図 4-10 を参照）。

手順の詳細

Rapid PVST+ が有効な VLAN の最大エージング タイムを設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > Rapid-PVST+ を選択して、Rapid-PVST+ ペ         
インを表示します。

ステップ 2 Summary ペインで、Device View タブをクリックします。

ステップ 3 Summary ペインで、hello タイムを設定する VLAN をクリックします。

Details ペインにタブが表示されます。

ステップ 4 Details タブをクリックします。
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ステップ 5 VLAN Setting セクションをクリックします。

ステップ 6 Max Age Time フィールドで、BPDU が期限切れになるまでに必要な秒数を入力します。

最大エージング タイムのデフォルトは 20 秒です。

ステップ 7 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

リンク タイプの指定
高速接続（802.1w 標準）は、ポイントツーポイント リンク上にのみ確立されます。デフォルトで  
は、リンク タイプがインターフェイスのデュプレックス モードから制御されます。つまり、全二  
重ポートはポイントツーポイント接続とみなされ、半二重ポートは共有接続とみなされます。

リモート デバイスの単一ポートに、ポイントツーポイントで物理的に接続されている半二重リンク 
がある場合、リンク タイプのデフォルト設定を上書きして高速移行をイネーブルにできます。

リンクを共有に設定すると、STP は 802.1D にフォール バックします。

Spanning Tree ペインを使用してリンク タイプを設定します（図 4-9 を参照）。

手順の詳細

リンク タイプを設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree を選択して、Spanning Tree ペインを表示します。

ステップ 2 Summary ペインで、デバイスをクリックします。

ステップ 3 Details ペインで、Configuration タブをクリックします。

ステップ 4 Details ペインで、Port Setting セクションをクリックします。

Port Setting セクションが展開します。

ステップ 5 Port Setting セクションで設定するインターフェイスをクリックします。

ステップ 6 Link Type カラムで、ドロップダウン リストをクリックしてリンク タイプを選択します。

Link Type のデフォルトは Auto です。

ステップ 7 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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統計情報の表示
Statistics タブに次のウィンドウが表示されます。

 • Spanning Tree Statistics ― 送受信した BPDU を含む Rapid PVST+ の情報を表示します。

Rapid PVST+ のフィールドの説明
これらのフィールドの説明は、Rapid PVST+ の設定に使用されます。ここでは、次の内容について  
説明します。

 • Device ビュー：VLAN：Details：VLAN Setting セクション（p.4-35）

 • Device ビュー：VLAN：Details：Port Setting セクション（p.4-36）

 • Network ビュー：デバイス：Details：VLAN Setting セクション（p.4-36）

 • Network ビュー：デバイス：Details：Port Setting セクション（p.4-37）

Device ビュー：VLAN：Details：VLAN Setting セクション

表 4-5 Device ビュー：VLAN：Details：VLAN Setting セクション 

フィールド 説明

VLAN 表示のみ。VLAN を一意に識別する番号
Device 表示のみ。デバイス名

Name 表示のみ。VLAN 名。デフォルトの名前は VLANXXXX です。
Type 表示のみ。VLAN のタイプ。有効な値は以下のとおりです。

 • Normal

 • Primary

 • Secondary

Status 表示のみ。VLAN の STP の動作ステータス
Root Bridge MAC Address 表示のみ。ルート ブリッジの MAC アドレス
Hello Time デバイスでの hello メッセージのブロードキャスト間隔。デフォルト値は、2 秒です。
Forward Delay Time ポートが転送を開始する前にラーニング ステートでいる期間。デフォルト値は、15 秒です。
Max Age Time プロトコル情報がポートに保管される期間。デフォルト値は、20 秒です。
STP VLAN で STP がイネーブル /ディセーブルかのステータス。デフォルト値は Enabled です。
Switch Priority

Switch Priority ブリッジのプライオリティ。デフォルト値は 32768 です。
Root Rapid PVST+ のプライマリまたはセカンダリ ルート。デフォルトは、ブランクです。
Diameter レイヤ 2 ネットワークにおいて任意の 2 つのエンド ステーション間で許可される最大ホッ     

プ数。デフォルトは、ブランクです。

Hello Time hello メッセージのブロードキャスト間隔。デフォルトは、ブランクです。
Port Status

Total Ports 表示のみ。VLAN に含まれるポート数
Blocking Ports 表示のみ。VLAN に含まれるポートで STP ブロッキング ステートのポート数
Forwarding Ports 表示のみ。VLAN に含まれるポートで STP フォワーディング ステートのポート数
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Device ビュー：VLAN：Details：Port Setting セクション

Network ビュー：デバイス：Details：VLAN Setting セクション

表 4-6 Device ビュー：VLAN：Details：Port Setting セクション 

フィールド 説明

Name 表示のみ。ポート名

Mode 表示のみ。ポート モード
Configuration

Priority STP ポート プライオリティ。デフォルト値は 128 です。
Cost  • Auto ― インターフェイスのメディア速度から得た STP ポート コスト

 • Value ― 手動で設定したポート コスト。有効値は 1 ～ 200000000 です。
Status

Role 表示のみ。Rapid PVST+ ポート ロール。有効な値は以下のとおりです。

 • Root port

 • Designated port

 • Alternate port

 • Backup port

 • Disabled

State 表示のみ。Rapid PVST+ ポート ステート。有効な値は以下のとおりです。

 • Blocking

 • Learning

 • Forwarding

 • Disabled

Priority 表示のみ。STP ポート プライオリティ。デフォルト値は 128 です。
Cost 表示のみ。STP ポート コスト。コスト値はインターフェイスのメディア スピードから取得し   

ます。有効値は 1 ～ 200000000 です。
Link Type 表示のみ。リンク タイプ。デフォルトは自動です。

表 4-7 Network ビュー：デバイス：Details：VLAN Setting セクション 

フィールド 説明

VLAN 表示のみ。VLAN を一意に識別する番号
Device 表示のみ。デバイス名

Name 表示のみ。VLAN 名。デフォルトの名前は VLANXXXX です。
Type 表示のみ。VLAN のタイプ。有効な値は以下のとおりです。

 • Normal

 • Primary

 • Secondary

Status 表示のみ。VLAN の STP の動作ステータス
Root Bridge MAC Address 表示のみ。ルート ブリッジの MAC アドレス
Hello Time デバイスでの hello メッセージのブロードキャスト間隔。デフォルト値は、2 秒です。
Forward Delay Time ポートが転送を開始する前にラーニング ステートでいる期間。デフォルト値は、15 秒です。
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Network ビュー：デバイス：Details：Port Setting セクション

Max Age Time プロトコル情報がポートに保管される期間。デフォルト値は、20 秒です。
STP VLAN で STP がイネーブル /ディセーブルかのステータス。デフォルト値は Enabled です。
Switch Priority

Switch Priority ブリッジのプライオリティ。デフォルト値は 32768 です。
Root Rapid PVST+ のプライマリまたはセカンダリ ルート。デフォルトは、ブランクです。
Diameter レイヤ 2 ネットワークにおいて任意の 2 つのエンド ステーション間で許可される最大ホップ     

数。デフォルトは、ブランクです。

Hello Time hello メッセージのブロードキャスト間隔。デフォルトは、ブランクです。
Port Status

Total Ports 表示のみ。VLAN に含まれるポート数
Blocking Ports 表示のみ。VLAN に含まれるポートで STP ブロッキング ステートのポート数
Forwarding Ports 表示のみ。VLAN に含まれるポートで STP フォワーディング ステートのポート数

表 4-8 Network ビュー：デバイス：Details：Port Setting セクション 

フィールド 説明

Name 表示のみ。ポート名

Mode 表示のみ。ポート モード
Configuration

Priority STP ポート プライオリティ。デフォルト値は 128 です。
Cost  • Auto ― インターフェイスのメディア速度から得た STP ポート コスト

 • Value ― 手動で設定したポート コスト。有効値は 1 ～ 200000000 です。
Status

Role 表示のみ。Rapid PVST+ ポート ロール。有効な値は以下のとおりです。

 • Root port

 • Designated port

 • Alternate port

 • Backup port

 • Disabled

State 表示のみ。Rapid PVST+ ポート ステート。有効な値は以下のとおりです。

 • Blocking

 • Learning

 • Forwarding

 • Disabled

Priority 表示のみ。STP ポート プライオリティ。デフォルト値は 128 です。
Cost 表示のみ。STP ポート コスト。コスト値はインターフェイスのメディア スピードから取得し   

ます。有効値は 1 ～ 200000000 です。
Link Type 表示のみ。リンク タイプ。有効値は shared と point-to-point です。

表 4-7 Network ビュー：デバイス：Details：VLAN Setting セクション（続き）

フィールド 説明
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追加情報
Rapid PVST+ の実装に関する追加情報は、次のセクションを参照してください。

 • 関連資料（p.4-38）

 • 標準規格（p.4-38）

 • MIB（p.4-38）

関連資料

標準規格

MIB

関連トピック マニュアル名

すべての VLAN 第 2 章「VLAN の設定」
MST 第 5 章「MST の設定」

STP 拡張機能 第 6 章「STP 拡張機能の設定」

NX-OS レイヤ 2 スイッチングの設定 『Cisco NX-OS Layer 2 Switching Configuration Guide』

レイヤ 2 インターフェイス 『Cisco DCNM Interfaces Configuration Guide』

DCNM の基本 『Cisco DCNM Fundamentals Configuration Guide』

ハイ アベイラビリティ 『Cisco NX-OS High Availability and Redundancy Guide』

システム管理 『Cisco NX-OS System Management Configuration Guide』
VDC 『Cisco DCNM Virtual Device Context Configuration Guide』

ライセンス 『Cisco DCNM Licensing Guide』

リリース ノート 『Cisco DCNM Release Notes, Release 4.0』

標準規格 タイトル

IEEE 802.1Q-2006（従来の IEEE 802.1s）、IEEE 802.1D-2004    
（従来の IEEE 802.1w）、IEEE 802.1D、IEEE 802.1t

—

MIB MIB リンク

 • CISCO-STP-EXTENSION-MIB

 • BRIDGE-MIB
次の URL から、MIB の検索およびダウンロードができます。

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml
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5
MST の設定

この章では、NX-OS デバイスに Multiple Spanning Tree（MST）を設定する方法について説明します。

Data Center Network Manager の機能の詳細については、『Cisco DCNM Fundamentals Configuration       
Guide』を参照してください。

（注） Spanning Tree Protocol（STP; スパニング ツリー プロトコル）パラメータの設定に DCNM を使用す       
る前に、使用しているデバイスのコマンドラインに NX-OS グローバル コマンドを入力してログレ   
ベルを設定する必要があります。 
--logging-level spanning-tree 6 
--logging logfile messages 6 
--logging event link-status default 
ログレベルについては、『Cisco NX-OS System Management Configuration Guide』を参照してください。

（注） レイヤ 2 インターフェイスの作成方法については、『Cisco DCNM Interface Configuration Guide』を      
参照してください。

IEEE 802.1s 標準の MST を使用すると、スパニング ツリー インスタンスに複数の VLAN（仮想 LAN）        
を割り当てることができます。MST はデフォルトのスパニング ツリー モードではありません。   
Rapid PVST+ がデフォルト モードです。名前、リビジョン番号、および VLAN/インスタンス間マッ    
ピングが同じ MSTI が組み合わされて、MST 領域を形成します。MST 領域は、領域外のスパニン    
グ ツリー構成からは、単一ブリッジとして認識されます。MST が隣接デバイスから IEEE 802.1D    
Spanning Tree Protocol（STP; スパニング ツリー プロトコル）メッセージを受信すると、該当するイ     
ンターフェイスとの境界が形成されます。

VLAN 3968 ～ 4047 または VLAN 4094 を MST インスタンスにマッピングすることはできません。         
これらの VLAN は、デバイスによる内部使用のために予約されています。

（注） スパニング ツリーは、IEEE 802.1w および IEEE 802.1s の規格を意味します。IEEE 802.1D STP につ         
いて説明している場合は、802.1D であることを明記します。
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ここでは、次の内容を説明します。

 • MST について（p.5-3）

 • MST のライセンス要件（p.5-13）

 • MST の前提条件（p.5-13）

 • 注意事項および制約事項（p.5-14）

 • MST の設定（p.5-15）

 • 統計情報の表示（p.5-26）

 • MST のフィールドの説明（p.5-27）

 • 追加情報（p.5-32）

（注） STP および Rapid PVST+ の詳細については、第 4 章「Rapid PVST+ の設定」、STP 拡張機能の詳細         
については、第 6 章「STP 拡張機能の設定」を参照してください。
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MST について

（注） STP パラメータの設定に DCNM を使用する前に、使用しているデバイスのコマンドラインに 
logging-level spanning-tree 6 および logging logfile messages 6 NX-OS グローバル コマンドを入力し
てログレベルを設定する必要があります。ログレベルの情報については、『Cisco NX-OS System 
Management Configuration Guide』を参照してください。

（注） レイヤ 2 インターフェイスの作成方法については、『Cisco DCNM Interface Configuration Guide』を      
参照してください。

IEEE 802.1s 標準の MST を使用すると、スパニング ツリー インスタンスに複数の VLAN を割り当        
てることができます。MST はデフォルトのスパニング ツリー モードではありません。Rapid PVST+    
がデフォルト モードです。名前、リビジョン番号、および VLAN/インスタンス間マッピングが同  
じ MSTI が組み合わされて、MST 領域を形成します。MST 領域は、領域外のスパニング ツリー構     
成からは、単一ブリッジとして認識されます。MST が隣接デバイスから IEEE 802.1D Spanning Tree     
Protocol（STP; スパニング ツリー プロトコル）メッセージを受信すると、該当するインターフェイ   
スとの境界が形成されます。

（注） スパニング ツリーは、IEEE 802.1w および IEEE 802.1s の規格を意味します。このマニュアルで IEEE       
802.1D STP に関して説明する場合は、具体的に 802.1D と表記されます。

ここでは、次の内容について説明します。

 • MST の概要（p.5-3）

 • MST 領域（p.5-4）

 • MST BPDU（p.5-5）

 • MST コンフィギュレーション情報（p.5-5）

 • IST、CIST、および CST（p.5-6）

 • ホップ カウント（p.5-8）

 • 境界ポート（p.5-9）

 • 単一方向リンク障害の検出（p.5-9）

 • ポート コストおよびポート プライオリティ（p.5-10）

 • IEEE 802.1D との相互運用性（p.5-11）

 • ハイ アベイラビリティ（p.5-11）

 • バーチャライゼーションのサポート（p.5-12）

MST の概要

（注） MST をイネーブルにする必要があります。デフォルトのスパニング ツリー モードは、Rapid PVST+    
です。
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MST は、複数の VLAN をスパニング ツリー インスタンスにマッピングします。各インスタンスに     
は他のスパニング ツリー インスタンスとは別のスパニング ツリー トポロジがあります。このアー    
キテクチャにより、データ トラフィック用に複数の転送パスが提供され、ロード バランスが有効  
化され、多くの VLAN をサポートするために必要な STP インスタンスの数を軽減します。MST で     
は、1 つのインスタンス（転送パス）で障害が発生しても他のインスタンス（転送パス）に影響し 
ないので、ネットワークの耐障害性が向上します。

各 MSTI で IEEE 802.1w 標準が使用されるため、明示的なハンドシェイクを通して高速コンバー     
ジェンスを実現することができます。これによって、IEEE 802.1D 転送遅延がなくなり、ルート ブ   
リッジ ポートと指定ポートが迅速にフォワーディング ステートへ移行します（明示的なハンド  
シェイク合意については、第 4 章「Rapid PVST+ の設定」を参照）。

デバイス上では、常に MAC アドレス リダクションがイネーブルです（MAC アドレス リダクショ     
ンの詳細については、第 4 章「Rapid PVST+ の設定」を参照）。この機能をディセーブルにするこ    
とはできません。

MST は、スパニング ツリー動作を改善し、以下の STP バージョンと後方互換性を維持しています。

 • 元の 802.1D スパニング ツリー
 • Rapid PVST+

（注） • IEEE 802.1w は Rapid Spanning Tree Protocol（RSTP）を定義し、IEEE 802.1D に組み込まれてい        
ます。

 • IEEE 802.1s は MST を定義し、IEEE 802.1Q に組み込まれています。

MST 領域
MSTI にデバイスを参加させるには、常に同じ MST コンフィギュレーション情報を使用してスイッ   
チを設定する必要があります（「MST コンフィギュレーション情報」[p.5-5] を参照）。

同じ MST コンフィギュレーションを持つ、相互接続されたデバイスの集合を MST 領域といいま    
す。MST 領域は、同じ MST コンフィギュレーションを持つ、リンクされた MST ブリッジのグルー     
プです。

MST コンフィギュレーションは、各デバイスが属する MST 領域を制御します。このコンフィギュ   
レーションには、領域名、リビジョン番号、VLAN/MSTI 割り当てマッピングが含まれます。

領域には、同じ MST コンフィギュレーションを持つメンバーを 1 つ以上格納できます。各メンバー    
には、802.1w Bridge Protocol Data Unit（BPDU; ブリッジ プロトコル データ ユニット）を処理する        
機能が必要です。ネットワーク内の MST 領域数に制限はありません。

各デバイスは、単一の MST 領域内で、インスタンス 0 を含む最大 65 個の MSTI をサポートできま        
す。インスタンスは 1 ～ 4094 の任意の番号で識別されます。インスタンス 0 は、Internal Spanning       
Tree（IST; 内部スパニング ツリー）という特殊なインスタンス専用です。1 つの VLAN を同時に 2      
つの MSTI に割り当てることはできません。（IST の詳細については、「IST、CIST、および CST」    
[p.5-6] を参照）。

MST 領域は、隣接 MST 領域やその他の Rapid PVST+ 領域、および 802.1D STP からは、単一ブリッ         
ジとして認識されます。

（注） ネットワークを多数の領域に分割することは推奨できません。
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MST BPDU

各デバイスで使用できる MST BPDU は、インターフェイスごとに 1 つのみです。この BPDU が、       
デバイス上の各 MSTI の M レコードを伝達します（図 5-1 を参照）。MST 領域の BPDU を送信する        
のは、IST のみです。すべての M レコードは、IST から伝送される、この特定の BPDU にカプセル      
化されます（IST の詳細については、「IST、CIST、および CST の概要」[p.5-6] を参照）。MST BPDU     
はすべてのインスタンスの情報を伝送するため、MST をサポートするために処理しなければならな 
い BPDU の数は、Rapid PVST+ と比べて大幅に削減されます。

図 5-1 MSTI の M レコードを含む MST BPDU

MST コンフィギュレーション情報
単一の MST 領域内にあるすべてのデバイスで MST コンフィギュレーションを同一にする必要が    
ある場合は、ユーザ側で設定します。

設定できる MST コンフィギュレーションのパラメータは、次の 3 つです。

 • 名前 ― MST 領域を識別する 32 文字のストリング（ヌル パディング、ヌルで終了）

 • リビジョン番号 ― 現在の MST コンフィギュレーションのリビジョンを識別する、符号なし 16     
ビット数

（注） MST コンフィギュレーションの一部としてリビジョン番号が必要な場合は、リビジョン番号を設定 
する必要があります。リビジョン番号は、MST コンフィギュレーションをコミットするたびに、自 
動的に増えるわけではありません。

 • VLAN/MSTI マッピング ― 各 Virtual Device Context（VDC）でサポートされる 4094 個の各 VLAN         
を指定インスタンスに対応付ける、4094 個のエレメントを含むテーブル。先頭エレメント（0） 
および最終エレメント（4095）は 0 に設定されています。エレメント番号 X の値は、VLAN X     
のマッピング先インスタンスを表します。

（注） VLAN/MSTI マッピングを変更すると、MST が再コンバージェンスされます。

MST BPDU には、上記の 3 つのコンフィギュレーション パラメータが含まれています。MST ブリッ      
ジが自身の領域に MST BPDU を受け入れるのは、これらの 3 つのコンフィギュレーション パラメー      
タが完全に一致する場合のみです。特定のコンフィギュレーション属性が異なる場合、MST ブリッ 
ジはこの BPDU が別の MST 領域から伝送されたとみなします。

IST 

 MSTI 

M 

18
27

78
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IST、CIST、および CST
ここでは、IST、Common and Internal Spanning-Tree（CIST）、および Common Spanning Tree（CST）      
について説明します。

 • IST、CIST、および CST の概要（p.5-6）

 • MST 領域内のスパニング ツリー動作（p.5-6）

 • MST 領域間のスパニング ツリー動作（p.5-7）

 • MST 用語（p.5-8）

IST、CIST、および CST の概要

すべての STP インスタンスが独立している Rapid PVST+（詳細については 第 4 章「Rapid PVST+ の         
設定」を参照）と異なり、MST は IST、CIST、および CST スパニング ツリーを次のように確立し     
て、維持します。

 • IST は 1 つの MST 領域で稼働するスパニング ツリーです。

MST は各 MST 領域内でその他のスパニング ツリーを確立して、維持します。これらのスパニ    
ング ツリーは、MSTI といいます。

インスタンス 0 は領域の特殊インスタンスで、IST と呼ばれています。IST は必ずすべてのポー    
ト上にあります。IST（インスタンス 0）は削除できません。デフォルトでは、すべての VLAN  
が IST に割り当てられています。他のすべての MSTI には 1 ～ 4094 の番号が割り当てられます。

IST は BPDU を送受信する唯一の STP インスタンスです。他のすべての MSTI 情報は、MST レ        
コード（M レコード）内に含まれ、MST BPDU 内でカプセル化されています。

同じ領域内にあるすべての MSTI は同じプロトコル タイマーを共有しますが、各 MSTI には     
ルート ブリッジ ID、ルート パス コストなどの独自のトポロジ パラメータがあります。

MSTI は領域に対してローカルです。たとえば、領域 A と B が相互接続されている場合でも、     
領域 A の MSTI 9 は 領域 B の MSTI 9 から独立しています。領域の境界をまたいで使用される           
のは、CST 情報のみです。

 • CST は MST 領域と、ネットワーク上で稼働できる 802.1D および 802.1w STP の任意のインス        
タンスを相互接続します。CST はブリッジ型ネットワークの STP インスタンスの 1 つです。す     
べての MST 領域と、802.1w および 802.1D インスタンスが含まれます。

 • CIST は、各 MST 領域にある IST の集合です。CIST は、MST 領域の内部では IST と同じであ         
り、MST 領域の外部では CST と同じです。

MST 領域内で計算されたスパニング ツリーは、スイッチド ドメイン全体を含む CST のサブツリー     
とみなされます。CIST は 802.1w、802.1s、802.1D 標準をサポートするスイッチ間で動作するスパ   
ニング ツリー アルゴリズムによって形成されます。MST 領域内にある CIST は領域外にある CST      
と同じです。

詳細については、「MST 領域内のスパニング ツリー動作」（p.5-6）および「MST 領域間のスパニン   
グ ツリー動作」（p.5-7）を参照してください。

MST 領域内のスパニング ツリー動作

IST は領域内のすべての MST のスイッチを接続します。IST が収束すると、IST のルートが CIST 領       
域のルートになります（図 5-2 [p.5-7] を参照）。CIST リージョナル ルートは、ネットワーク内に領    
域が 1 つしかない場合は CIST ルートでもあります。CIST ルートが領域外にある場合、領域の境界     
にある MST デバイスの 1 つが CIST リージョナル ルートとして選択されます。

MST の デバイスは初期化時に、自身を CIST ルートおよび CIST リージョナル ルートとして識別す       
る BPDU を送信します。その際、CIST ルートへのパス コストと CIST リージョナル ルートへのパ       
ス コストは 0 に設定されています。また、デバイスは、すべての MSTI を初期化し、自身がこれら     
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すべてのルートであることを示します。デバイスが現在ポートに格納されているものよりも上位の

MSTI ルート情報（小さいスイッチ ID、低いパス コストなど）を受信すると、CIST リージョナル    
ルートとしての主張を撤回します。

初期化中に、MST 領域内に独自の CIST リージョナル ルートを持つ多くのサブ領域が形成される場    
合があります。スイッチは、同じ領域内のネイバーから上位の IST 情報を受信すると、古いサブ領  
域を脱退して、真の CIST リージョナル ルートが含まれている新しいサブ領域に加入します。この   
ようにして、真の CIST リージョナル ルートが含まれているサブ領域以外のサブ領域はすべて縮小   
します。

MST 領域内のすべてのスイッチが同じ CIST リージョナル ルートを承認する必要があります。領域    
内にある任意の 2 つのスイッチは、共通 CIST リージョナル ルートに収束する場合、MSTI に対す      
るポート ロールのみを同期します。

MST 領域間のスパニング ツリー動作

ネットワーク内に複数の領域、または 802.1 w や 802.1D STP インスタンスがある場合、MST はネッ       
トワーク内のすべての MST 領域、およびすべての 802.1w と 802.1D STP スイッチを含む CST を確         
立して、維持します。MSTI は領域の境界で IST と結合して CST になります。

IST は領域内のすべての MST のスイッチを接続し、スイッチ ドメイン全体を含んだ CIST 内のサブ      
ツリーとして認識されます。サブツリーのルートは CIST リージョナル ルートです。MST 領域は、    
隣接する STP のスイッチおよび MST 領域からは仮想デバイスとして認識されます。

図 5-2 に、3 つの MST 領域および 802.1D デバイス（D）があるネットワークを示します。領域 1 の        
CIST リージョナル ルート（A）は CIST ルートでもあります。領域 2 の CIST リージョナル ルート         
（B）および領域 3 の CIST リージョナル ルート（C）は、CIST 内の各サブツリーのルートです。

図 5-2 MST 領域、CIST リージョナル ルート、および CST ルート

A
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D
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BPDU を送受信するのは CST インスタンスのみです。MSTI は自身のスパニング ツリー情報を     
BPDU に（M レコードとして）追加し、同じ MST 領域内の隣接スイッチと相互作用して、最終的    
なスパニング ツリー トポロジを計算します。そのため、BPDU 送信に関連したスパニング ツリー    
パラメータ（たとえば hello タイム、転送時間、最大エージング タイム、最大ホップ数など）は、   
CST インスタンスにのみ設定されますが、すべての MSTI に影響します。スパニング ツリー トポ     
ロジに関連するパラメータ（スイッチ プライオリティ、ポート VLAN コスト、ポート VLAN プラ     
イオリティなど）は CST インスタンスと MSTI の両方で設定できます。

MST デバイスは、バージョン 3 BPDU を使用します。802.1D STP にフォール バックした MST デバ         
イスは、802.1D 専用デバイスと通信する場合、802.1D BPDU のみを使用します。MST デバイスは、    
MST デバイスと通信する場合、MST BPDU を使用します。

MST 用語

MST の命名規則には、一部の内部パラメータまたはリージョナル パラメータの識別情報が含まれ  
ています。これらのパラメータは、ネットワーク全体で使用されている外部パラメータとは違い、

MST 領域のみで使用されます。CIST はネットワーク全体にまたがる唯一のスパニング ツリー イン    
スタンスなので、CIST パラメータでは、内部修飾子や領域の修飾子ではなく、外部修飾子が必要 
です。MST 用語を次に示します。

 • CIST ルートは CIST のルート ブリッジで、ネットワーク全体にまたがる一意のインスタンスで    
す。

 • CIST 外部ルート パス コストは、CIST ルートのコストです。このコストは、MST 領域内では     
変化しません。MST 領域は CIST に対して単一のデバイスのように見えます。CIST 外部ルート    
パス コストは、これらの仮想スイッチとどの領域にも属さないスイッチとの間で計算された 
ルート パス コストです。

 • CIST ルートが領域内にある場合、CIST リージョナル ルートは CIST ルートです。それ以外の     
場合は、領域内で CIST ルートに最も近いデバイスが CIST リージョナル ルートです。CIST リー      
ジョナル ルートは IST のルート ブリッジとして動作します。

 • CIST 内部ルート パス コストは、領域内の CIST リージョナル ルートのコストです。このコス      
トは、IST（インスタンス 0）にのみ関連します。

ホップ カウント
MST 領域内の STP トポロジを計算する場合、MST はコンフィギュレーション BPDU のメッセージ      
有効期間および最大エージング タイムの情報を使用しません。その代わりに、ルートへのパス コ  
ストおよび IP Time to Live（TTL; 存続可能時間）メカニズムに似たホップカウント メカニズムを使      
用します。

ホップ カウントは、メッセージ有効期間情報と同じ結果（再設定の開始）となります。インスタン 
スのルート ブリッジは、常にコスト 0 でホップ カウントが最大値に設定されている BPDU（また     
は M レコード）を送信します。デバイスがこの BPDU を受信すると、受信 BPDU の残存ホップ カ       
ウントから 1 だけ差し引いた値を残存ホップ カウントとする BPDU を生成し、これを伝播します。     
ホップ カウントが 0 になると、デバイスは BPDU を廃棄して、ポートに維持された情報を期限切     
れにします。

BPDU の 802,1w 部分に格納されているメッセージ有効期間および最大エージング タイムの情報    
は、領域全体で同じです（IST の場合のみ）。同じ値が、境界にある領域の指定ポートによって伝播 
されます。

最大エージング タイムは、デバイスがスパニング ツリー設定メッセージを受信せずに再設定を試  
行するまで待機する秒数です。
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境界ポート

境界ポートは LAN に接続されたポートです。この LAN の代表ブリッジは、MST コンフィギュレー     
ションが異なる（したがって、MST 領域が異なる）ブリッジ、または Rapid PVST+ や 802.1D STP      
ブリッジです。指定ポートは、STP ブリッジを検出した場合、またはコンフィギュレーションの異 
なる MST ブリッジや Rapid PVST+ ブリッジから合意メッセージを受信した場合に、自身が境界上     
にあることを認識します。この定義により、領域の内側にある 2 つのポートが異なる領域に属する  
ポートとセグメントを共有することができるので、内部メッセージと外部メッセージの両方をポー

トで受信できる可能性があります（図 5-3 を参照）。

図 5-3 MST 境界ポート

境界では、MST ポートの役割は重要でありません。MSTポート ステートは強制的に IST ポート ス     
テートと同じに設定されます。ポートに境界フラグが設定されている場合、MST ポートのロール選 
択プロセスによって、境界にポート ロールが割り当てられ、IST ポートと同じステートが割り当て  
られます。境界の IST ポートは、バックアップ ポート ロール以外のあらゆるポート ロールを担う     
ことができます（境界ポートのステートおよびロード バランシングに関する重要な情報について 
は、「注意事項および制約事項」[p.5-14] を参照）。

単一方向リンク障害の検出

現在、IEEE MST 標準に単一方向リンク障害の検出機能はありませんが、標準に準拠した実装には  
組み込まれています。この機能のベースとなるのは、異議メカニズムです。ソフトウェアは、受信

した BPDU のポート ロールとステートの一貫性をチェックして、ブリッジング ループが発生する    
可能性のある単一方向リンク障害を検出します。

（注） Unidirectional Link Detection（UDLD; 単方向リンク検出）の詳細については、『Cisco DCNM Interface     
Configuration Guide』を参照してください。

指定ポートが矛盾を検出するとロールは維持されますが、状態は廃棄ステートに戻ります。これは、

接続に矛盾が生じた場合、ブリッジング ループを開始するよりも接続を中断する方が好ましいため 
です。

B2  => B1 
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図 5-4 に、ブリッジング ループの一般的な原因となる単一方向リンク障害を示します。スイッチ A   
はルート ブリッジで、その BPDU はデバイス B へのリンクで損失されます。Rapid PVST+（802.1w）      
および MST BPDU には、送信ポートのロールとステートが含まれます。デバイス A はこの情報を     
使用して、デバイス B が A の送信した上位 BPDU に反応せず、デバイス B がルート ポートではな         
く、指定ポートであることを検出できます。その結果、デバイス A は B のポートをブロックする    
（またはブロックし続ける）ので、ブリッジング ループが回避されます。

図 5-4 単一方向リンク障害の検出

（注） ブリッジ保証機能の詳細については、第 6 章「STP 拡張機能の設定」も参照してください。

ポート コストおよびポート プライオリティ
スパニング ツリーはポート コストを使用して、指定ポートを決定します。値が低いほど、ポート  
コストは小さくなります。スパニング ツリーはコストが最小のパスを選択します。デフォルト ポー  
ト コストは、次のように、インターフェイスの帯域幅から取得されます。

 • 10 Mbps ― 2,000,000

 • 100 Mbps ― 200,000

 • 1 ギガビット イーサネット ― 20,000

 • 10 ギガビット イーサネット ― 2,000

ポート コストを設定すると、選択されるポートが影響を受けます。

（注） MST では常にロング パスコスト計算方式が使用されるため、有効値は 1 ～ 200,000,000 です。

コストが同じポートを差別化するために、ポート プライオリティが使用されます。値が小さいほ 
ど、プライオリティは高くなります。デフォルトのポート プライオリティは 128 です。プライオリ   
ティに設定できる値は、0 ～ 224 です（32 単位で増分）。

 BPDU
 +  

 BPDU
 A  B
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IEEE 802.1D との相互運用性
MST が稼働しているデバイスは、802.1D STP スイッチと相互運用できるようにする内蔵プロトコ   
ル移行機能をサポートします。このデバイスが 802.1D コンフィギュレーション BPDU（プロトコ   
ル バージョンが 0 に設定されている BPDU）を受信すると、そのポートからは 802.1D BPDU のみ       
を送信します。また、MST デバイスは、802.1D BPDU、異なる領域と関連する MST BPDU（バー    
ジョン 3）、または 802.1w BPDU（バージョン 2）を受信するときに、ポートが領域の境界にあるこ    
とを検出できます。

ただし、デバイスが 802.1D BPDU を受信しなくなっても、自動的に MST モードに戻ることはあり     
ません。これは、802.1D デバイスが指定デバイスでない場合、802.1D デバイスがリンクから削除  
されているかどうかを検出できないためです。また、デバイスは、このデバイスに接続されている

デバイスがその領域に加入した場合、引き続きポートに境界ロールを割り当てる可能性もありま

す。

プロトコル移行プロセスを再起動する（隣接スイッチと強制的に再ネゴシエーションする）には、

clear spanning-tree detected-protocols コマンドを入力します。

リンク上のすべての Rapid PVST+ スイッチ（およびすべての 8021.D STP スイッチ）は、802.1w      
BPDU の場合と同様に、MST BPDU を処理できます。MST スイッチは、境界ポートでバージョン 0     
コンフィギュレーションと Topology Change Notification（TCN; トポロジ変更通知）BPDU、または    
バージョン 3 MST BPDU のいずれかを送信できます。境界ポートは、指定デバイスが単一のスパニ    
ング ツリー デバイスであるか、または異なる MST コンフィギュレーションを持つデバイスである    
LAN に接続されます。

MST は、MST ポートでシスコの先行標準 MSTP を受信した場合、必ず先行標準 MSTP と相互運用      
されます。明示的な設定は不要です。Cisco NX-OS Release 4.0(2) 以降のリリースでは、指定したイ    
ンターフェイスから先行標準の MSTP メッセージを常時送信するよう設定できます。先行標準 MST   
メッセージを受信するまで待機せずに、先行標準 MST メッセージの送信を開始できます。

インターフェイスによるプロアクティブな先行標準 MSTP メッセージの送信の設定に関する詳細  
については、『Cisco NX-OS Layer 2 Configuration Guide』を参照してください。

ハイ アベイラビリティ
ソフトウェアは MST に対してハイ アベイラビリティをサポートしています。ただし、MST を再起    
動した場合、統計情報およびタイマーは復元されません。タイマーは最初から開始され、統計情報

は 0 にリセットされます。

（注） ハイ アベイラビリティ機能の詳細については、『Cisco NX-OS High Availability and Redundancy 
Configuration Guide』を参照してください。
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バーチャライゼーションのサポート

システムでは VDC がサポートされ、VDC ごとに個別の STP が実行されます（図 5-5 を参照）。

図 5-5 VDC ごとに個別の STP

特定の VDC で Rapid PVST+ を実行し、別の VDC で MST を実行することができます。VDC ごとに          
独自の MST があります。作業している VDC が正しいことを確認してください。

（注） VDC およびリソースの割り当ての詳細については、『Cisco DCNM Virtual Device Context 
Configuration Guide』を参照してください。
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MST のライセンス要件
次の表に、この機能に関するライセンス要件を示します。

ただし、VDC を使用する場合は Advanced Services ライセンスが必要です。

MST の前提条件
MST には次の前提条件があります。

 • デバイスにログオンしている必要があります。

 • DCNM を使用して STP パラメータを設定する前に、デバイスのコマンド ラインに NX-OS グ      
ローバル コマンドの logging-level spanning-tree 6 を入力して、ログレベルを設定する必要があ     
ります。ログレベルの情報については、『Cisco NX-OS System Management Configuration Guide』     
を参照してください。

 • 必要に応じて、Advanced Services ライセンスをインストールし、特定の VDC を開始します。

 • デフォルト以外の VDC で作業する場合は、目的の VDC を作成しておく必要があります。

製品 ライセンス要件

DCNM MST のライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco DCNM に組み込ま     
れており、無料で提供されます。DCNM ライセンス スキームの詳細については、『Cisco DCNM Licensing    
Guide』を参照してください。

NX-OS MST のライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco NX-OS システム イ      
メージにバンドルされ、無料で提供されます。NX-OS ライセンス機構の詳細については、『Cisco NX-OS  
Licensing Guide』を参照してください。
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注意事項および制約事項

（注） VLAN/MSTI マッピングを変更すると、MST が再コンバージェンスされます。

MST を使用する場合は、次の注意事項に従ってください。

 • MST をイネーブルにする必要があります。デフォルトのスパニング ツリー モードは、Rapid 
PVST+ です。

 • 1 つの VLAN を同時に 2 つの MSTI に割り当てることはできません。

 • VLAN 3968 ～ 4047 または VLAN 4094 を MST インスタンスにマッピングすることはできませ         
ん。これらの VLAN は、デバイスによる内部使用のために予約されています。

 • 1 つのデバイスに最大 65 個の MSTI を設定できます。

 • VLAN およびポートの最大数は 75,000 です。

 • デフォルトでは、すべての VLAN が MSTI 0（IST）にマッピングされます（VLAN を特定の    
MSTI にマッピングする方法については、「VLAN と MSTI のマッピングおよびマッピング解除」    
[p.5-21] を参照）。

 • ロード バランスは、MST 領域の内部でのみ実行できます。

 • MSTI にマッピングされたすべての VLAN が、トランクによって伝送されているか、または伝   
送から除外されていることを確認します。

 • STP は常にイネーブルのままにしておきます。

 • タイマーは変更しないでください。安定性が低下することがあります。

 • ユーザ トラフィックが管理 VLAN に流れないようにして、管理 VLAN とユーザ データを常に      
分離するようにしてください。

 • プライマリおよびセカンダリ ルート スイッチの場所として、ディストリビューション レイヤ   
およびコア レイヤを選択します。

 • ポート チャネリング ― ポート チャネル バンドルは、単一ポートとみなされます。ポート コ      
ストは、このチャネルに割り当てられたすべての設定済みポート コストの合計値です。

（注） ソフトウェアは、MST に対して中断のない完全アップグレードをサポートします。中断のないアッ 
プグレードの詳細については、『Cisco NX-OS High Availability and Redundancy Configuration Guide』       
を参照してください。

 • VLAN を MSTI にマッピングすると、この VLAN が以前の MSTI から自動的に削除されます。

 • 1 つの MSTI に任意の個数の VLAN をマッピングできます。

 • Rapid PVST+ と MST クラウド、または PVST+ と MST クラウドとの間でロード バランスを実         
現するには、すべての MST 境界ポートがフォワーディング ステートでなければなりません。   
MST クラウドの CIST リージョナル ルートが CST のルートでなければなりません。MST クラ       
ウドが複数の MST 領域で構成されている場合、MST 領域の 1 つに CST ルートが含まれていな       
ければならず、その他のすべての MST 領域では MST クラウド内に含まれるルートへのパスが、    
Rapid PVST+ または PVST+ クラウドよりも良好なものでなければなりません。

 • ネットワークを多数の領域に分割しないでください。ただし、そのような状況が避けられない

ような場合には、スイッチド LAN を非レイヤ 2 装置と相互接続された小規模な LAN に分割す      
ることを推奨します。
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MST の設定

（注） デバイスで Rapid PVST+ を実行している場合、MST のプリプロビジョニングを行うことができま    
す。メイン メニューで、Tools > Global Preferences > Pre Provisioning を選択し、この機能の有効        
化と表示を行う画面にアクセスしたり、画面を非表示にしたりできます。プリプロビジョニングに

ついては、『Cisco DCNM Fundamentals Configuration Guide』を参照してください。

ここでは、次の内容について説明します。

 • MST のイネーブル化（p.5-15）

 • MST 名およびリビジョンの指定（p.5-17）

 • MST のデフォルト値への設定（p.5-17）

 • MST インスタンスの追加およびインスタンスと VLAN のマッピング（p.5-18）

 • MST インスタンスの削除（p.5-20）

 • VLAN と MSTI のマッピングおよびマッピング解除（p.5-21）

 • プライマリおよびセカンダリ ルートとスイッチ プライオリティの設定（p.5-22）

 • ポート プライオリティおよび MST ポートのコストの設定（p.5-23）

 • ポートごとのデフォルト MST 値の設定（p.5-24）

 • hello タイム、転送遅延時間、最大エージング タイム、最大ホップ カウントの設定（p.5-25）

 • リンク タイプの指定（p.5-26）

MST のイネーブル化
MST をイネーブルにできます。デフォルトは、Rapid PVST+ です。

（注） スパニング ツリー モードを変更すると、すべてのスパニング ツリー インスタンスが前のモードで    
停止して新規モードで再開されるため、トラフィックは中断されます。

Spanning Tree ペインを使用して MST をイネーブルにします（図 5-6 を参照）。
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図 5-6 MST のイネーブル化

手順の詳細

デバイスで MST をイネーブルにするには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree を選択して、Spanning Tree ペインを表示します。

ステップ 2 Summary ペインで、MST をイネーブルにするデバイスをクリックします。

Rapid PVST+ はすべての VLAN でデフォルトでイネーブルです。

ステップ 3 Protocol フィールドで、ドロップダウン リストをクリックして MST を選択します。

ステップ 4 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

（注） スパニング ツリー モードを変更すると、すべてのスパニング ツリー インスタンスが前のモードで    
停止して新規モードで再開されるため、トラフィックは中断されます。
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MST 名およびリビジョンの指定
ブリッジに名前とリビジョン番号を設定します。複数のブリッジが同じ MST 領域内にある場合は、  
これらのブリッジの MST 名、VLAN/ インスタンス間マッピング、および MST リビジョン番号を    
同一にする必要があります。

Spanning Tree ペインを使用して MST 名およびリビジョン番号を設定します（図 5-6 を参照）。

手順の詳細

MST 名とリビジョン番号を設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree を選択して、Spanning Tree ペインを表示します。

ステップ 2 Summary ペインで、MST 名とリビジョン番号を指定するデバイスをクリックします。

Summary ペインでデバイスが強調表示され、Details ペインにタブが表示されます。

ステップ 3 Details ペインで、Configuration タブをクリックします。

ステップ 4 Global Setting セクションをクリックします。

ステップ 5 MST Setting エリアの Name フィールドに、ブリッジの MST 名を入力します。

デフォルトは、ブランクです。

ステップ 6 MST Setting エリアの Revision Number フィールドに、MST リビジョン番号を入力します。

デフォルトは、0 です。

ステップ 7 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

MST のデフォルト値への設定
Spanning Tree ペインを使用して MST をデフォルト値に設定します（図 5-6 を参照）。

手順の詳細

MST をデフォルト値に設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree を選択して、Spanning Tree ペインを表示します。

ステップ 2 MST をデフォルト値に設定するデバイスを選択します。

ステップ 3 メニューバーで Spanning Tree > Set to default を選択します。

この操作によって名前とリビジョン番号が削除され、すべての VLAN が MST インスタンス 0 に戻      
されます。
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ステップ 4 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

MST インスタンスの追加およびインスタンスと VLAN のマッピング
VLAN 3968 ～ 4047 または VLAN 4094 を MST インスタンスにマッピングすることはできません。         
これらの VLAN は、デバイスによる内部使用のために予約されています。

（注） すべてのデバイスが同じ MST 領域に含まれるよう、すべてのデバイスで MST 名とリビジョン番号    
に同一の内容を指定し、すべてのデバイスで VLAN/MST インスタンス間マッピングが同一になる  
ようにします。

MST ペインを使用して MST を追加し、VLAN をインスタンスにマッピングします（図 5-7 を参照）。

図 5-7 MST の設定
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手順の詳細

MST インスタンスを追加するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > MST を選択して、MST ペインを表示します。

ステップ 2 Summary ペインで、Device View タブをクリックします。

ステップ 3 Summary ペインで、MST インスタンスを追加または削除するデバイスをクリックします。

Summary ペインが展開し、デバイスに現在設定されている MST インスタンスが表示されます。

ステップ 4 メニューバーで MST > Add MST Instance を選択します。

システムによってインスタンスが追加されます。MST ID と VLAN フィールドはブランクのままで    
す。

ステップ 5 MST ID フィールドに新しい MST 用の番号を入力します。

ステップ 6 VLANs フィールドに、新しい MST にマッピングする VLAN を入力します。

（注） 新しく作成した MST インスタンスには、VLAN を最低 1 つ追加する必要があります。

ステップ 7 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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MST インスタンスの削除
MST ペインを使用して MST インスタンスを削除します（図 5-8 を参照）。

図 5-8 MST インスタンスの削除

手順の詳細

MST インスタンスを削除するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > MST を選択して、MST ペインを表示します。

ステップ 2 Summary ペインで、Network View タブをクリックします。

ステップ 3 Summary ペインで、MST instance をクリックします。

Summary ペインが展開し、その MST インスタンスが現在設定されているデバイスが表示されます。

ステップ 4 メニューバーで MST > Delete MST Instance を選択します。

ステップ 5 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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VLAN と MSTI のマッピングおよびマッピング解除
複数のブリッジが同じ MST 領域内にある場合は、これらのブリッジの MST 名、VLAN/ インスタ    
ンス間マッピング、および MST リビジョン番号を同一にする必要があります。

VLAN 3968 ～ 4047 または VLAN 4094 を MST インスタンスにマッピングすることはできません。         
これらの VLAN は、デバイスによる内部使用のために予約されています。

（注） VLAN/MSTI マッピングを変更すると、MST が再コンバージェンスされます。

（注） MSTI はディセーブルにできません。

MST ペインを使用して VLAN/MST インスタンス間マッピングを作成します（図 5-7 を参照）。

手順の詳細

VLAN と MST インスタンスのマッピングおよびマッピング解除を行うには、次の手順を実行しま   
す。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree > MST を選択して、MST ペインを表示します。

ステップ 2 Summary ペインで、Device View タブをクリックします。

ステップ 3 Summary ペインで、MST インスタンスを追加または削除するデバイスをクリックします。

Summary ペインが展開し、デバイスに現在設定されている MST インスタンスが表示されます。

ステップ 4 VLAN を追加または削除する MST をクリックします。

ステップ 5 メニューバーで MST > Add VLAN to MST Instance を選択します。

ステップ 6 新しい MST に VLAN を追加します。

ステップ 7 （任意）メニューバーで MST Remove VLAN を選択し、MST インスタンスから VLAN を削除して       
マッピングを解除します。

ステップ 8 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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プライマリおよびセカンダリ ルートとスイッチ プライオリティの設定
指定されたデバイスがルート ブリッジとして選択される可能性が高くなるように、プライマリおよ 
びセカンダリ ルートまたは MST インスタンスのスイッチ プライオリティを設定できます。この設    
定では、直径と hello タイムの選択も行うことができます。

（注） 特定のスイッチ プライオリティ値を設定するよりも、プライマリおよびセカンダリ ルートを指定  
することを推奨します。

複数のバックアップ ルート ブリッジを設定する場合は、複数のデバイスをセカンダリ ルートとし   
て指定する必要があります。プライマリ ルート ブリッジを設定するときに使用したものと同じ  
ネットワーク直径および hello タイムをセカンダリ ルートに使用してください。

MST ペインを使用して、デバイスをプライマリまたはセカンダリ ルートに設定し、スイッチ プラ   
イオリティを設定します（図 5-8 を参照）。

手順の詳細

プライマリおよびセカンダリ ルートの設定またはスイッチ プライオリティの設定を行うには、次  
の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > MST を選択して、MST ペインを表示します。

ステップ 2 Summary ペインで、設定するデバイスをクリックします。

Summary ペインが展開し、MST インスタンスが表示されます。

ステップ 3 Summary ペインで、プライマリおよびセカンダリ ルート、またはスイッチ プライオリティを指定   
するMST インスタンスをクリックします。

Details ペインにタブが表示されます。

ステップ 4 Details ペインで、Details タブをクリックします。

ステップ 5 Details タブで、MST Setting セクションをクリックします。

ステップ 6 （任意）Switch Priority エリアの Root フィールドでドロップダウン リストをクリックし、primary を      
クリックしてデバイスをプライマリ ルートに設定します。

ステップ 7 （任意）Switch Priority エリアの Root フィールドでドロップダウン リストをクリックし、secondary 
をクリックしてデバイスをセカンダリ ルートに設定します。

ステップ 8 （任意）Switch Priority エリアの Switch Priority フィールドでドロップダウン リストをクリックし、      
スイッチ プライオリティ値をクリックしてスイッチ プライオリティを特定の値に設定します。

ステップ 9 Diameter フィールドでドロップダウン リストをクリックし、直径に設定する値をクリックします。

直径のデフォルト値は 7 です。
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ステップ 10 Hello Time フィールドでドロップダウン リストをクリックし、hello タイム メッセージの間隔（秒     
数）に設定する値をクリックします。

hello タイムのデフォルト値は 2 秒です。

ステップ 11（任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

ポート プライオリティおよび MST ポートのコストの設定
ループが発生すると、MST はポート プライオリティとコストを使用して、フォワーディング ステー   
トにするインターフェイスを選択します。MST パス コストのデフォルト値は、インターフェイス  
のメディア速度から取得されます。最初に選択させたいインターフェイスには低いプライオリティ

値およびコスト値を、最後に選択させたいインターフェイスには高い値を割り当てることができま

す。すべてのインターフェイスが同じプライオリティ値およびコスト値を使用している場合には、

MST はインターフェイス番号が最も小さいインターフェイスをフォワーディング ステートにし  
て、残りのインターフェイスをブロックします。

MST ペインを使用して、MST アクセス ポートおよびトランク ポート別にポート プライオリティ     
およびポート コスト値を設定します（図 5-8 を参照）。

手順の詳細

ポート プライオリティおよびポート コストを設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > MST を選択して、MST ペインを表示します。

ステップ 2 Summary ペインで、設定するデバイスをクリックします。

Summary ペインが展開し、MST インスタンスが表示されます。

ステップ 3 Summary ペインで、ポート プライオリティおよびポート コストを設定するMST インスタンスをク    
リックします。

Details ペインにタブが表示されます。

ステップ 4 Details ペインで、Details タブをクリックします。

ステップ 5 Details タブで、Access Ports セクションをクリックしてアクセス ポートを設定するか、Trunk Ports     
セクションをクリックしてトランク ポートを設定します。

セクションが展開し、MST インスタンスのポートが表示されます。

ステップ 6 プライオリティおよびコストを設定するポートをクリックします。

ステップ 7 Priority フィールドでドロップダウン リストをクリックし、ポートの MST プライオリティとして設    
定する値を選択します。

デフォルト値は 128 です。
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ステップ 8 Cost フィールドで、auto をクリックしてポートのコストをディセーブルにします。

デフォルト値は 128 です。

ステップ 9 値を入力してポートのコストを設定します。

デフォルトのポート コストは、ポートの帯域幅から判別されます。

ステップ 10（任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

ポートごとのデフォルト MST 値の設定
MST アクセス ポートおよびトランク ポート別にデフォルト値を設定します（図 5-8 を参照）。

手順の詳細

特定のポートのデフォルト MST 値を設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > MST を選択して、MST ペインを表示します。

ステップ 2 Summary ペインで、設定するデバイスをクリックします。

Summary ペインが展開し、MST インスタンスが表示されます。

ステップ 3 Summary ペインで、ポート プライオリティおよびポート コストを設定するMST インスタンスをク    
リックします。

Details ペインにタブが表示されます。

ステップ 4 Details ペインで、Details タブをクリックします。

ステップ 5 Details タブで、Access Ports セクションをクリックしてアクセス ポートを設定するか、Trunk Ports     
セクションをクリックしてトランク ポートを設定します。

セクションが展開し、MST インスタンスのポートが表示されます。

ステップ 6 MST デフォルト値を設定するポートをクリックします。

ステップ 7 メニューバーで、MST > Set to default for Access Port を選択してアクセス ポートのデフォルトを設         
定するか、Set to default for Trunk Port を選択してトランク ポートのデフォルトを設定します。

ステップ 8 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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hello タイム、転送遅延時間、最大エージング タイム、最大ホップ カウントの設定
hello タイムは、デバイス上のすべてのインスタンスに対してルート ブリッジが生成する設定メッ  
セージの間隔です。最大エージング タイマーは、デバイスがスパニング ツリー設定メッセージを  
受信せずに再設定を試行するまで待機する秒数です。領域内の最大ホップを設定し、それをその領

域内にあるすべての MST インスタンスに適用できます。ホップ カウントは、メッセージ有効期間   
情報と同じ結果（再設定の開始）となります。

Spanning Tree ペインを使用して、hello タイム、転送遅延時間、最大エージング タイム、最大ホッ    
プ カウントを設定します（図 5-6 を参照）。

手順の詳細

MST の hello タイム、転送遅延時間、最大エージング タイム、最大ホップ カウントを設定するに     
は、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree を選択して、Spanning Tree ペインを表示します。

ステップ 2 Summary ペインで、MST 名とリビジョン番号を指定するデバイスをクリックします。

Summary ペインでデバイスが強調表示され、Details ペインにタブが表示されます。

ステップ 3 Details ペインで、Configuration タブをクリックします。

ステップ 4 Global Setting セクションをクリックします。

ステップ 5 MST Setting エリアの Hello Time フィールドでドロップダウン リストをクリックし、hello タイムに       
設定する値を選択します。

デフォルトは、2 秒です。

ステップ 6 MST Setting エリアの Forwarding Delay Time フィールドで、転送遅延時間に設定する値を入力しま      
す。

デフォルトは、15 秒です。

ステップ 7 MST Setting エリアの Max Age Time フィールドで、最大エージング タイムに設定する値を入力しま       
す。

デフォルトは、20 秒です。

ステップ 8 MST Setting エリアの Max Hop Count フィールドで、最大ホップ カウントに設定する値を入力しま       
す。

デフォルトは、20 です。

ステップ 9 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。
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リンク タイプの指定
高速接続（802.1w 標準）は、ポイントツーポイント リンク上にのみ確立されます。デフォルトで  
は、リンク タイプがインターフェイスのデュプレックス モードから制御されます。つまり、全二  
重ポートはポイントツーポイント接続とみなされ、半二重ポートは共有接続とみなされます。

リモート デバイスの単一ポートに、ポイントツーポイントで物理的に接続されている半二重リンク 
がある場合、リンク タイプのデフォルト設定を上書きして高速移行をイネーブルにできます。

リンクを共有に設定すると、STP は 802.1D にフォール バックします。

Spanning Tree ペインを使用してリンク タイプを設定します（図 5-6 を参照）。

手順の詳細

リンク タイプを設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインで、Switching > Spanning Tree を選択して、Spanning Tree ペインを表示します。

ステップ 2 Summary ペインで、デバイスをクリックします。

ステップ 3 Details ペインで、Configuration タブをクリックします。

ステップ 4 Details ペインで、Port Setting セクションをクリックします。

Port Setting セクションが展開します。

ステップ 5 Port Setting セクションで設定するインターフェイスをクリックします。

ステップ 6 Link Type カラムで、ドロップダウン リストをクリックしてリンク タイプを選択します。

Link Type のデフォルトは Auto です。

ステップ 7 （任意）メニューバーで File > Deploy を選択し、デバイスに変更を適用します。

統計情報の表示
Statistics タブに次のウィンドウが表示されます。

 • Spanning Tree Statistics ― 送受信した BPDU を含む Rapid PVST+ の情報を表示します。
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MST のフィールドの説明
これらのフィールドの説明は、MST の設定に使用されます。ここでは、次の内容について説明しま 
す。

 • Device ビュー：インスタンス：Details：MST Settings セクション（p.5-27）

 • Device ビュー：インスタンス：Details：Access Ports セクション（p.5-28）

 • Device ビュー：インスタンス：Details：Trunk Ports セクション（p.5-29）

 • Network ビュー：デバイス：Details：MST Settings セクション（p.5-30）

 • Network ビュー：デバイス：Details：Access Ports セクション（p.5-30）

 • Network ビュー：デバイス：Details：Trunk Ports セクション（p.5-31）

Device ビュー：インスタンス：Details：MST Settings セクション

表 5-1 Device ビュー：インスタンス：Details：MST Settings セクション 

フィールド 説明

MST Instance 表示のみ。MST インスタンスを一意に識別する番号
Device 表示のみ。VLAN の設定対象デバイス名
VLANs MST インスタンスに含まれる VLAN。デフォルトは、VLAN1 です。

（注） インスタンス 0 で作業する場合は、このフィールドを変更することはできません。

Switch Priority

Switch Priority ブリッジのプライオリティ。デフォルト値は 32768 です。
Root Rapid PVST+ のプライマリまたはセカンダリ ルート。デフォルトは、ブランクです。
Diameter レイヤ 2 ネットワークにおいて任意の 2 つのエンド ステーション間で許可される最大ホップ     

数。デフォルトは、ブランクです。

Hello Time hello メッセージのブロードキャスト間隔。デフォルトは、ブランクです。
Port Status

Total Ports 表示のみ。MST インスタンスに含まれるポート数
Blocking Ports 表示のみ。MST インスタンスに含まれるポートで STP ブロッキング ステートのポート数
Forwarding Ports 表示のみ。MST インスタンスに含まれるポートで STP フォワーディング ステートのポート数
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Device ビュー：インスタンス：Details：Access Ports セクション

表 5-2 Device ビュー：インスタンス：Details：Access Ports セクション 

フィールド 説明

Name 表示のみ。ポート名

Mode 表示のみ。ポート モード
Configuration

Priority MST ポート プライオリティデフォルト値は 128 です。
Cost  • Auto ― インターフェイスのメディア速度から得た STP ポート コスト

 • Value ― 手動で設定したポート コスト。有効値は 1 ～ 200000000 です。
Status

Role 表示のみ。MST ポート ロール。有効な値は以下のとおりです。

 • Root port

 • Designated port

 • Alternate port

 • Backup port

 • Disabled

State 表示のみ。MST ポート ステート。有効な値は以下のとおりです。

 • Blocking

 • Learning

 • Forwarding

 • Disabled

Priority 表示のみ。MST ポート プライオリティ。デフォルト値は 128 です。
Cost 表示のみ。MST ポート コスト。コスト値はインターフェイスのメディア スピードから取得し   

ます。有効値は 1 ～ 200000000 です。
Link Type 表示のみ。リンク タイプ。デフォルトは自動です。
Boundary Port 表示のみ。MST 領域間の境界ポートを表示します。
PreStd Port 表示のみ。MST 領域間のポートおよび先行標準ポートを表示します。
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Device ビュー：インスタンス：Details：Trunk Ports セクション

表 5-3 Device ビュー：インスタンス：Details：Trunk Ports セクション 

フィールド 説明

Name 表示のみ。ポート名

Configuration

Priority MST ポート プライオリティデフォルト値は 128 です。
Cost  • Auto ― インターフェイスのメディア速度から得た STP ポート コスト

 • Value ― 手動で設定したポート コスト。有効値は 1 ～ 200000000 です。
Status

Role 表示のみ。MST ポート ロール。有効な値は以下のとおりです。

 • Root port

 • Designated port

 • Alternate port

 • Backup port

 • Disabled

State 表示のみ。MST ポート ステート。有効な値は以下のとおりです。

 • Blocking

 • Learning

 • Forwarding

 • Disabled

Priority 表示のみ。MST ポート プライオリティ。デフォルト値は 128 です。
Cost 表示のみ。MST ポート コスト。コスト値はインターフェイスのメディア スピードから取得し   

ます。有効値は 1 ～ 200000000 です。
Link Type 表示のみ。リンク タイプ。デフォルトは自動です。
Boundary Port 表示のみ。

PreStd Port 表示のみ。
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Network ビュー：デバイス：Details：MST Settings セクション

Network ビュー：デバイス：Details：Access Ports セクション

表 5-4 Network ビュー：デバイス：Details：MST Settings セクション 

フィールド 説明

MST Instance 表示のみ。MST インスタンスを一意に識別する番号
Device 表示のみ。VLAN の設定対象デバイス名
VLANs MST インスタンスに含まれる VLAN。デフォルトは、VLAN1 です。

（注） インスタンス 0 で作業する場合は、このフィールドを変更することはできません。

Switch Priority

Switch Priority ブリッジのプライオリティ。デフォルト値は 32768 です。
Root Rapid PVST+ のプライマリまたはセカンダリ ルート。デフォルトは、ブランクです。
Diameter レイヤ 2 ネットワークにおいて任意の 2 つのエンド ステーション間で許可される最大ホップ     

数。デフォルトは、ブランクです。

Hello Time hello メッセージのブロードキャスト間隔。デフォルトは、ブランクです。
Port Status

Total Ports 表示のみ。MST インスタンスに含まれるポート数
Blocking Ports 表示のみ。MST インスタンスに含まれるポートで STP ブロッキング ステートのポート数
Forwarding Ports 表示のみ。MST インスタンスに含まれるポートで STP フォワーディング ステートのポート数

表 5-5 Network ビュー：デバイス：Details：Access Ports セクション 

フィールド 説明

Name 表示のみ。ポート名

Mode 表示のみ。ポート モード
Configuration

Priority MST ポート プライオリティデフォルト値は 128 です。
Cost  • Auto ― インターフェイスのメディア速度から得た STP ポート コスト

 • Value ― 手動で設定したポート コスト。有効値は 1 ～ 200000000 です。
Status

Role 表示のみ。MST ポート ロール。有効な値は以下のとおりです。

 • Root port

 • Designated port

 • Alternate port

 • Backup port

 • Disabled

State 表示のみ。MST ポート ステート。有効な値は以下のとおりです。

 • Blocking

 • Learning

 • Forwarding

 • Disabled
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Network ビュー：デバイス：Details：Trunk Ports セクション

Priority 表示のみ。MST port priority.デフォルト値は 128 です。
Cost 表示のみ。MST ポート コスト。コスト値はインターフェイスのメディア スピードから取得し   

ます。有効値は 1 ～ 200000000 です。
Link Type 表示のみ。リンク タイプ。デフォルトは自動です。
Boundary Port 表示のみ。

PreStd Port 表示のみ。

表 5-6 Network ビュー：デバイス：Details：Trunk Ports セクション 

フィールド 説明

Name 表示のみ。ポート名

Configuration

Priority MST ポート プライオリティデフォルト値は 128 です。
Cost  • Auto ― インターフェイスのメディア速度から得た STP ポート コスト

 • Value ― 手動で設定したポート コスト。有効値は 1 ～ 200000000 です。
Status

Role 表示のみ。MST ポート ロール。有効な値は以下のとおりです。

 • Root port

 • Designated port

 • Alternate port

 • Backup port

 • Disabled

State 表示のみ。MST ポート ステート。有効な値は以下のとおりです。

 • Blocking

 • Learning

 • Forwarding

 • Disabled

Priority 表示のみ。MST ポート プライオリティ。デフォルト値は 128 です。
Cost 表示のみ。MST ポート コスト。コスト値はインターフェイスのメディア スピードから取得し   

ます。有効値は 1 ～ 200000000 です。
Link Type 表示のみ。リンク タイプ。デフォルトは自動です。
Boundary Port 表示のみ。

PreStd Port 表示のみ。

表 5-5 Network ビュー：デバイス：Details：Access Ports セクション（続き）

フィールド 説明
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追加情報
MST の実装に関する情報については、次のセクションを参照してください。

 • 関連資料（p.5-32）

 • 標準規格（p.5-32）

 • MIB（p.5-32）

関連資料

標準規格

MIB

関連トピック マニュアル名

Rapid PVST+ 第 4 章「Rapid PVST+ の設定」

STP 拡張機能 第 6 章「STP 拡張機能の設定」

NX-OS レイヤ 2 スイッチングの設定 『Cisco NX-OS Layer 2 Switching Configuration Guide』

レイヤ 2 インターフェイス 『Cisco DCNM Interfaces Configuration Guide』

DCNM の基本 『Cisco DCNM Fundamentals Configuration Guide』

ハイ アベイラビリティ 『Cisco NX-OS High Availability and Redundancy Guide』

システム管理 『Cisco NX-OS System Management Configuration Guide』
VDC 『Cisco DCNM Virtual Device Context Configuration Guide』

ライセンス 『Cisco DCNM Licensing Guide』

リリース ノート 『Cisco DCNM Release Notes, Release 4.0』

標準規格 タイトル

IEEE 802.1Q-2006（従来の IEEE 802.1s）、IEEE 802.1D-2004    
（従来の IEEE 802.1w）、IEEE 802.1D、IEEE 802.1t

—

MIB MIB リンク

 • CISCO-STP-EXTENSION-MIB

 • BRIDGE-MIB
次の URL から、MIB の検索およびダウンロードができます。

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml
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6
STP 拡張機能の設定

この章では、NX-OS デバイス上での Spanning Tree Protocol（STP; スパニング ツリー プロトコル）       
拡張機能の設定方法について説明します。

Data Center Network Manager（DCNM）機能の詳細については、『Cisco DCNM Fundamentals 
Configuration Guide』を参照してください。

この章で説明する内容は、次のとおりです。

 • STP 拡張機能の概要（p.6-2）

 • STP 拡張機能のライセンス要件（p.6-10）

 • STP 拡張機能の前提条件（p.6-10）

 • 注意事項および制約事項（p.6-11）

 • STP 拡張機能の設定（p.6-12）

 • STP 拡張機能の設定フィールドの説明（p.6-16）

 • 追加情報（p.6-18）

（注） STP および Per VLAN Rapid Spanning Tree（Rapid PVST+）の詳細は第 4 章「Rapid PVST+ の設定」           
を、Multiple Spanning Tree（MST）の詳細は第 5 章「MST の設定」を参照してください。
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STP 拡張機能の概要

（注） DCNM を使用して STP パラメータを使用する前に、デバイスのコマンドラインに次の NX-OS グ     
ローバル コマンドを入力してロギング レベルを設定する必要があります。 
--logging-level spanning-tree 6 
--logging logfile messages 6 
--logging event link-status default 
ロギング レベルの詳細については『Cisco NX-OS System Management Configuration Guide』を参照し      
てください。

（注） レイヤ 2 インターフェイスの作成に関する詳細については、『Cisco DCNM Interfaces Configuration     
Guide』を参照してください。

ループ回避を改善し、ユーザによる設定ミスを削減し、プロトコル パラメータの制御を向上するた 
めに、シスコは STP に拡張機能を追加しました。IEEE 802.1w Rapid Spanning Tree Protocol（RSTP）       
規格に同様の機能が統合されていることも考えられますが、ここで紹介する拡張機能を使用するこ

とを推奨します。PVST シミュレーションを除き、これらの拡張機能はすべて、Rapid PVST+ およ   
び MST の両方で使用できます。PVST シミュレーションを使用できるのは、MST だけです。

使用できる拡張機能は、スパニング ツリー エッジ ポート（従来の PortFast の機能を提供）、ブリッ     
ジ保証、Bridge Protocol Data Unit（BPDU; ブリッジ プロトコル データ ユニット）ガード、BPDU       
フィルタリング、ループ ガード、ルート ガード、および PVT シミュレーションです。これらの機    
能のほとんどは、グローバルにも、または特定のインターフェイスだけにも適用できます。

（注） スパニング ツリーは、IEEE 802.1w および IEEE 802.1s の規格を意味します。IEEE 802.1D STP につ         
いて説明している場合は、802.1D であることを明記します。

ここでは、次の内容について説明します。

 • STP ポート タイプ（p.6-3）

 • ブリッジ保証（p.6-3）

 • BPDU ガード（p.6-6）

 • BPDU フィルタリング（p.6-6）

 • ループ ガード（p.6-7）

 • ルート ガード（p.6-8）

 • STP 拡張機能の適用（p.6-8）

 • PVST シミュレーション（p.6-9）

 • ハイ アベイラビリティ（p.6-9）

 • バーチャライゼーションのサポート（p.6-9）
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STP ポート タイプ
スパニング ツリーのポートは、エッジ ポート、ネットワーク ポート、または標準ポートとして設   
定できます。ポートは、いつの時点でも、これらのステートのいずれかになります。デフォルトの

スパニング ツリー ポート タイプは、標準（normal）です。

レイヤ 2 ホストに接続するエッジ ポートは、アクセス ポートまたはトランク ポートのどちらかに     
なります。

（注） レイヤ 2 スイッチまたはブリッジに接続しているポートをエッジ ポートとして設定すると、ブリッ   
ジング ループが発生することがあります。

ネットワーク ポートは、レイヤ 2 スイッチまたはブリッジだけに接続します。

（注） レイヤ 2 ホストまたはエッジ デバイスに接続されたポートを、誤ってスパニング ツリー ネット     
ワーク ポートとして設定した場合、これらのポートは自動的にブロッキング ステートに移行しま  
す。

STP エッジ ポート

STP エッジ ポートは、レイヤ 2 ホストにのみ接続します。エッジ ポート インターフェイスは、ブ      
ロッキング ステートまたはラーニング ステートを経由せずに、直接フォワーディング ステートに   
移行します（この直接の移行は、従来のシスコの独自機能である PortFast に設定されていました）。

レイヤ 2 ホストに接続したインターフェイスでは、STP の BPDU を受信しないようにします。

ブリッジ保証

ブリッジ保証を使用すると、ネットワーク上でブリッジング ループが発生する原因となる特定の問 
題を回避できます。具体的には、ブリッジ保証を使用して、単方向リンク障害または他のソフト

ウェア障害、およびスパニング ツリー アルゴリズムの停止後もデータ トラフィックを転送し続け   
ているデバイスから、ネットワークを保護します。

（注） ブリッジ保証がサポートされるのは、Rapid PVST+ および MST だけです。

ブリッジ保証はデフォルトでイネーブルであり、ディセーブルにするとグローバルに適用されま

す。また、ブリッジ保証をイネーブルにできるのは、ポイントツーポイント リンクのスパニング 
ツリー ネットワーク ポート上だけです。さらに、リンクの両端でブリッジ保証がイネーブルに設  
定されている必要があります。リンクの一端のデバイスでブリッジ保証がイネーブルであっても、

他端のデバイスがブリッジ保証をサポートしていない、またはブリッジ保証がイネーブルではない

場合、接続ポートはブロックされます。
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ブリッジ保証をイネーブルにすると、代替ポートやバックアップ ポートも含めたネットワーク上で 
稼働しているすべてのポートに対して、ハロー タイムのたびに BPDU が送信されます。ポートが   
指定時間を経過したあとも BPDU を受信しない場合、そのポートはブロッキング ステートになり、   
ルート ポートの計算には使用されません。BPDU を受信すると、ポート上で標準 スパニング ツリー    
のステート移行が再開されます。

図 6-1 に、一般的な STP トポロジを示します。また、図 6-2 には、ブリッジ保証を実行していない    
場合、デバイスの障害発生時にネットワークで発生する可能性のある問題を示します。

図 6-1 標準的な STP トポロジのネットワーク

図 6-2 ブリッジ保証を実行していないネットワークの問題

18
65

25

BPDU

X

18
64

10



第 6章      STP 拡張機能の設定
STP 拡張機能の概要 

6-5
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0        

OL-15867-01-J

図 6-3 に、ブリッジ保証をイネーブルにしたネットワークで、すべての STP ネットワーク ポートか    
ら双方向 BPDU が発行される一般的な STP トポロジを示します。図 6-4 は、ネットワーク上でブ     
リッジ保証をイネーブルにした場合、図 6-2 で示したネットワーク上の問題が発生しない理由を示 
しています。

図 6-3 ブリッジ保証を実行しているたネットワークの STP トポロジ

図 6-4 ブリッジ保証によるネットワーク上の問題の回避
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%STP-2-BRIDGE_ASSURANCE_BLOCK: Bridge Assurance blocking port Ethernet2/48 VLAN0700.
switch# sh spanning vl 700 | in -i bkn
Eth2/48          Altn BKN*4         128.304  Network P2p *BA_Inc
switch#
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BPDU ガード
BPDU ガードをイネーブルにすると、インターフェイスは BPDU を受信した場合にシャットダウン  
します。

BPDU ガードは、インターフェイス レベルで設定できます。インターフェイス レベルで BPDU ガー     
ドを設定すると、BPDU を受信したポートは、ポート タイプの設定に関係なく、すぐにシャットダ  
ウンします。

BPDU ガードをグローバルに設定すると、稼働中のスパニング ツリー エッジ ポート上でのみ有効    
になります。有効な設定では、レイヤ 2 LAN エッジ インターフェイスは BPDU を受信しません。      
レイヤ 2 LAN エッジ インターフェイスが BPDU を受信した場合、許可されていないデバイスの接      
続と同様に、無効な設定として通知されます。BPDU ガードをグローバルでイネーブルにすると、 
BPDU を受信したすべてのスパニング ツリー エッジ ポートがシャットダウンします。

BPDU ガードでは、無効な設定が通知された場合、レイヤ 2 LAN インターフェイスを手動で再起動    
させる必要があるので、無効な設定に対して安全に対応できます。

（注） グローバルにイネーブル化した場合、BPDU ガードは稼働中のすべてのスパニング ツリー エッジ   
インターフェイスに適用されます。

BPDU フィルタリング
BPDU フィルタリングを使用すると、デバイスの特定のポート上で BPDU が送信されないように、   
または BPDU を受信しないように設定できます。

グローバルに設定した場合、BPDU フィルタリングは稼働中のすべてのスパニング ツリー エッジ   
ポートに適用されます。エッジ ポートは、一般的に BPDU をドロップするホストにのみ接続すべ   
きです。稼働中のスパニング ツリー エッジ ポートが BPDU を受信した場合、そのポートはすぐに     
標準スパニング ツリー ポート タイプに戻り、ステートの移行を開始します。この場合、このポー   
ト上の BPDU フィルタリングはディセーブルになり、スパニング ツリーにより、ポート上での   
BPDU の送信が再開されます。

また、BPDU フィルタリングは、個々のインターフェイスに対して設定できます。ポート上で BPDU  
フィルタリングを明示的に設定すると、そのポートは BPDU を送信しません。また、受信したすべ  
ての BPDU をドロップします。特定のインターフェイスを設定することにより、個々のポート上  
で、グローバルな BPDU フィルタリング設定を上書きすることができます。インターフェイスに対  
する BPDU フィルタリング コマンドは、インターフェイスがトランキング モードかどうかに関係    
なく、インターフェイス全体に適用されます。

注意 インターフェイス単位での BPDU フィルタリングの設定には、注意が必要です。ホストに接続さ  
れていないポートに BPDU フィルタリングを設定すると、そのポートは受信した BPDU を無視し    
てフォワーディングに移行するので、ブリッジング ループが発生することがあります。



第 6章      STP 拡張機能の設定
STP 拡張機能の概要 

6-7
Cisco DCNM Layer 2 Switching コンフィギュレーション ガイド Release 4.0        

OL-15867-01-J

表 6-1 に、すべての BPDU フィルタリングの組み合わせを示します。

ループ ガード
ループ ガードを使用すると、ポイントツーポイント リンク上の単方向リンク障害によって発生す  
ることがあるブリッジング ループを防止できます。

STP ループは、冗長トポロジのブロッキング ポートが誤ってフォワーディング ステートに移行し   
た場合に発生します。物理的な冗長トポロジのポート（ブロッキング ポートに限らない）の 1 つで   
BPDU の受信が停止すると、ポートのステートが移行する原因になります。

グローバルでイネーブル化したループ ガードが有益なのは、デバイスがポイントツーポイント リ  
ンクで接続されているスイッチド ネットワークだけです。ポイントツーポイント リンクでは、代  
表ブリッジは不良 BPDU を送信するかリンクがダウンしない限り、存続します。ただし、共有リン  
ク上のループ ガードはインターフェイス単位でイネーブルに設定できます。

ループ ガードを使用すると、ルート ポートまたは代替 /バックアップ ルート ポートが BPDU を受      
信しているかどうかを判別できます。BPDU を受信していたポートで BPDU が受信されなくなる   
と、ループ ガードは、ポート上で BPDU の受信が再開されるまで、そのポートを不整合（ブロッ   
キング）ステートにします。これらのポートで BPDU の受信が再開されると、ポートおよびリンク  
は再び動作可能として認識されます。この回復は自動的に実行されるので、プロトコルによりポー

トからループ不整合が排除されると、STP によりポート ステートが判別されます。

ループ ガードにより障害が特定されるので、STP は障害リンクまたは障害ブリッジのない安定した  
トポロジを収束できます。ループ ガードをディセーブルにすると、ループ不整合のポートはすべ 
て、リスニング ステートに移行します（STP ポート ステートの情報については、第 4 章「Rapid     
PVST+ の設定」を参照してください）。

ループ ガードはポート単位でイネーブルにすることができます。ポート上でループ ガードをイ  
ネーブルにすると、そのポートが属しているすべてのアクティブ インスタンスまたは VLAN にルー   
プ ガードが自動的に適用されます。ループ ガードをディセーブルにすると、指定したポートに対  
してディセーブルになります。

表 6-1 BPDU フィルタリングの設定

ポート単位の BPDU 
フィルタリング設定

BPDU フィルタリングの
グローバル設定

STP エッジ ポートの
設定

BPDU フィルタリング 
ステート

デフォルト1

1. 明示的なポート設定はありません。

イネーブル イネーブル イネーブル 2

2. ポートは最低 10 の BPDU を送信します。BPDU を受信すると、このポートはスパニング ツリー標準ポート ステー       
トに戻り、BPDU フィルタリングはディセーブルになります。

デフォルト イネーブル ディセーブル ディセーブル

デフォルト ディセーブル 適用なし ディセーブル

ディセーブル 適用なし 適用なし ディセーブル

イネーブル 適用なし 適用なし イネーブル
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ルート ガード
ポート上でルート ガードをイネーブルにすると、そのポートはルート ポートになりません。受信  
した BPDU により、指定ポートをルート ポートとする STP コンバージェンスが実行されると、そ     
のポートはルート不整合（ブロックされた）ステートになります。ポートが優位 BPDU の送信を停  
止すると、そのポートのブロックが解除されます。ポートは、STP により、フォワーディング ス  
テートに移行します。この回復は自動的に実行されます。

インターフェイス上でルート ガードをイネーブルにすると、そのインターフェイスが属しているす 
べての VLAN にルート ガードが適用されます。

ルート ガードを使用して、ルート ブリッジをネットワークに強制的に配置できます。ルート ガー   
ドでは、ルート ガードをイネーブルにしたポートが指定ポートになります。通常、ルート ブリッ  
ジ上の複数のポートが接続されている場合を除き、ルート ブリッジのポートはすべて指定ポートで 
す。ブリッジは、ルート ガードがイネーブルであるブリッジ ポート上で優位 BPDU を受信すると、    
そのポートをルート不整合 STP ステートに移行します。このように、ルート ガードによってルー   
ト ブリッジの配置を制御できます。

ルート ガードは、グローバルに設定することはできません。

STP 拡張機能の適用
図 6-5 に示すように、ネットワーク上に各種の STP 拡張機能を設定することを推奨します。ブリッ   
ジ保証は、ネットワーク全体でイネーブルになります。ホスト インターフェイスで BPDU ガード   
または BPDU フィルタリングをイネーブルにする必要があります。

図 6-5 STP 拡張機能を適正に設定したネットワーク
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PVST シミュレーション
MST は、ユーザが設定しなくても、Rapid PVST+ と相互運用します。この相互運用性を提供するの   
が、PVST シミュレーション機能です。

（注） MST をイネーブルにすると、PVST シミュレーションがデフォルトでイネーブルになります。デ
フォルトでは、デバイス上のすべてのインターフェイスで MST と Rapid PVST+ が相互運用されま
す。

ただし、MST イネーブル ポートが Rapid PVST+ イネーブル ポートに接続される可能性を防ぐには、      
MST と Rapid PVST+ 間の接続を制御する必要があります。Rapid PVST+ はデフォルトの STP モー        
ドなので、多数の Rapid PVST+ 接続が発生することがあります。

Rapid PVST+ シミュレーションを、デバイス全体でグローバルにディセーブルにすると、MST イ   
ネーブル ポートは、Rapid PVST+ イネーブル ポートに接続したことが検出された時点で、ブロッ    
キング ステートに移行します。このポートは、Rapid PVST+/SSTP BPDU を受信しなくなるまで不    
整合ステートのままですが、そのあとは標準 STP のステート移行を再開します。

すべての STP インスタンスのルート ブリッジは、MST または Rapid PVST+ のどちらかの側に属し       
ている必要があります。すべての STP インスタンスのルート ブリッジがどちらか一方の側に属し   
ていないと、ポートは PVST シミュレーション不整合ステートになります。

（注） すべての STP インスタンスのルート ブリッジを、MST 側に配置することを推奨します。

ハイ アベイラビリティ
このソフトウェアは、STP のハイ アベイラビリティをサポートしています。ただし、統計情報とタ  
イマーは STP の再起動時には復元されません。タイマーは最初から開始され、統計情報は 0 にリ    
セットされます。

（注） ハイ アベイラビリティ機能の詳細については、『Cisco NX-OS High Availability and Redundancy 
Configuration Guide』を参照してください。

バーチャライゼーションのサポート

このシステムは Virtual Device Context（VDC）をサポートしています。各 VDC で個別の STP を実       
行できます。1 つの VDC で Rapid VPST+ を実行し、別の VDC で MST を実行することもできます。

（注） VDC およびリソース割り当ての詳細については、『Cisco DCNM Virtual Device Context Configuration      
Guide』を参照してください。
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STP 拡張機能のライセンス要件
次の表に、この機能に関するライセンス要件を示します。

ただし、VDC を使用するには、Advanced  Services ライセンスが必要です。

STP 拡張機能の前提条件
STP には、次の前提条件が適用されます。

 • デバイスにログオンしている必要があります。

 • DCNM を使用して STP パラメータを設定する前に、デバイスのコマンド ラインに NX-OS グ      
ローバル コマンドの logging-level spanning-tree 6 を入力して、ロギング レベルを設定する必要      
があります。ロギング レベルの情報については、『Cisco NX-OS System Management Configuration     
Guide』を参照してください。

製品 ライセンス要件

DCNM STP 拡張機能には、ライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco DCNM    
にバンドルされ、無料で提供されます。DCNM ライセンス機構の詳細については、『Cisco DCNM Licensing   
Guide』を参照してください。

NX-OS STP 拡張機能には、ライセンスは不要です。ライセンス パッケージに含まれていない機能は Cisco NX-OS    
システム イメージにバンドルされ、無料で提供されます。NX-OS ライセンス機構の詳細については、『Cisco  
NX-OS Licensing Guide』を参照してください。
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注意事項および制約事項
STP 拡張機能の設定時は、次の注意事項および制限に従ってください。

 • STP ネットワーク ポートは、スイッチだけに接続してください。

 • ホスト ポートは、ネットワーク ポートではなく STP エッジ ポートとして設定する必要があり     
ます。

 • STP ネットワーク ポート タイプをグローバルにイネーブルにする場合には、ホストに接続し
ているすべてのポートを手動で STP エッジ ポートとして設定してください。

 • レイヤ 2 ホストに接続しているすべてのアクセス ポートおよびトランク ポートを、エッジ ポー     
トとして設定する必要があります。

 • ブリッジ保証は、ポイントツーポイント スパニング ツリー ネットワーク ポート上でのみ実行    
されます。リンクの両端に、この機能を設定しておく必要があります。

 • ブリッジ保証は、ネットワーク全体でイネーブルにすることを推奨します。

 • すべてのエッジ ポート上で BPDU ガードをイネーブルにすることを推奨します。

 • グローバルにイネーブルしたループ ガードは、ポイントツーポイント リンク上でのみ動作し  
ます。

 • インターフェイス単位でイネーブルにしたループ ガードは、共有リンクおよびポイントツーポ 
イント リンクの両方で動作します。

 • ルート ガードを適用したポートは強制的に指定ポートになりますが、ルート ポートにはなり
ません。ループ ガードは、ポートがルート ポートまたは代替ポートの場合にのみ有効です。
ポート上でループ ガードとルート ガードの両方を同時にイネーブルにすることはできません。

 • ディセーブル化されたスパニング ツリー インスタンスまたは VLAN 上では、ループ ガードは     
無効です。

 • スパニングツリーは、BPDU を送信するチャネル内で最初に動作するポートを常に選択します。 
このリンクが単方向になると、チャネル内の他のリンクが正常に動作していても、ループ ガー 
ドによりチャネルがブロックされます。

 • ループ ガードによってブロックされている一連のポートをグループ化してチャネルを形成する 
と、これらのポートのステート情報はスパニング ツリーからすべて削除され、新しいチャネル 
のポートは指定ロールによりフォワーディング ステートに移行できます。

 • チャネルがループ ガードによりブロックされ、チャネルのメンバーが個々のリンク ステータ  
スに戻ると、スパニング ツリーからすべてのステート情報が削除されます。チャネルを形成し 
ている 1 つ以上のリンクが単方向であっても、個々の物理ポートは指定ロールによりフォワー  
ディング ステートに移行できます。

（注） UniDirectional Link Detection（UDLD; 単方向リンク検出）アグレッシブ モードをイ
ネーブルにすると、リンク障害を分離できます。UDLD により障害が検出される
まではループが発生することがありますが、ループ ガードでは検出できません。
UDLD の詳細については、『Cisco NX-OS Interfaces Configuration Guide』を参照して
ください。

 • 物理ループのあるスイッチ ネットワーク上では、ループ ガードをグローバルにイネーブルに
する必要があります。

 • 直接の管理制御下にないネットワーク デバイスに接続しているポート上では、ルート ガード
をイネーブルにする必要があります。
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STP 拡張機能の設定
ここでは、次の内容について説明します。

 • STP 拡張機能のデフォルト値の設定（p.6-12）

 • STP 拡張機能のグローバル設定（p.6-13）

 • PVST シミュレーションのグローバル設定（p.6-14）

 • STP 拡張機能のインターフェイス単位での設定（p.6-15）

ループ ガードは、共有リンクまたはポイントツーポイント リンク上のインターフェイス単位でイ  
ネーブルに設定できます。

STP 拡張機能のデフォルト値の設定
STP 拡張機能をデフォルト設定に戻すには、Spanning Tree ペインを使用します（図 6-6 を参照）。

図 6-6 STP 拡張機能の設定
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手順の詳細

STP 拡張機能をグローバルまたはポート単位でデフォルト設定にするには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching > Spanning Tree  を選択して Spanning Tree ペインを開きます。

ステップ 2 Summary ペインで、デバイス全体についてグローバルにデフォルト設定にするデバイスをクリック 
します。

ステップ 3 メニュー バーから Spanning-Tree > Set to default を選択します。

ステップ 4 Details ペインで、ポートをデフォルト設定にするために Configuration タブをクリックします。

ステップ 5 Port Setting セクションをクリックします。

Port Setting セクションが展開され、ポートが表示されます。

ステップ 6 Port Setting セクションで、設定するインターフェイスを選択します。

ステップ 7 メニュー バーで Spanning-Tree > Set to default を選択します。

ステップ 8 （任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。

STP 拡張機能のグローバル設定
STP 拡張機能をグローバルに設定するには、Spanning Tree ペインを使用します（図 6-6 を参照）。

手順の詳細

STP 拡張機能をグローバルに設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching > Spanning Tree  を選択して Spanning Tree ペインを開きます。

ステップ 2 Summary ペインでデバイスをクリックします。

ステップ 3 Details ペインで Configuration タブをクリックします。

ステップ 4 Details ペインで Global Setting セクションをクリックします。

Global Setting セクションが展開されます。

ステップ 5 Port Type ドロップダウン リストからポート タイプを選択します。

デフォルトのポート タイプは、Normal STP です。

ステップ 6 Bridge Assurance ドロップダウン リストから、Enabled または Disabled を選択します。

ブリッジ保証は、デフォルトでイネーブルです。
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ステップ 7 BPDU Guard ドロップダウン リストから、Enabled または Disabled を選択します。

デフォルトでは、BPDU ガードはディセーブルです。

ステップ 8 BPDU Filter ドロップダウン リストから、Enabled または Disabled を選択します。

デフォルトでは、BPDU フィルタはディセーブルです。

ステップ 9 Loop Guard ドロップダウン リストから、Enabled または Disabled を選択します。

デフォルトでは、ループ ガードはディセーブルです。

ステップ 10（任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。

PVST シミュレーションのグローバル設定

（注） PVST シミュレーションは、デフォルトでイネーブルです。デフォルトでは、デバイス上のすべて 
のインターフェイスで MST と Rapid PVST+ が相互運用されます。

PVST シミュレーションを設定するのは、デバイス上で MST を実行している場合だけです（Rapid   
PVST+ がデフォルトの STP モードです）。MST は、Rapid PVST+ と相互運用します。ただし、デ      
フォルトの STP モードで、MST を実行していないデバイスに接続する可能性を防ぐには、この自   
動機能をディセーブルに設定できます。PVST シミュレーションをディセーブルにすると、Rapid 
PVST+ イネーブル ポートに接続したことが検出された時点で、MST イネーブル ポートはブロッキ    
ング ステートに移行します。このポートは、BPDU を受信しなくなるまでは不整合ステートのまま  
ですが、そのあとは標準 STP のステート移行を再開します。

PVST シミュレーションを設定するには、Spanning Tree ペインを使用します（図 6-6 を参照）。

手順の詳細

PVST シミュレーションをグローバルに設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching > Spanning Tree  を選択して Spanning Tree ペインを開きます。

ステップ 2 Summary ペインで、MST 名とリビジョン番号を指定するデバイスをクリックします。

Summary ペインで選択したデバイスが強調表示され、Details ペインにタブが表示されます。

ステップ 3 Details ペインで Configuration タブをクリックします。

ステップ 4 Global Setting セクションをクリックします。

ステップ 5 MST Setting エリアの Simulate PVST フィールドで、ドロップダウン リストをクリックし、Enabled      
をクリックします。

デフォルトはイネーブルです。
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ステップ 6 （任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。

STP 拡張機能のインターフェイス単位での設定
STP 拡張機能をインターフェイス単位で設定するには、Spanning Tree ペインを使用します（図 6-6   
を参照）。

手順の詳細

STP 拡張機能をインターフェイス単位で設定するには、次の手順を実行します。

ステップ 1 Feature Selector ペインから、Switching > Spanning Tree  を選択して Spanning Tree ペインを開きます。

ステップ 2 Summary ペインでデバイスをクリックします。

ステップ 3 Details ペインで Configuration タブをクリックします。

ステップ 4 Details ペインで Port Setting セクションをクリックします。

Port Setting セクションが展開されます。

ステップ 5 Port Setting セクションで、設定するインターフェイスをクリックします。

ステップ 6 Port Type カラムで、ドロップダウン リストをクリックし、ポート タイプを選択します。

デフォルトでは、各インターフェイスのポート タイプは Default に設定されています。これにより、   
ポート タイプは、グローバルに設定されたポート タイプになります。

ステップ 7 BPDU Guard カラムで、ドロップダウン リストをクリックし、BPDU  ガード設定を選択します。

デフォルトでは、各インターフェイスの BPDU ガード設定は Default に設定されています。これに    
より、インターフェイスは、グローバルに設定された BPDU ガード値になります。

ステップ 8 BPDU Filter カラムで、ドロップダウン リストをクリックし、BPDU  フィルタ設定をクリックしま
す。

デフォルトでは、各インターフェイスの BPDU フィルタ設定は Default に設定されています。これ    
により、インターフェイスは、グローバルに設定された BPDU フィルタ値になります。

ステップ 9 Guard  カラムで、ドロップダウン リストをクリックし、ループ ガードまたはループ ガード設定を
選択します。

デフォルトでは、各インターフェイスのガード設定は Default に設定されています。これにより、イ  
ンターフェイスは、グローバルに設定されたループ ガード値になります。

ステップ 10（任意）デバイスに変更を適用するには、メニュー バーから File > Deploy を選択します。
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STP 拡張機能の設定フィールドの説明
ここでは、STP タイプの設定、さまざまな MST の設定、および STP 拡張機能の設定に使用する     
フィールドについて、次の内容を説明します。

 • デバイス：設定：Global Settings セクション（p.6-16）

 • デバイス：設定：Port Setting セクション（p.6-17）

デバイス：設定：Global Settings セクション

表 6-2 デバイス：設定：Global Settings セクション 

フィールド 説明

STP 設定
Device 表示のみ。デバイスの IP アドレスの名前。
Protocol デバイスで使用されている STP プロトコル。値は PVRST または MST です。デフォルトは      

PVRST です。
Port Type デバイスのグローバル STP ポート タイプ。値は Edge、Network、または Normal STP です。デ       

フォルトのポート タイプは、Normal STP です。
Bridge Assurance ブリッジ保証機能。値はイネーブルまたはディセーブルです。デフォルトは Enabled です。
BPDU Guard ブリッジ保証機能。値はイネーブルまたはディセーブルです。デフォルトは Disabled です。
BPDU Filter ブリッジ保証機能。値はイネーブルまたはディセーブルです。デフォルトは Disabled です。
Loop Guard ループガード機能。値はイネーブルまたはディセーブルです。デフォルトは Disabled です。
Path Cost パスコスト機能。値はショートまたはロングです。デフォルトはショートです。

（注） このフィールドは、Rapid PVST+ のみに適用されます。MST では、パスコスト方式は   
常にロングです。

MST 設定
Name MST 領域の名前。最大 34 文字までの英数字を入力できます。デフォルトはブランクです。
Hello Time MST プロトコルの hello タイム。指定できる範囲は 1 ～ 10 秒です。デフォルトは 2 秒です。
Revision Number 現在の MST コンフィギュレーションのリビジョン。指定できる範囲は 0 ～ 65535、デフォル     

ト値は 0 です。
Simulate PVST PVST シミュレーション。値はイネーブルまたはディセーブルです。デフォルトは Enabled で   

す。

Digest 表示のみ。VLAN/MST 間マッピングの MD5 ダイジェスト。
Pre-Standard Digest 表示のみ。先行標準キーを使用した VLAN/MST 間マッピングの MD5 ダイジェスト。
Forward Delay Time インターフェイスがフォワーディングを開始するまで、ラーニング ステートが継続する時間。 

指定できる範囲は 4 ～ 30 秒、デフォルト値は 15 秒です。
Max Age Time ポートで受信したプロトコル情報がデバイスに保管される時間です。指定できる範囲は 6 ～ 40   

秒、デフォルト値は 20 秒です。
Max Hop Count BPDU が廃棄されるまで、領域内で許可されるホップの数。指定できる範囲は 1 ～ 255 ホッ     

プ、デフォルト値は 20 ホップです。
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デバイス：設定：Port Setting セクション

表 6-3 デバイス：設定：Port Setting セクション 

フィールド 説明

Name 表示のみ。インターフェイスの名前。

Priority インターフェイスの STP ポート プライオリティ。指定できる範囲は 0 ～ 224 で、32 単位で設        
定します。デフォルト値は 128 です。

Cost インターフェイスの STP ポート コスト。範囲は 1 ～ 200,000,000 です。デフォルト値は、イン       
ターフェイスのメディア速度から抽出されます。

Port Type STP ポート タイプの有効な値は、次のとおりです。

 • Network ― 他のスイッチまたはブリッジに接続する場合のみ使用します。

 • Edge access ― ホスト ポートに接続する場合のみ使用します。

 • Edge trunk ― ホスト ポートへ接続する場合で、複数の VLAN にトラフィックを伝送する      
ときのみ使用します。

 • Disable ― ポートを STP 標準ポートに設定します。

 • Default ― ポートをグローバル STP ポート タイプ設定に戻します。

デフォルトは Default です。
BPDU Guard 特定のインターフェイスの BPDU ガード機能。有効な値は、次のとおりです。

 • Enable

 • Disable

 • Default ― ポートをグローバル BPDU ガード設定に戻します。

デフォルトは Default です。
BPDU Filter 特定のインターフェイスの BPDU フィルタ機能。有効な値は、次のとおりです。

 • Enable

 • Disable

 • Default ― ポートをグローバル BPDU フィルタ設定に戻します。

デフォルトは Default です。
Guard ループ ガードまたはルート ガード。有効な値は、次のとおりです。

 • Loop

 • None

 • Root

デフォルトは Default です。
Simulate PVST インターフェイス単位の PVST シミュレーション。有効な値は、次のとおりです。

 • Enabled

 • Disabled

 • Default ― インターフェイスをデバイスのグローバル PVST シミュレーション設定に戻し    
ます。

デフォルトは Default です。
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追加情報
STP 拡張機能の実装に関する追加情報は、次のセクションを参照してください。

 • 関連資料（p.6-18）

 • 標準規格（p.6-18）

 • MIB（p.6-18）

関連資料

標準規格

MIB

Link Type インターフェイスのリンク タイプ。有効な値は、次のとおりです。

 • Point-to-point

 • Shared

 • Auto ― インターフェイスのデュプレックス設定に基づいてリンク タイプが設定されます。

デフォルトは Auto です。

表 6-3 デバイス：設定：Port Setting セクション（続き）

フィールド 説明

関連トピック マニュアル名

Rapid PVST+ 第 4 章「Rapid PVST+ の設定」
MST 第 5 章「MST の設定」

NX-OS レイヤ 2 スイッチングの設定 『Cisco NX-OS Layer 2 Switching Configuration Guide』

レイヤ 2 インターフェイス 『Cisco DCNM Interfaces Configuration Guide』
DCNM fundamentals 『Cisco DCNM Security Configuration Guide』

ハイ アベイラビリティ 『Cisco NX-OS High Availability and Redundancy Guide』

システム管理 『Cisco NX-OS System Management Configuration Guide』
VDC 『Cisco DCNM Virtual Device Context Configuration Guide』

ライセンス 『Cisco DCNM Licensing Guide』

リリース ノート 『Cisco DCNM Release Notes, Release 4.0』

標準規格 タイトル

IEEE 802.1Q-2006（従来の IEEE 802.1s）、IEEE 802.1D-2004    
（従来の IEEE 802.1w）、IEEE 802.1D、IEEE 802.1t

—

MIB MIB リンク

 • CISCO_STP_EXTENSION MIB

 • BRIDGE MIB
次の URL から、MIB の検索およびダウンロードができます。

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml
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A
Cisco NX-OS Release 4.0 レイヤ 2 
スイッチング機能の設定の上限

NX-OS でサポートされている機能には、設定の上限があります。表 A-1 に、NX-OS Release 4.0 が     
稼働するレイヤ 2 デバイスの設定の上限を示します。

表 A-1 Cisco NX-OS Release 4.0 のレイヤ 2 設定の上限 

機能 上限

MAC アドレス 131,060

MAC エージング タイム値 14

すべての VLAN VDC ごとに 4096

ボックスごとに 16,384 個の VLAN ポート

Spanning-Tree Protocol（STP; スパニング  
ツリー プロトコル）

65 個の MST Instance（MSTI; MST インスタンス）（インスタンス 0 を含む）

VDC ごとに 4096 個の Rapid PVST+

システムごとに 16,000 個の Rapid PVST+ 論理ポート

システムごとに 75,000 個の MST 論理ポート
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